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Preface
xiii
Thank you for purchasing your Topcon receiver, survey product or 
accessory (the «Product»). The materials available in this manual 
(the «Manual») have been prepared by Topcon Positioning 
Systems, Inc. («TPS») for owners of Topcon products. This Manual 
is designed to assist owners with the use of software (the 
«Software») to be used with the Product and its use is subject to 
these terms and conditions (the «Terms and Conditions»).

NOTICE
Please read these Terms and Conditions 
carefully.

Terms and Conditions
PROFESSIONAL USE – Topcon Products are designed to be used 
by a professional. The user is required to be a professional surveyor 
or have a good knowledge of surveying, in order to understand the 
user and safety instructions before operating, inspecting or 
adjusting. Always wear required safety attire (safety shoes, hard 
hat, etc.) when operating the Products.

COPYRIGHT – All information contained in this Manual is the 
intellectual property of, and copyrighted material of TPS. All rights 
are reserved. You may not use, access, copy, store, display, create 
derivative works of, sell, modify, publish, distribute, or allow any 
third party access to, any graphics, content, information or data in 
this Manual without TPS’ express written consent and may only use 
such information for the care and operation of your Product. The 
information and data in this Manual are a valuable asset of TPS and 
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xiv
are developed by the expenditure of considerable work, time and 
money, and are the result of original selection, coordination and 
arrangement by TPS.

TRADEMARKS – Topcon® and Topcon Positioning Systems™ 
are trademarks of TPS. Windows® is a registered trademark of 
Microsoft Corporation. Product and company names mentioned 
herein may be trademarks of their respective owners.

DISCLAMER OF WARRANTY – EXCEPT FOR ANY 
WARRANTIES IN A WARRANTY CARD ACCOMPANYING 
THE PRODUCT, THIS MANUAL, THE PRODUCT, AND ANY 
ACCOMPANYING SOFTWARE ARE PROVIDED “AS-IS.” 
THERE ARE NO OTHER WARRANTIES. TPS DISCLAIMS 
ANY IMPLIED WARRANTY OF MERCHANTABILITY OR 
FITNESS FOR ANY PARTICULAR USE OR PURPOSE. TPS 
AND ITS DISTRIBUTORS SHALL NOT BE LIABLE FOR 
TECHNICAL OR EDITORIAL ERRORS OR OMISSIONS 
CONTAINED HEREIN; NOR FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES RESULTING FROM THE 
FURNISHING, PERFORMANCE OR USE OF THIS 
MATERIAL, THE SOFTWARE, OR THE PRODUCT.  SUCH 
DISCLAIMED DAMAGES INCLUDE BUT ARE NOT LIMITED 
TO LOSS OF TIME, LOSS OR DESTRUCTION OF DATA, LOSS 
OF PROFIT, SAVINGS OR REVENUE, OR LOSS OF THE 
PRODUCT’S USE.  IN ADDITION TPS IS NOT RESPONSIBLE 
OR LIABLE FOR DAMAGES OR COSTS INCURRED IN 
CONNECTION WITH OBTAINING SUBSTITUTE PRODUCTS 
OR SOFTWARE, CLAIMS BY OTHERS, INCONVENIENCE, 
OR ANY OTHER COSTS. IN ANY EVENT, TPS SHALL HAVE 
NO LIABILITY FOR DAMAGES OR OTHERWISE TO YOU OR 
ANY OTHER PERSON OR ENTITY IN EXCESS OF THE 
PURCHASE PRICE FOR THE PRODUCT.
Topcon PC-CDU User’s Manual
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xv
LICENSE AGREEMENT – Use of the Software and any other 
computer programs or software supplied by TPS or downloaded 
from a TPS website (the “Software”) in connection with a Topcon 
Product constitutes acceptance of these Terms and Conditions in 
this Manual and an agreement to abide by these Terms and 
Conditions. The user is granted a personal, non-exclusive, non-
transferable license to use such Software under the terms stated 
herein and in any case only with a single Product or single 
computer. You may make one (1) backup copy of the Software. 
Otherwise, the Software may not be copied or reproduced.  You 
may not assign or transfer the Software or this license without the 
express written consent of TPS. This license is effective until 
terminated. You may terminate the license at any time by destroying 
the Software and Manual. TPS may terminate the license if you fail 
to comply with any of the Terms or Conditions. You agree to 
destroy the Software and manual upon termination of your use of 
the Product.  All ownership, copyright and other intellectual 
property rights in and to the Software belong to TPS. If these 
license terms are not acceptable, return any unused Software and 
the Manual.

CONFIDENTIALITY – This Manual, its contents and the 
Software (collectively, the “Confidential Information”) are the 
confidential and proprietary information of TPS. You agree to treat 
Confidential Information of TPS with a degree of care no less 
stringent that the degree of care you would use in safeguarding your 
own most valuable trade secrets. Nothing in this paragraph shall 
restrict you from disclosing Confidential Information to your 
employees as may be necessary or appropriate to operate or care for 
the receiver. Such employees must also keep the Confidential 
Information confidential. In the event you become legally 
compelled to disclose any of the Confidential Information, you 
shall give TPS immediate notice so that it may seek a protective 
order or other appropriate remedy.
P/N 7010-xxxx www.topconpositioning.com
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WEBSITE; OTHER STATEMENTS – No statement contained at 
the TPS website (or any other website) or in any other 
advertisements or TPS literature or made by an employee or 
independent contractor of TPS modifies these Terms and 
Conditions (including the Software License Agreement, Disclaimer 
of Warranty and limitation of liability).

SAFETY – Improper use of a Topcon Product can lead to injury to 
persons or property and/or malfunction of the Product. The Product 
should only be repaired by authorized TPS warranty service 
centers. Users should review and heed the safety warnings in the 
manual accompanying the Product.

MISCELLANEOUS – The above Terms and Conditions may be 
amended, modified, superseded, or canceled, at any time by TPS. 
The above Terms and Conditions will be governed by, and 
construed in accordance with, the laws of the State of California, 
without reference to conflict of laws.
Topcon PC-CDU User’s Manual
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About This Manual
Welcome to the PC-CDU User’s Manual!

This manual explains how to install, set up, and use the PC-CDU 
software. For best performance of this software, please read all of 
the instructions carefully. They were especially designed to help 
you correctly install and operate this program. This manual 
assumes that you are familiar with GPS and also have some 
knowledge of working with TPS receivers.

The information contained in this manual applies to both PC-CDU 
MS and PC-CDU Lite. However, there are some features unique to 
PC-CDU MS. For the user’s convenience, these features will be 
explicitly stated. For more information about the differences 
between PC-CDU MS and PC-CDU Lite, refer to “PC-CDU MS 
and PC-CDU Lite” on page 1-3.

Symbols and Typographic Conventions
This manual uses the following text conventions

Example Description

clock offset This format is used in definitions or when it is 
necessary to emphasize that the marked term is 
technical jargon.

Satellites This format represents titles of dialog 
windows/boxes, names of menu options.

Internal This format identifies program interface 
objects, such as checkboxes, edit boxes, radio 
buttons, etc.

Ctrl+V This format is used to specify keys and key 
combinations.

Temp This format is used to enter various string 
information (e.g., file and directory names) as 
well as operator commands.
P/N 7010-xxxx www.topconpositioning.com
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Also, in this manual you will find four levels of special visual 
cues to certain types of information.

NOTICE
Supplementary information that can have an 
affect on system operation, system performance, 
measurements, or personal safety.

TIP
Supplementary information that can help you 
configure, maintain, or set up a system.

CAUTION
Notification that an action has the potential to 
adversely affect system operation, system 
performance, data integrity, or personal 
health.

WARNING
Notification that an action will result in 
system damage, loss of data, loss of 
warranty, or personal injury.
Topcon PC-CDU User’s Manual
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Screen Captures
This manual includes sample screen captures. Your actual 
screen can look slightly different from the sample screen due to 
the receiver you have connected, operating system used and 
settings you have specified. This is normal and not a cause for 
concern.

Manual Organization
The manual is divided into four chapters and four appendixes. 
The table of contents and index provide manual navigation. 

Chapter 1: Getting Started

• Tells the user about purposes and features of the program.

• Explains how to install and remove PC-CDU. Also 
provides information about system requirements and 
differences between PC-CDU MS and PC-CDU Lite.

• Shows how to launch and close the program.

Chapter 2: Quick Software Reference

• Provides a list of configuration procedures most likely to be 
used.

Chapter 3: Detailed Software Reference

• Describes the content of the main window.

• Provides information describing each tab, field and control 
you can access via the program interface.

Chapter 4: Troubleshooting

• Helps you in diagnosing, correcting and avoiding problems.

Appendix A: PC-CDU Scripts

• Introduces readers to the PC-CDU scripts and describes 
how to use them.
P/N 7010-xxxx www.topconpositioning.com
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Appendix B: Settings List

• Provides complete list of settings supported PC-CDU.

Appendix C: Output Period Setup Wizard

• Presents the Output Period Setup Wizard, which are used to 
adjust the periods of generating raw data and position.

Appendix D: Satellite Navigation Status Codes

• Shows the list of all available satellite navigation status 
codes.

Supplemental Documentation
The table below lists the manuals that can be useful while operating 
PC-CDU.

For Read This Document Part Number

In-depth information about 
an interface language used 
for managing a TPS receiver

GPS Receiver Interface 
Language (GRIL)

n/a

A description on how to use 
the HiPer GD and GGD

HiPer GD/GGD 
Operator’s Manual

7010-0626

A description on how to use 
the HiPer+

HiPer+ Operator’s 
Manual

7010-0526

A description on how to use 
the HiPer Lite&HiPer Lite+

HiPer Lite & HiPer Lite+ 
Operator’s Manual

7010-0557

A description on how to use 
the HiPer Pro

HiPer Pro Operator’s 
Manual

7010-0681

A description on how to use 
the Odyssey-E

Odyssey-E Operator’s 
Manual

7010-0507

A description on how to use 
the Odyssey-RS

Odyssey-RS Operator’s 
Manual

7010-0511
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Supplemental Documentation

xxi
A description on how to use 
the GB-500

GB-500 Operator’s 
Manual

31-050506-01

A description on how to use 
the GB-1000

GB-1000 Operator’s 
Manual

31-050402-01

A description on how to 
install/update the firmware in 
a TPS receiver

FLoader User’s Manual n/a

For Read This Document Part Number
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Getting Started
1-1
PC-CDU is a comprehensive Windows software product designed 
for controlling GPS+ receivers developed by the Topcon 
Positioning Systems company. It uses GPS Receiver Interface 
Language (GRIL) to configure various receiver settings and 
diagnose the receiver performance.
Before you begin using PC-CDU, you should become familiar with 
its functions and learn how to install and launch the program.

Introducing PC-CDU
The most current version of PC-CDU MS (as of 2.1.14, October 14, 
2004) provides the following functions:

• A way to connect a TPS receiver and a computer via serial, 
parallel, USB or Ethernet ports (Direct Connection Mode).

• Internet Server feature that provides the ability for Internet 
Clients to get access to a TPS receiver from a remote distance. 
To do this, the user can run PC-CDU in Internet Server mode 
on a computer connected to the Internet.

• Internet Client feature that provides remote access to a TPS 
receiver connected with Internet Server. In this case the user 
can run his/her PC-CDU in Internet Client Mode.

• Tracking of the total number and the status of all visible 
satellites.

• Display the receiver’s current position and time in real time.
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• Controlling the recording of raw data measurements into the 
receiver’s internal memory.

• Downloading collected raw data measurements (log files) from 
the receiver’s internal memory onto the computer’s disk drives.

• Recording, in real time, the receiver’s raw data measurements 
on the computer’s disk in TPS and RINEX formats. To generate 
RINEX files, the executable file tps2rin.exe must be 
installed on your PC.

• Display, in real time, the graph of the receiver’s current position 
and the satellite sky plot.

• Displaying and programming the receiver’s settings (such as 
Data Recording Interval, Position Computation Mode, etc.)

• Display of the current receiver options and loading of Option 
Authorization Files into the receiver.

• Creating and uploading configuration script files to the receiver.

Setting up PC-CDU

System Requirements
Before installing and using PC-CDU, take a moment to run 
through the system requirements listed below.

• PC-compatible with Intel® Pentium® 100 MHz or faster

• 5 Mbyte free disk space

• 16 Mbyte RAM or more (32 Mbyte recommended)

• 32-bit operating system such as MS Windows 95/98/Me/
NT/2000/XP

• Color monitor with minimum 640x480 screen resolution

• Internet Server/Client applications require your computer 
has a connection to the Internet
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PC-CDU MS and PC-CDU Lite
PC-CDU exists in two implementations: the full-functionality 
version called PC-CDU MS, and the reduced-functionality 
version called PC-CDU Lite. Differences between PC-CDU 
MS and PC-CDU Lite are listed in Table 1-1

PC-CDU MS may have a limited lifetime as a full-functionality 
tool. After the current version of PC-CDU MS expires, its 
extended functions, listed in Table 1-1, are automatically 
disabled so that PC-CDU MS turns into PC-CDU Lite. Table 1-
2 on page 1-4 provides a more detailed description of the 
different scenarios available.

Table 1-1. Differences between PC-CDU MS and PC-CDU Lite

Function PC-CDU MS PC-CDU Lite

Remote connection to a receiver 
via the Internet

yes no

Direct connection to a receiver 
via Ethernet port

yes no

Record data on a PC’s disk drive 
in real time (“Real-Time Data 
Logging)

yes no

Graphical presentation of the 
receiver’s current position & the 
satellite sky plot

yes no
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NOTICE
PC-CDU Lite will never turn into PC-CDU MS and 
will never expire.

Installing PC-CDU
There is no special installer for the current version of PC-CDU. 
This tool is a ready-to-run executable.

NOTICE
Below is the procedure for downloading PC-CDU 
from the Topcon website. If your version of PC-

Table 1-2. PC-CDU MS Authorization Algorithm

If the Firmware 
Version Installed on 

the Receiver Is...

And the Connected 
Receiver Is...

Then...

2.3 or newer Authorized

PC-CDU MS will never 
expire and will always work 
as MS (full functionality) 
when connected to this 
authorized receiver.

2.3 or newer Not authorized
PC-CDU MS will work as 
Lite (reduced-functionality).

If the Firmware Version Installed on the 
Receiver Is...

Then...

2.2p3 or older

PC-CDU MS will work as 
MS until the expiration date. 
Once this date has been 
reached, the program 
changes into Lite mode.
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CDU is on a CD-ROM or on a diskette, please 
skip to step 6 on page 1-7.

To install PC-CDU on your computer from the Topcon website, 
take the following steps:

1. Visit the Precision GPS section                                         
(http://www.topcongps.com/) of the Topcon website. Click 
on the Software link in the top-left corner of the window. 
Next, select the Software Downloads link. Finally, click 
on the link Click here to download pccdu_ms.zip to start 
program downloading.

NOTICE
To download PC-CDU Lite, select the Utilities link 
on the Software Center page.

2. You will see the dialog box Enter Network Password 
appears on the screen. You are prompted to enter a 
username and password. After you type in this information, 
press OK (Figure 1-1).

Figure 1-1. Enter Network Password

NOTICE
PC-CDU Lite is a freely available software. Thus, 
when you install PC-CDU Lite, the Enter Network 
Password prompt will not appear on the screen.
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3. The File Download dialog box will be opened. To continue 
the download process, press Save (Figure 1-2).

Figure 1-2. Download PC-CDU

4. In the Save As dialog window, specify the desired 
destination (disk drive/folder) for the archive 
pccdu_ms.zip (Figure 1-3).

Figure 1-3. Select a Destination for pccdu_ms.zip

5. Wait while the archive is being downloaded onto your 
system (Figure 1-4).

Figure 1-4. Copying PC-CDU to Your Computer’s Disk Drive
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6. Create a folder on your local disk drive. It is recommended 
to use C:\Program Files\TPS\PC-CDU.

7. Unpack the archive into this folder with WinZip® or 
another appropriate software. You will see the following 
files appear in the folder:

• Executable file Pccdu.exe

• Auxiliary binary file lptaccess.vxd

Removing PC-CDU
The simplest way to remove PC-CDU from a system is to 

delete the whole directory1 that was created when installing 
PC-CDU and in which Pccdu.exe and all of its components 
reside. Also, do not forget to delete the PC-CDU shortcut, if 
available.

1. Assuming this directory is not used for storing any other (i.e., PC-
CDU unrelated) data.
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Getting Connected

Starting PC-CDU
PC-CDU can be launched, as any other Windows program, for 
example, with the Start button.

NOTICE
After the user first runs PC-CDU, he/she will see 
the file pccdu.ini appears in the directory from 
which the executable has been launched. In this 
.INI file PC-CDU will store all its settings. PC-
CDU will automatically modify the contents of the 
.INI file as the user makes changes through the 
program’s controls. Because this file use only 
plain text (i.e., ASCII), it can also be edited with 
any text editor or word processor. Before 
changing the file it is strongly recommended that 
you make a backup copy of the original .INI file.

NOTICE
If the user wants to have more than one copy of 
PC-CDU, each one with its own unique settings, 
the user can keep these copies in separate 
directories. Running different copies of PC-CDU 
from different directories will allow the operator to 
maintain unique setting for each of the copies.
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Once PC-CDU is launched, the Connection Parameters 
window will appear (Figure 1-5).

Figure 1-5. Connection Parameters

In this window the user first selects the desired connection 
mode:

• Direct. This mode is used when it is required to connect a 
computer and a TPS receiver directly, i.e., using the 
computer and receiver serial, parallel, USB or Ethernet 
ports and an appropriate cable.

NOTICE
You can use Ethernet ports to establish direct 
connection between a computer and a TPS 
receiver using direct cable connection or similar 
direct connection through the Internet. For more 
information about communicating via Ethernet, 
see “Establishing an Ethernet Connection” on 
page 1-17.

• Internet Server. When running PC-CDU in Internet Server 
mode on a PC connected to the Internet, the software 
provides the ability to get remote Internet access to the TPS 
receiver connected to this PC using any direct connection 
mode (serial, parallel, USB, or Ethernet ports). Current 
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Internet Server implementation allows for access by only 
one remote terminal (PC-CDU Client) at a time.

• Internet Client. This mode may be used when it is required 
to access a remote receiver that is directly connected with 
some other PC and the PC-CDU software is running on that 
PC in Internet Server mode. Both computers with PC-CDU 
Internet Server and Internet Client software up and running, 
should be connected to the Internet to get the remote Client 
access to Server.

Establishing a Serial Port Connection
To establish a connection between your computer and the 
receiver using serial ports, follow these steps:

1. Connect one of the available receiver’s port (usually A) to a 
communication port on the computer using a Receiver-to-
Computer RS-232 serial cable.

2. Supply power to the receiver and computer, then turn them 
on.

3. Run PC-CDU.

4. From the Port list box, select the computer serial port 
(COM1, COM2,...) that you want to use for the 
connection.

5. From the Baud Rate list box, select the desired baud rate.

6. Select the RTS/CTS handshaking checkbox.

NOTICE
It is recommended that the user enables        
RTS/CTS handshaking as this makes data 
exchange between the receiver and computer 
more reliable. Prior to selecting this control, 
make sure that:
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•RTS/CTS handshaking is supported both at the 
computer and at the receiver.

•The cable used allows RTS/CTS handshaking.

7. Press Connect. Figure 1-5 on page 1-9 shows an example 
of the Connection Parameters window for this connection 
type.

NOTICE
By changing the parameters in the Port settings 
area of the Connection Parameters window, the 
user configures the communication port of the 
PC and the desired settings of the receiver’s 
communication port, which will be set up once 
you click the Connect button.

The Infrared port checkbox is selected when the user want to 
use an infra-red adaptor to establish a connection between a 
computer and receiver over an infrared data-link.

Connection via an infrared port will be available only if the 
following conditions are met:

• An appropriate external infrared adaptor is connected to the 
selected serial port on the computer side.

• Your receiver supports the infrared port hardware-wise.

• The Infrared Port option is enabled in your receiver.

Along with the above listed controls, the user may need to 
adjust some of the settings in the Program Settings area. This 
area includes the following four controls:

• Passive mode

• Manual mode only

• Timeout
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• Restore the receiver’s original baud rate on Disconnect

In Passive mode PC-CDU is not allowed to change any 
receiver parameters. Note that in this mode PC-CDU will 
display in the main window only those satellites whose 
elevation angles are larger than the elevation mask specified by 
the parameter Terminal Elevation Mask (see Chapter 3 on 
page 3-35). Once Passive mode is off, PC-CDU will 

automatically force Terminal Elevation Mask to -900. 
Therefore the user will be able to view in PC-CDU’s main 
window (see Chapter 3 on page 3-1) all of the satellites that are 
being tracked. It is important to remember that this setting        

(-900) will be effective as long as the main window remains 
open. Note however that the original value of Terminal 
Elevation Mask will not be lost in this case; once the main 
window is closed, PC-CDU will automatically restore the 
original mask.

If Manual mode only is on, PC-CDU will perform as an   
input/output terminal, which allows the user to send commands 
to and receive information from the receiver without 
performing any connection procedure with the receiver.

With the Timeout [ms] drop down list box, the user specifies 
the number of milliseconds the program will wait before 
switching to the next baud rate while establishing connection 
with the receiver through serial ports.

If the user has selected the Restore the receiver’s original 
baud rate on Disconnect checkbox, PC-CDU will determine 
and save the receiver port’s original baud rate (i.e., that the 
receiver port had before running PC-CDU) and then restore this 
setting automatically on disconnecting the receiver (by pressing 
the Disconnect menu item).
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Establishing a Parallel Port Connection
Before connecting the receiver and your PC using parallel ports 
and the corresponding cable, make sure the following 
requirements are met:

1. The computer runs under Windows 95, 98 or ME.

2. The computer’s parallel port has been configured as ECP or 
ECP+EPP.

3. The Parallel Port option has been enabled in the receiver.

WARNING
If run on a Windows NT/2000 computer, PC-
CDU does not allow connection to the 
receiver via parallel ports.

To establish a connection between your computer and the 
receiver using parallel ports, follow these steps:

1. Connect the receiver’s parallel port (usually marked 
Parallel) to a parallel port on the computer using a supplied 
Receiver-to-Computer parallel cable.

2. Supply power to the receiver and computer, then turn them 
on.

3. Run PC-CDU.

4. From the Port list box, select the computer parallel port 
(LPT1, LPT2,...) that you want to use for the connection.
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5. Press Connect (Figure 1-6).

Figure 1-6. Parallel Port Connection Parameters

For a description of the available Program settings, see 
“Establishing a Serial Port Connection” on page 1-10.

Establishing a USB Connection
Before connecting a USB equipped TPS receiver with PC’s 
USB port, make sure that you have the USB Port option 
enabled in the receiver and the TPS USB driver installed on the 
computer.

Checking Option

To verify whether or not the USB Port option is enabled, 
you can use a direct serial cable connection. Once 
connected, click Tools, then Receiver options.

• If enabled, you will see yes in the Current column of 
the USB Port option.

• If disabled, you will see no in the Current column of 
the USB Port option.
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Installing Driver

NOTICE
This procedure refers to the USB driver version 
2.0.0.2, build date November 24, 2003.

The driver installation procedure varies slightly depending 
on the operating system used. In general, the installation 
procedure is as follows:

NOTICE
For detailed information on the driver installation 
for your specific operating system, refer to the 
appropriate sections of “How to Install the TPS 
USB Driver...” on page 2-2.

1. Visit the GPS Precision section                                         
(http://www.topcongps.com/) of the Topcon website. 
Click on the Software link in the top-left corner of the 
window. Next, select the Software Downloads link. 
Finally, click on the tps_usb.zip link to start driver 
downloading.

2. Unpack the archive into a separate, empty folder. You 
will see the following files appear in the folder:

• Tpsusbio.inf

• Tpsusb98.sys

• Tpsusbio.sys

3. Connect the receiver to the computer through the 
supplied USB cable. Turn the receiver on.

4. Windows will automatically detect the new hardware 
device. Follow the on-screen instructions to finish 
installation process.
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After Windows finishes installing the driver, you will be 
able to connect the receiver and the computer via USB 
ports.

Connecting

To establish a connection with the receiver using USB 
ports, follow these steps:

1. Insert the USB cable’s 5-pin connector into the USB 
port of the receiver. Plug the opposite end of this cable 
into the USB port on the computer.

2. Turn on the computer and receiver.

3. Start PC-CDU.

4. From the Port list box, select the computer’s USB port 
(USB).

5. From the Rec ID list box, select the receiver’s ID you 
want to connect to.

6. Press Connect (Figure 1-7).

Figure 1-7. USB Connection Parameters

For a description of the available Program settings, see 
“Establishing a Serial Port Connection” on page 1-10.
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WARNING
USB connection cannot be established if you 
run the PC under Windows 95/NT.

Establishing an Ethernet Connection
There are two Ethernet-based methods used for communication 
with a TPS receiver:

1. Communication with a receiver directly connected to a 
computer

2. Communication with a receiver connected to an existing 
TCP/IP Ethernet network

Connecting the Receiver Directly to a PC

This method is used when you have a PC, a TPS receiver 
and have no existing Ethernet network, but would like to 
communicate with the receiver via Ethernet.

NOTICE
It can be useful to apply this method for 
preliminary tests if you are going to use the 
receiver later on a real TCP/IP network.

Before establishing the connection, make sure you have the 
following:

• A PC with an Ethernet card installed and the TCP/IP 
protocol configured

• A TPS receiver with physically installed and enabled 
by options Ethernet port

• Appropriate cables: 

–Ethernet adapter (p/n 14-008032-01).
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–An Ethernet cross-over cable (this cable is typically 
available from your local computer store or from many 
online computer stores).

–You should also have an RS-232 cable (p/n 14-
008005-02) to configure IP settings of your receiver.

The following procedure shows you how to connect the 
receiver directly to a PC using Ethernet ports.

NOTICE
You should have already installed an Ethernet 
card and configured the TCP/IP protocol on your 
computer. For definiteness assume that you use 
a protocol with the following settings: IP address 
– 192.168.0.1, Gateway – 192.168.0.3 (actually, 
since you have only two devices connected 
directly and have no connections to another 
network, you can set the gateway address all 
zeros), Subnet mask – 255.255.255.0.

Take these steps to connect the receiver to a PC using the 
Ethernet ports:

1. Connect your computer and receiver with a serial cable.

2. Run PC-CDU. Select appropriate communication 
settings for connection via serial ports and then click 
Connect.

3. Go to Configuration  Receiver  Ports  
Ethernet.

4. Specify IP settings for your receiver.

• IP Address – set the same value as the computer’s IP 
address, except for the last number (it must differ from 
the computer's IP address but lies in the range from 0 to 
255, for example, 192.168.0.2)
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• IP Mask – set exactly the same number as you use for 
the computer

• Gateway – set exactly the same number as you use for 
the computer

5. In the Telnet Settings area leave all settings as they are 
but make sure that TCP port is set to 8002.

Remember the value in the Network Password field (if 
you do not want to use any password, you may simply 
clear this field). Click Apply  OK.

6. Restart the receiver by selecting Tools  Reset 
receiver.

7. Insert the corresponding end (having seven pins) of the 
Ethernet adapter into the ETHR port of the receiver. 
Connect the other end of this adapter with the Ethernet 
crossover cable (either of its ends can be used). Plug 
the second end of the crossover cable into the Ethernet 
jack on the computer's back (Figure 1-8).

Figure 1-8. Direct Ethernet Connection – Hardware Setup
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8. Run PC-CDU. In the Connection Parameters window, 
specify the following settings:

• Connection mode – Direct

• Port – ETHR

• TCP port – 8002

• Host name – IP address that you have assigned to the 
receiver in step 4.

• Password – exactly the same series of characters as 
you have specified for the receiver in step 5 or keep it 
blank if you do not use a password.

9. Click Connect (Figure 1-9).

Figure 1-9. Ethernet Connection Parameters

After establishing connection, you will see the current 
connection type (Ethr) and the receiver's IP address in 
the bottom left corner of the PC-CDU's main window 
(Figure 1-10).
Topcon PC-CDU User’s Manual



Getting Connected

1-21
Figure 1-10. PC-CDU Main Window – Ethernet Connection Established

From this moment on, you may interact with the 
receiver in a normal way (i.e., record files into the 
receiver's memory and onto the computer's drives, send 
commands into the receiver, and so on).

Connecting the Receiver to an Existing TCP/IP 
Ethernet Network

This method is used when you have an existing local area 
network (LAN) consisting of a group of computers and 
network communication devices interconnected and a TPS 
receiver that you want to place on this LAN. This method is 
also used to connect a TPS receiver directly to the Internet 
and access this receiver from a remote PC, connected to the 
Internet.

Before establishing the connection, make sure you have 
each of the components listed below:

• An operational TCP/IP LAN or connection to the 
Internet

• Appropriate cables:

–Ethernet adapter (p/n 14-008032-01).
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–A straight-through Ethernet cable (this cable is 
typically available from your local computer store or 
from many online computer stores).

–You should also have an RS-232 cable (p/n 14-
008005-02) to configure IP settings of your receiver.

• A TPS receiver with physically installed and enabled 
by options Ethernet port. To verify whether or not the 
Ethernet options are enabled, use the Option Manager 
window of PC-CDU (click Tools, then Receiver 
options). The value of the Ethernet Port option in the 
Current column must be set to yes. TCP Connections 
must be in the range from 1 to 5. FTP Connections 
must be set to 1 only if you are going to download 
receiver files via FTP. For more information about 
receiver options including Ethernet-related options, see 
Table 3-9 on page 3-101.

The following procedure shows you how to attach the 
receiver to an existing network.

NOTICE
It is very important to work closely with your 
system administrator to make the connection 
succeed. The system administrator should 
provide a unique IP address, Subnet mask, and 
Default gateway for the receiver. Also, make sure 
the system administrator realizes that each TPS 
receiver on the network must have a static IP 
address, whether or not a Dynamic Host 
Configuration Protocol (DHCP) server is used on 
the network.

1. Connect your computer and the receiver with a serial 
cable.
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2. Run PC-CDU. Select appropriate communication 
settings for the connection via serial port and then click 
Connect.

3. Go to Configuration  Receiver  Ports  
Ethernet.

4. Specify IP settings for your receiver:

• IP Address

• IP Mask

• Gateway

CAUTION
If in doubt about which IP settings are safe to 
use, consult your system administrator.

5. Configure Telnet Settings and Network Password. 
You may use the following settings:

• TCP port – 8002 (default value). This is the port on 
which the receiver listens for telnet-like connections. 
The receiver allows up to five simultaneous telnet-like 
connections.

• Timeout – 600 (default value). This parameter sets the 
amount of time in seconds the receiver allows an 
inactive connection to remain open. After this time, the 
receiver terminates the unused connection.

• Network Password – an arbitrary sequence of 
characters (if you do not want to use any password, you 
may simply leave this field blank).

6. Configure FTP Settings (optional). You may use the 
following settings:

• TCP port – 21 (default value). This is the port on 
which the receiver listens for FTP connection. The 
receiver allows only one FTP connection at a time.
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• Timeout – 600 (default value). This parameter sets the 
length of time in seconds the receiver allows an inactive 
connection to remain open. After this time, the receiver 
terminates the unused connection.

7. Click Apply  OK.

8. Restart the receiver by selecting Tools  Reset 
receiver.

9. Insert the Ethernet adapter’s 7-pin connector into the 
ETHR port of the receiver. Connect the opposite end of 
this adapter with the Ethernet straight-through cable 
(either of its ends can be used). Plug the second end of 
the straight-through cable into the appropriate Ethernet 
port on your LAN hub or switch (Figure 1-11 on 
page 1-25).
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Figure 1-11. Receiver on LAN – Hardware Setup

TIP
At this point, it is a good idea to check that the 
receiver responds to the ping command. From 
the Windows command prompt or Run dialog 
box, type: ping [receiver’s IP address]. For 
example, ping 195.105.138.43. If the receiver 
responds, go to step 10. If it does not respond, 
double-check the LAN connections and 
addresses.
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10. Run PC-CDU. In the Connection Parameters window, 
specify the following settings:

• Connection mode – Direct

• Port – ETHR

• TCP port – 8002

• Host name – IP address that you have assigned to the 
receiver in step 4

• Password – exactly the same series of characters as 
you have specified for the receiver in step 5 or keep it 
blank if you do not use a password.

11. Click Connect (see Figure 1-8 on page 1-19). After 
establishing the connection, you will see the current 
connection type (Ethr) and the receiver's IP address in 
the bottom left corner of the PC-CDU's main window 
(see Figure 1-10 on page 1-21). From this moment on, 
you may interact with the receiver in a normal way 
(i.e., record files into the receiver's memory and onto 
the computer's drives, send commands into the receiver, 
and so on) plus some network abilities (i.e., transfer 
files from the receiver over a TCP/IP network using 
FTP, connect up to 5 remote terminals to the receiver).

NOTICE
For how to transfer raw data files from the 
receiver to the remote computer using FTP, refer 
to Chapter 2 on page 2-26.

Establishing an Internet Client–Server 
Connection

Internet Server Mode

When running PC-CDU in Internet Server mode, the 
software provides the ability to get access to a TPS receiver 
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connected to the computer with a direct serial, parallel or 
USB connection from a remote location. Remote terminals 
(PC-CDU clients) can then access this PC-CDU server via 
the Internet.

NOTICE
The current implementation of the Server feature 
allows for access by only one remote terminal 
(PC-CDU client) at a time.

The parameters Port, Baud rate, Infrared port, RTS/
CTS handshaking, Passive mode serve the same purposes 
as in Direct mode (see “Establishing a Serial Port 
Connection” on page 1-10). The other group of parameters, 
Internet (Client - Server) settings, are intended for the 
user to tune PC-CDU for Internet connection: TCP port, 
Password, Display data on server, Log server events, 
and DNS lookup.

Special attention should be given to setting TCP port for 

PC-CDU servers2. Make sure that the selected TCP port 
does not coincide with any one of the reserved port 
numbers. The default TCP port number is 8000.

The Password edit box is used to protect the PC-CDU 
server from unauthorized access. The user can enter in this 
edit box up to 128 alphanumeric characters.

If the user has selected the Log server events checkbox, 
there will be created a text log file 
(pccdu_server.log) in PC-CDU's working directory. 
This file will contain some information that has been 

2. According to TCP specifications, TCP port number can be up to 64 
K. Although the user can formally enter a port number N, which is 
greater or equal to 64 K, the software will implicitly force it to N mod 
64 K.
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collected during the communication session between the 
PC-CDU server and PC-CDU client. New information will 
be added to the file after another client connects to the PC-
CDU server.

If the user wants to view the satellite information and the 
antenna's current position in the main windows, he/she 
must select the Display data on server checkbox. 
Otherwise no information will be displayed in the window.

If the DNS lookup checkbox is selected, the file 
pccdu_server.log will contain the IP and DNS 
addresses. Otherwise this file will include the IP addresses 
only.

Figure 1-12 shows an example of the Connection 
Parameters dialog window in Internet Server mode.

Figure 1-12. Internet Server Connection Parameters

In this example a four-character password and the default 
TCP port number are used.
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After the Connect button is pressed, the Main and Server 
dialog windows will be displayed (Figure 1-13).

Figure 1-13. Internet Server Started

The Server window allows an operator running PC-CDU 
Server to communicate with his/her counterpart who runs 
the corresponding PC-CDU Client. In addition, this dialog 
window displays information about the server's current 
status.

Internet Client Mode

The user selects Internet Client mode when it is required to 
access a remote receiver that is directly connected with and 
controlled by a computer on which PC-CDU Server is 
being run (the obvious pre-condition is that both computers 
must have access to the Internet).

After a connection to the remote receiver is established, the 
user can control this receiver exactly in the same manner as 
if the user's computer were directly connected to the 
receiver, specifically: send commands to the remote 
receiver, download log files from the receiver's memory, 
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etc. In order to be able to connect to the remote receiver, the 
user first needs to configure his/her computer as a PC-CDU 
Client capable of working with the corresponding PC-CDU 
Server.

The user is required to know the following information 
about the PC-CDU Server:

• IP or DNS address

• TCP port number

• password (if necessary).

Figure 1-14 shows an example of the Connection 
Parameters dialog window with the following settings:

• PC-CDU Server’s IP address: 194.85.135.59

• TCP port number: 8000

• Password is not used

Figure 1-14. Internet Client Connection Parameters

NOTICE
In the Host name edit box the user can enter 
either the server’s IP address (it is 194.85.135.59 
in the given example) or its DNS address (it is 
pab.topconps.com in this case).
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After all necessary settings have been entered into this 
window, press Connect. You will see PC-CDU open the 
Main window and the Client window (Figure 1-15).

Figure 1-15. Internet Client Started

The Client window allows the operator running PC-CDU 
Client on one end to exchange messages with the operator 
running PC-CDU-Server on the other end. Messages sent 
from the client to the server are preceded by the character 
">". Messages sent by the server to the client begin with the 
character "<". The last received message is topmost in the 
list.

Closing PC-CDU
To disconnect from the receiver, select the Disconnect menu 
item from the File menu. Alternatively, you can use the Ctrl+D 
keys to close the connection.

Pressing Disconnect will result in

1. Turning off RTS/CTS handshaking.
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2. Resetting the receiver control Terminal Elevation Mask 
to its original value (only if the Passive mode checkbox 
has not been deselected).

3. Resetting the baud rate to 115200, if the receiver’s original 
baud rate (i.e., that the receiver has before running PC-
CDU) exceeded 115200.

4. Restoring the original baud rate, only if the Restore the 
receiver’s original baud rate on Disconnect control has 
been selected.

To quit PC-CDU, select Exit from the File menu. Alternatively, 
you can close the program by pressing the Ctrl+X keys.

If the receiver has not been disconnected by the time the 
program is terminated, the connection will be automatically 
broken before PC-CDU is closed.

NOTICE
It is strongly recommended to close the 
connection with the receiver and close PC-CDU 
prior to switching the receiver off and 
disconnecting the cable.
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This chapter contains a number of step-by-step instructions that will 
walk you through the most frequent software procedures, focusing 
only on the configuration procedures most likely to be used.

It is addressed to those users wishing to know how to configure a 
TPS receiver for a particular job using PC-CDU. Because it is a 
quick reference, this chapter does not contain a detailed description 
of the settings listed. For a detailed information about the settings 
used, refer to the corresponding sections of the third chapter.

How to Connect to the Receiver
Physically connect the receiver and a computer using either a serial, 
parallel, USB, or Ethernet cable and refer to:

• “Establishing a Serial Port Connection” on page 1-10 for a 
serial port connection procedure.

• “Establishing a Parallel Port Connection” on page 1-13 for a 
parallel port connection procedure.

• “Establishing a USB Connection” on page 1-14 for a USB port 
connection procedure.

• “Establishing an Ethernet Connection” on page 1-17 for an 
Ethernet port connection procedure.

How to Navigate through the Software
Moving through PC-CDU is like moving through any other 
Windows program. You can use your mouse to position the cursor 
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over the desired control and then click a mouse button or you can 
use the Tab key to move around window.

You can also use shortcut keys. These keys are used in menus where 
an alternate keystroke sequence is defined. These shortcut keys are 
shown on the right side of the corresponding menu items. For 
example, the user can select the Site item (from the Configuration 
menu) with the keys Ctrl+I.

How to Install the TPS USB Driver...

NOTICE
This section describes the first-time installation 
procedure for the USB driver version 2.0.0.2, 
build date November 24, 2003. If you already 
have the previous version of USB driver (as of 
1.0.1.0, October 25, 2002) installed, refer to the 
corresponding section of “How to Update the 
TPS USB Driver...” on page 2-11 to know how to 
update the driver for your specific operating 
system.
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On Windows 98 SE
1. Once you connected the receiver and the computer through 

the USB cable, the Add New Hardware Wizard window 
displays. Click Next.

Figure 2-1. Windows 98 SE – Add New Hardware Wizard

2. Select Search for the best driver for your device. 
(Recommended). and then click Next.

Figure 2-2. Windows 98 SE – Select the Driver Search Method
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3. In the next window, select Specify a location and click 
Browse.

Figure 2-3. Windows 98 SE – Locate Driver Files

4. Select the folder on the computer drive, where the driver 
resides, click OK.

Figure 2-4. Windows 98 SE – Browse for Folder
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5. Make sure you have selected the correct driver location and 
then click Next.

Figure 2-5. Windows 98 SE – Driver Location Specified

6. Make sure that TPSUSBIO.INF has been detected and 
then click Next.

Figure 2-6. Windows 98 SE – Ready to Install Driver
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7. When driver installation is completed, the window shown 
below appears. Click Finish.

Figure 2-7. Windows 98 SE – USB Driver Installation Complete

On Windows ME
1.

2.

3.

4.

On Windows NT
1.

2.

3.

4.
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On Windows 2000
1. Once you connected the receiver and the computer through 

the USB cable, the Found New Hardware Wizard window 
displays. Click Next.

Figure 2-8. Windows 2000 – Found New Hardware Wizard

2. On the next Wizard window, select Search for a suitable 
driver for my device (recommended) and then click Next.

Figure 2-9. Windows 2000 – Install Hardware Device Drivers
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3. On the Wizard’s Locate Driver Files window, select 
Specify a location and then click Next.

Figure 2-10. Windows 2000 – Locate Driver Files

4. In the next window, click Browse.

Figure 2-11. Windows 2000 – Click Browse
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5. Select the folder on the computer drive, where the driver 
resides, click Open.

Figure 2-12. Windows 2000 – Browse for Folder

6. Make sure you have selected the correct driver location and 
then click OK.

Figure 2-13. Windows 2000 – Driver Location Specified
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7. Make sure that TPSUSBIO.INF has been detected and 
then click Next.

Figure 2-14. Windows 2000 – Ready to Install Driver

8. When driver installation is completed, the window shown 
below appears. Click Finish.

Figure 2-15. Windows 2000 – USB Driver Installation Complete

On Windows XP
1.

2.

3.
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How to Update the TPS USB Driver...
You will need to update the TPS USB driver to version 2.0.0.2 if 
you want to have a USB connection working properly with PC-
CDU version 2.1.13 or later.

On Windows 98 SE
1. Use the USB cable to connect the receiver and the USB 

port on the PC.

2. Open the Device Manager window, double-click 
Universal Serial Bus controllers, right-click your 
receiver, and then click Properties.

Figure 2-16. Windows 98 SE – Device Manager
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3. On the Receiver Properties window, select the Driver tab 
and then click Update Driver.

Figure 2-17. Windows 98 SE – Click Update Driver

4. The Upgrade Device Driver Wizard window displays, click 
Next.

Figure 2-18. Windows 98 SE – Driver Upgrade Wizard Welcome
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5. Select Display a list of the known drivers for this device 
so that I can choose a specific driver and then click Next.

Figure 2-19. Windows 98 SE – Update Hardware Device Drivers

6. On the next window, choose the desired receiver and click 
the Have Disk button.

Figure 2-20. Windows 98 SE – Select a Device Driver
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7. The Open window appears. Select the driver and folder 
from which to install the driver (TPSUSBIO.INF) and 
click OK.

Figure 2-21. Windows 98 SE – Browse for the Driver

8. The Install From Disk window appears. Click OK.

Figure 2-22. Windows 98 SE – Install From Disk->Click OK

9. On the next window, select your receiver model and click 
Next.

Figure 2-23. Windows 98 SE – Select the receiver model->click Next

10. On the Ready to install window, click Next to begin 
installation process.
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11. When the USB driver installation completes, click Finish 
to close the installation wizard.

Figure 2-24. Windows 98 SE – USB Driver Installation Complete

On Windows ME
1.

2.

3.

4.

On Windows NT
1.

2.

3.

4.

On Windows 2000
1. Once you connected the receiver and the computer through 

the USB cable, open the Device Manager window, double-
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click Universal Serial Bus controllers, right-click your 
receiver, and then click Properties.

Figure 2-25. Windows 2000 – Device Manager->Select the Receiver

2. On the Receiver Properties window, select the Driver tab 
and then click Update Driver.

Figure 2-26. Windows 2000 – Receiver Properties->Update Driver
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3. The Upgrade Device Driver Wizard window displays, click 
Next.

Figure 2-27. Windows 2000 – Driver Upgrade Wizard Welcome

4. Select Display a list of the known drivers for this device 
so that I can choose a specific driver and then click Next.

Figure 2-28. Windows 2000 – Install Hardware Device Drivers
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5. On the Select a Device Driver window, choose the desired 
receiver and click the Have Disk button.

Figure 2-29. Windows 2000 – Select a Device Driver

6. The Install From Disk window appears. Click the Browse 
button and select the folder from which to install the driver 
(TPSUSBIO.INF).

Figure 2-30. Windows 2000 – Install From Disk->Browse
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Once you locate the driver, click Open. The Install From 
Disk window reappears, click OK.

Figure 2-31. Windows 2000 – Install From Disk->OK

7. On the next window, select your receiver model and click 
Next.

Figure 2-32. Windows 2000 – Select the receiver model->click Next

8. On the Start Device Driver Installation window, click 
Next to begin installation process.
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9. When the USB driver installation completes, click Finish 
to close the installation wizard ().

Figure 2-33. Windows 2000 – USB Driver Installation Complete

On Windows XP
1.

2.

3.

4.

How to Disconnect from the Receiver
From the File menu, click Disconnect, then click Exit.

How to Start Data Logging...

To the Receiver Memory
1. In the File menu, select File Manager item.

2. Click the Current log file tab and set the following 
parameters:

• File name – type in the name of the file to which the 
receiver will log data
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• Recording interval – set the data logging interval

• Elevation mask – set the elevation cut-off angle

• Site parameters – click this button and in the window 
appeared, enter the site name and antenna details

3. Click OK and then Start. A new log file will be created 
and the receiver will start recording data into the file.

For details, see “Current log file Tab” on page 3-18.

On the Computer
1. In the File menu, select Real-Time Logging item.

2. Click the Select output path tab and navigate to and open 
the folder in which to download and store log files. Or, type 
a new folder in which to download and store files.

3. Select the desired file creation mode, set the following 
parameters, and then click Start.
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For more detailed information, see “Single file Tab” on page 3-
25 and “Multiple files Tab” on page 3-26.

How to Convert Real-Time TPS Raw 
Data Files to RINEX
1. In the File menu, select Real-Time Logging item.

If Single file selected... If Multiple files selected...

• In the Save to field, 
enter the file name.

• In the Recording 
interval field, 
specify the data 
logging interval.

• Click Site 
parameters button 
and in the window 
appeared, enter the 
site name and 
antenna details, then 
click OK.

• In the Elevation 
mask field, set the 
elevation cut-off 
angle.

• In the Prefix field, enter the prefix part 
of the filename.

• From the Numbering filed, select the 
desired file numbering scheme.

–If you select Ascending Count, then 
you can enter initial numeric value of 
the file count in the Start Count filed.

• In the New file every field, specify the 
duration, in minutes, hours, or days, of 
the files during the logging.

• Enable the Overwrite existing files 
checkbox if you want this to occur.

• To cause the program to automatically 
convert TPS files to the RINEX format, 
enable the Autoconvert to RINEX 
checkbox and click the Setup 
converter button to adjust the 
converter settings.

• In the Recording interval field, 
specify the data logging interval.

• Click Site parameters button and in 
the window appeared, enter the site 
name and antenna details, then click 
OK.

• In the Elevation mask field, set the 
elevation cut-off angle.
Topcon PC-CDU User’s Manual



How to Convert Real-Time TPS Raw Data Files to RINEX

2-23
2. Click the Select output path tab and navigate to and open the 
folder in which to download and store the original tps log files 
and their RINEX counterparts. Or, type a new folder in which 
to download and store files.

3. Select the Multiple files tab, and set the following parameters:

• In the Prefix field, enter the prefix part of the filename.

• From the Numbering filed, select the desired file numbering 
scheme.

–If you select Ascending Count, then you can enter initial 
numeric value of the file count in the Start Count filed.

• In the New file every field, specify the duration, in minutes, 
hours, or days, of the files during the logging.

• Enable the Overwrite existing files checkbox if you want this 
to occur.

• In the Recording interval field, specify the data logging 
interval.

• In the Elevation mask field, set the elevation cut-off angle.

4. Enable the Autoconvert to RINEX checkbox, click the Setup 
converter button, adjust the following parameters, then click 
OK:

• Run by – name of the person who runs the converter.

• Observer – observer name.

• Agency – observing agency.

• Antenna # – serial number of antenna.

• Antenna type – description of antenna (use only antenna names 
approved and standardized by NGS).

• Comment – any text entered here will appear in the header of 
each RINEX file to be generated.

• Marker name – survey marker name.
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• Marker number – survey marker identification number.

• Converter Application – specify the full path to the 
tps2rin.exe file.

• Exclude GPS (Exclude GLONASS) – enable if you want the 
resulting RINEX files do not contain raw data measurements/
ephemeris data corresponding to GPS (GLONASS).

• Exclude L1 (Exclude L2) – enable if you want the resulting 
RINEX files do not contain L1 (L2) raw data measurements.

• Delete source JPS files after successful conversation – enable if 
you want the original tps files removed once their conversion to 
the RINEX format has been successfully completed.

• Additional options – you can enter any of the command-line 
switches available for the RINEX converter to modify its 
behavior.

5. Finally, click the Start button.

For more information on the settings listed, refer to “Multiple files 
Tab” on page 3-26.

How to Stop Data Logging...

To the Receiver Memory
1. In the File menu, select the File Manager item.

2. Click the Current log file tab and click the Stop button.

On the Computer
1. In the File menu, select Real-Time Logging item.

2. Click the Stop button on the Single file or Multiple files 
tab, depending on the logging method selected.
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How to Configure Automatic File 
Rotation Mode
1. In the Configuration menu, select the Receiver item.

2. Select the Minter tab.

3. In the File Creation mode area, select AFRM.

4. In the Automatic File Rotation Mode (AFRM) parameters 
area, set the following parameters and click Apply:

• Period – specify the time duration of the files logged.

• Phase – specify the constant time shift of the files logged.

• Files (total) – enter the number of files to be created.

• Automatically remove old files – tick this checkbox if you want 
the receiver removes the earliest log file when no free memory 
is available to log data.

5. To start data logging in AFRM mode, use the MINTER’s FN 
button as you usually do for recording a single raw data file.

For more information on AFRM mode, refer to “MINTER Tab” on 
page 3-40.

How to Download Files to a Computer 
Using File Manager
1. In the File menu, select the File Manager item.

2. Select the Download path tab.

3. Navigate to and open the folder in which to download and store 
files. Or, type a new folder name and click Create to create a 
new folder in which to download and store files. Open this new 
folder.

4. Select the Download files tab.

5. Select the file(s) to download.

6. Click the Download button.
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7. Once the files have been successfully downloaded, continue 
with other operations. 

How to Download Files to a Remote 
Computer Using FTP
1. Configure your Ethernet-enabled receiver as shown in 

“Connecting the Receiver to an Existing TCP/IP Ethernet 
Network” on page 1-21, steps 1 through 9.

2. From a computer on which you want the files to be stored, open 
a Web browser such as Internet Explorer.

3. In the Address bar of the browser, type an IP address of the 
receiver you want to connect to (e.g., ftp://63.106.139.235).

4. The Login As window appears. Type in an arbitrary User 
Name and the Password intended for access. Click Login.

Figure 2-34. Login As Window

5. Once the access has been verified, you will see a list of log files 
available in the receiver. Select the files you want to download, 
then right-click anywhere within the selected area and click 
Copy To Folder on the pop-up menu.
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Figure 2-35. Copy Log Files

6. Navigate to and open the folder in which to download and store 
files. Click OK and wait until all the selected files copy to the 
computer.

7. Once the files have been successfully copied, continue with 
other operations.

How to Delete Files from the Receiver
1. In the File menu, select the File Manager item.

2. On the Download files tab, select the file(s) you want to delete.

3. Click Delete and Yes at the delete files confirmation dialog 
box. PC-CDU deletes the selected files.

4. Once the files have been successfully deleted, continue with 
other operations.

How to Recover Deleted Files
Before restoring a deleted file, keep in mind the following 
important recommendations:
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• Do not record any new raw data files to the internal memory of 
the receiver from which the file was deleted. Recording new 
files may overwrite the deleted file and make it permanently 
lost.

• Do not attempt to initialize the file system. This procedure 
permanently erases all files inside the receiver.

• Do not try to remove the receiver’s Compact Flash card and 
read its contents with a cardreader.

1. In the File menu, select the Manual Mode item.

2. In the command line at the top of the Manual Mode window, 
type in the %%set,/par/dev/blk/a/removed,on 
command and click Send command.

3. Wait while the receiver re-mounts its file system (during this 
process the REC LED blinks orange).

4. Once the file system is successfully re-mounted (the REC LED 
stops blinking), close the Manual Mode window and select the 
File Manager item from the File menu.

5. From the list of the deleted files, select the desired file and click 
Download.

NOTICE
In this mode you will see the deleted file(s) only.

6. After the file has been successfully downloaded, you need to 
restore the file system to its previous state. For this, do one of 
the following:

• Click Exit on the File Manager window and re-open the 
Manual Mode window. In the command line, type in the 
%%set,/par/dev/blk/a/removed,off command and 
click Send command.

• Click Exit on the File Manager window, then select 
Disconnect from the File menu. Finally, power cycle the 
receiver.
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7. Wait while the receiver re-mounts its file system (during this 
process the REC LED blinks orange).

8. Once the file system is successfully re-mounted (the REC LED 
stops blinking), continue with other configuration procedures 
as needed.

How to Create the Receiver 
Configuration File
1. In the Configuration menu, select the Receiver item.

2. Click the Save button on any of the eight tabs.

3. From the Save setup to a script window, navigate to and open 
the folder in which to save the file.

4. In the File name field, enter the name of the configuration file 
to be created.

5. From the Save as type drop-down box, select the extension for 
the file. It is recommended that you use a .tpc extension.

6. Finally, click the Save button.

How to Load the Configuration File to 
the Receiver
1. In the File menu, select the Manual Mode item.

2. In the bottom-left corner of the Manual Mode window, click 
the Load script button.

3. The Script file window displays. Select the desired 
configuration file. Then click Open. You will see the filename 
appears in the command line.

4. Click the Send command button. The file begins loading. Once 
the >Done! string appears, the loading is completed and the 
settings are applied to the receiver.
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CAUTION
It is not recommended that you load the 
configuration files other than created 
specifically for the selected receiver.

How to Enable WAAS Satellites
1. In the Configuration menu, select the Receiver item.

2. Select the Positioning tab. In the right-hand section, select the 
WAAS subtab.

3. Enable the Channel 1 checkbox.

4. From the Set WAAS and as GPS list boxes, select the WAAS 
satellite PRN code and GPS satellite PRN code, respectively.

5. From the Interpret message #0 as message:# list box, select 2 
(two).

6. With the Use Iono Corrections radio buttons, select the desired 
ionosphere correction mode.

7. If you want that WAAS satellites have their true WAAS PRNs 
(not “GPS associated”), enable the Enable output of "true" 
WAAS PRN numbers checkbox.

8. If required, repeat steps 3-6 for the second channel.

9. Click Apply.

For details, see “Positioning Tab” on page 3-45.

How to Configure Base Station for 
Broadcasting...

RTCM Messages
1. In the Configuration menu, select the Receiver item.

2. Select the Base tab, set the following parameters and click 
Apply:
Topcon PC-CDU User’s Manual



How to Configure Base Station for Broadcasting...

2-31
• GPS/GLO at one time – enable

• Reference Geodetic Coordinates – enter latitude, longitude, 
and altitude (ellipsoidal height) values of the antenna 
position in the selected datum. Do one of the following:

–If known, type in the values.

–Enable Averaged and enter the Averaged Span in 
seconds, then click Apply->OK. Click Tools->Reset 
receiver and wait until the specified interval (span) 
completes. Examine the Base coordinates on the Base tab, 
they should correspond to the coordinates obtained from 
the average.

–Click Get from receiver to use the current antenna 
position.

• In the L1 to L2 Antenna Phase Center offsets edit boxes, 
enter the corresponding components of the L1 antenna 
phase center to L2 antenna phase center vector offset.

• In the RTCM Settings area, adjust the desired settings.

3. Either click the Configuration of Receiver Ports button or 
Ports tab. On the Serial subtab, set the following 
parameters for the port on which you want to generate 
RTCM messages and click Apply->OK:

• Input – select Command.

• Output – select the message set among the following sets 
available and depending on differential mode required

–DGPS RTCM {1,31,3}

–DGPS RTCM {9,34,3}

–RTK RTCM {18,19,22,3}

–RTK RTCM {20,21,22,3}

–RTK RTCM {18,19,23,24}

–RTK RTCM {20,21,23,24}
P/N 7010-xxxx www.topconpositioning.com



Quick Software Reference

2-32
–RTK RTCM3 GD min

–RTK RTCM3 GD full

–RTK RTCM3 GGD min

–RTK RTCM3 GGD full

• Period – enter interval at which receiver will generate 
differential messages.

• Baud rate – select a baud rate (i.e., the rate at which 
receiver will transmit RTCM messages to modem or any 
other device connected to this port).

• RTS/CTS – enable/disable, depending on whether a modem 
connected to the port supports hardware handshaking or 
not.

CMR Messages
1. In the Configuration menu, select the Receiver item.

2. Select the Base tab, set the following parameters and click 
Apply:

• GPS/GLO at one time – enable

• Reference Geodetic Coordinates – enter latitude, longitude, 
and altitude (ellipsoidal height) values of the antenna 
position in the selected datum. Do one of the following:

–If known, type in the values.

–Enable Averaged and enter the Averaged Span in 
seconds, then click Apply->OK. Click Tools->Reset 
receiver and wait until the specified interval (span) 
completes. Examine the Base coordinates on the Base tab, 
they should correspond to the coordinates obtained from 
the average.

–Click Get from receiver to use the current antenna 
position.
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• In the L1 to L2 Antenna Phase Center offsets edit boxes, 
enter the corresponding components of the L1 antenna 
phase center to L2 antenna phase center vector offset.

• In the CMR Settings area, adjust the desired settings.

3. Either click the Configuration of Receiver Ports button or 
Ports tab. On the Serial subtab, set the following 
parameters for the port on which you want to generate 
CMR messages and click Apply->OK:

• Input – select Command.

• Output – select either RTK CMR {10,0,1} or RTK CMR+ 
{10,0,9}.

• Period – enter interval at which receiver will generate 
differential messages.

• Baud rate – select a baud rate (i.e., the rate at which 
receiver will transmit CMR messages to modem or any 
other device connected to this port).

• RTS/CTS – enable/disable, depending on whether a modem 
connected to the port supports hardware handshaking or 
not.

How to Configure Rover Station for 
Accepting...

RTCM Messages in DGPS mode
1. In the Configuration menu, select the Receiver item.

2. Select the Rover tab, set the following parameters and click 
Apply:

• Positioning Mode – enable DGPS (Code Differential).

• If you use multiple Base stations, adjust the parameters 
within the Multi-base area. For details, see “Rover Tab” on 
page 3-61.
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• CD Corrections max. age – use the default value.

• Iono Corrections max. age – use the default value.

• Use Iono Corrections – use the default state.

• Source – use the default value.

3. Either click the Configuration of Receiver Ports button or 
Ports tab. On the Serial subtab, set the following 
parameters for the port on which you want to accept RTCM 
messages and click Apply->OK:

• Input – select RTCM.

• Output – select None.

• Baud rate – select a baud rate (i.e., the rate which will be 
used by the receiver for data reception from modem or any 
other device connected to this port).

• RTS/CTS – enable/disable, depending on whether a modem 
connected to the port supports hardware handshaking or 
not.

RTCM Messages in RTK mode
1. In the Configuration menu, select the Receiver item.

2. Select the Rover tab, set the following parameters and click 
Apply:

• Positioning Mode – enable RTK Fixed.

• Use the default values for other parameters available.

3. Either click the Configuration of Receiver Ports button or 
Ports tab. On the Serial subtab, set the following 
parameters for the port on which you want to accept RTCM 
messages and click Apply->OK:

• Input – select RTCM.

• Output – select None.
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• Baud rate – select a baud rate (i.e., the rate which will be 
used by the receiver for data reception from modem or any 
other device connected to this port).

• RTS/CTS – enable/disable, depending on whether a modem 
connected to the port supports hardware handshaking or 
not.

CMR Messages
1. In the Configuration menu, select the Receiver item.

2. Select the Rover tab, set the following parameters and click 
Apply:

• Positioning Mode – enable RTK Fixed.

• Use the default values for other parameters available.

3. Either click the Configuration of Receiver Ports button or 
Ports tab. On the Serial subtab, set the following 
parameters for the port on which you want to accept CMR 
messages and click Apply->OK:

• Input – select CMR.

• Output – select None.

• Baud rate – select a baud rate (i.e., the rate which will be 
used by the receiver for data reception from modem or any 
other device connected to this port).

• RTS/CTS – enable/disable, depending on whether a modem 
connected to the port supports hardware handshaking or 
not.

How to Setup Raw Data & Position 
Update Rates to 20 Hz
1. In the Tools menu, select the Receiver options item.
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2. Make sure that the Position update rate (Hz) and Raw data 
update rate (Hz) options display 20 in the Current column, 
then click Exit.

3. In the Configuration menu, select the Receiver item.

4. Select Advanced->Raw Data Management, set the following 
parameters and click Apply->OK:

• In the Raw Measurement Update Rate area, set the Update 
Rate parameter to 50 ms.

• In the Position Update Rate area, set the Update Rate 
parameter to 50 ms.

• Click Refesh and examine the values in the Current Update 
Rate fields, they should display 50.

From this moment on, the receiver will output the measurement 
data and position information at 20 Hz.

Alternatively, when you request any data recording or output with a 
0.05 second period, PC-CDU will launch Output Period Setup 
Wizard, that will do the same steps as described above.

How to Enable a 1 PPS Output
1. In the Configuration menu, select the Receiver item.

2. Select the Events tab, set the following parameters and click 
Apply:

• PPS A Enabled – enable.

• Period – enter the pulse output interval in milliseconds.

• Offset (ms) – enter the millisecond part of the pulse offset from 
the selected reference time (if required).

• Offset (ns) – enter the nanosecond part of the pulse offset from 
the selected reference time (if required).

• Period of ‘marked’ pulses – enter the marked pulse output 
interval in milliseconds (if required).
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• Edge – select either the rising or falling edge of the pulse to be 
synchronized with the selected reference time.

• Ref. Time – select the reference time that the 1PPS signal will 
be synchronized with.

• Tied with Ref. Time – enable if you want the receiver 
synchronizes the 1PPS signal with the chosen reference time.

3. Repeat step 2 to enable the PPS B output (if required).

For details, see “Events Tab” on page 3-76.

How to Enable an Event Marker Input
1. In the Configuration menu, select the Receiver item.

2. Select the Events tab, set the following parameters and click 
Apply:

• Event A Enabled – enable.

• Clock Synchronization – leave default.

• Edge – select the edge at which the input signal will be time 
tagged.

• Ref. Time – select reference time scale that the event reception 
time will be synchronized with.

• Tied with Ref. Time – enable to measure the event reception 
time in the selected reference time with consideration for the 
computed receiver clock offset.

3. Repeat step 2 to enable the Event B input (if required).

For details, see “Events Tab” on page 3-76.

How to Output Position in a Pre-
defined Datum
1. In the Configuration menu, select the Receiver item.
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2. Go to the Positioning tab, select the desired datum ID from the 
Current Datum drop-down list box and click Apply.

NOTICE
To view or log the receiver position in the 
selected datum, use NMEA messages, for 
example GGA.

How to Output Position in a User-
defined Datum
1. In the Configuration menu, select the Receiver item.

2. Select the Positioning tab, click Datum Parameters and set 
the following parameters:

• Current Datum – select USER.

• Enter the corresponding values in the Reference Ellipsoid 
parameters and Transformation parameters group boxes.

• Click Apply->OK.

3. Finally, click Apply on the Positioning tab.

NOTICE
To view or log the receiver position in the 
selected datum, use NMEA messages, for 
example GGA.

How to Restore Receiver Default 
Settings
Do one of the following:

• In the Configuration menu, select the Receiver item. On either 
tab, click the Set all parameters to defaults button. 

• In the Tools menu, select the Clear NVRAM item.
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NOTICE
Clearing the NVRAM causes the receiver to 
delete any data stored in its nonvolatile memory, 
including receiver parameters, ephemeris and 
almanac data and receiver position. No raw data 
files will be deleted in this case.

How to Check Firmware Version
1. In the Help menu, select the About item.

2. The About PC-CDU window opens. Check the Firmware 
version field.

3. When finished, click OK, then continue with other 
configuration or operation functions as needed.

How to Check Receiver Options
1. In the Tools menu, select the Receiver options item.

2. The Option Manager window displays and contains the 
following information:

• Option name – a name/description of the option

• Current – the current status of the option

GPS Receiver 
Firmware Version
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• Purchased – if the option is purchased or not

• Leased – if the option is leased or not

• Expiration date – the date the option will be disabled, if 
applicable

3. When finished, click Exit to close this window.

How to Load New OAF to Receiver
1. In the Tools menu, select the Receiver options item.

2. Click Load at the bottom of the Option Manager window.

3. Navigate to the location of the new Option Authorization File. 
OAFs have .tpo or .jpo extensions and are unique to each 
receiver.

4. Select the appropriate file and click Open. The new receiver 
options will load onto the receiver and the Option Manager 
table will update.

5. When finished, PC-CDU will restart the receiver to activate 
new values of the options.
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This chapter provides procedures for using the various software 
functions, as well as describes each menu, dialog, and field found in 
the software interface.

Understanding Elements of the Main 
Window
After PC-CDU has established a connection between the computer 
and receiver, the Main window will be opened (Figure 3-1). This 
window can be split into three areas: the Menu bar, the Satellites 
and Position area, which is the largest part of the window, and the 
Status bar.

Figure 3-1. Main Window

Menu Bar
The Menu bar extends across the top of the Main window and 
contains five menu titles through which the user can access the 
program functions. By hovering the mouse pointer over a menu 

Menu Bar

Satellite&
Position Area

Status Bar
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title and then clicking the left mouse button will cause the menu 
to drop down, displaying a list of menu items. Position your 
pointing device on the desired menu item, then click and 
release the left mouse button and that function is invoked 
(Figure 3-2). Alternatively, you can use the shortcut keys (if 
available).

Figure 3-2. Menu Bar with the File Manager Item Highlighted

Satellites and Position Area
The Satellites and Position area comprises two panels, GPS 
Satellites panel on the left and GLONASS Satellites on the right, 
which are separated by the Geo|XYZ|Target box. The panels 
display the basic tracking information (parameters) for the 
locked satellites. These tracking parameters are described in 
Table 3-1. The Geo|XYZ|Target box represents the antenna’s 
current position (if available) and the time-frequency 
parameters.

Table 3-1. Tracking Parameters Displayed in the GPS Satellites and GLONASS 
Satellites Panels

Parameter Description

# GPS SV PRN. If the character “*” is shown next to 
PRN in the column, this means that almanac data are 
unavailable for the corresponding satellite.

Sn GLONASS SV Orbital Slot Number. If the character 
“*” is shown next to Sn in the column, this means 
that almanac data are unavailable for the 
corresponding satellite.

Fn GLONASS SV Frequency Number.
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The sign “??” will be displayed anywhere in the panels where 
the corresponding parameters are unavailable.

The user can sort data in a column in descending (ascending) 
order by clicking on the column’s title.

EL Elevation angle in degrees. The signs “+” and “-” 
immediately following the elevation angle indicate 
that the corresponding satellites are either ascending 
or descending, respectively. If a satellite is at 
maximum elevation, it is marked with “^”.

AZ Azimuth in degrees.

CA Signal-to-Noise Ratio (C/No) in the C/A channel 
[dB*Hz].

P1 Signal-to-Noise Ratio (C/No) in the P1 channel 
[dB*Hz].

P2 Signal-to-Noise Ratio (C/No) in the P2 channel 
[dB*Hz].

TC Time elapsed since the last loss-of-lock in the C/A 
channel for the corresponding satellite. This time is 
given in minutes or, if the symbol “:” is specified in 
the column, in seconds.

SS Satellite navigation status. For a complete 
description of the satellite navigation status 
structure, see Appendix D on page D-1. If a satellite 
is not used in position computation, its SS flag will 
be set to “-”. Otherwise “+” will be displayed.

Table 3-1. Tracking Parameters Displayed in the GPS Satellites and GLONASS 
Satellites Panels (Continued)

Parameter Description
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The Geo tab shows the receiver's antenna's current position and 
the time-frequency parameters describing the behavior of the 
receiver's local oscillator (Figure 3-3 (a)).

The XYZ tab, which is shown in Figure 3-3 (b), is similar to the 
Geo tab except for the fact that the position of the receiver's 
antenna is displayed in Cartesian coordinates here.

The Target tab is used to display various navigational 
information (Figure 3-3 (c)).

Figure 3-3. Geo|XYZ|Target Tabs

Table 3-2 provides a description of each of the values in these 
tabs.

Table 3-2. Elements of the Geo|XYZ|Target Tabs

Field Description

Geo related fields

Lat Geodetic latitude of the receiver antennaa.

Lon Geodetic longitude of the receiver antennaa.

Alt Ellipsoidal height of the receiver antennaa.

XYZ related fields

X Earth-Centered-Earth-Fixed WGS-84 X 
coordinate of the receiver antenna.

Y Earth-Centered-Earth-Fixed WGS-84 Y 
coordinate of the receiver antenna.

a b c
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Z Earth-Centered-Earth-Fixed WGS-84 Z 
coordinate of the receiver antenna.

Target related fields

Lat Geodetic latitude of the target or of the receiver’s 
antenna.

Lon Geodetic longitude of the target or of the 
receiver’s antenna.

ETT Easting-to-Target in the local system with the 
origin at the receiver.

NTT Northing-to-Target in the local system with the 
origin at the receiver.

DTT Distance-to-Target.

CTT Course-to-Target.

Geo and XYZ common fields

Vel (Magnitude of the) velocity (m/s).

RMS Pos RMS position error (m). More precisely, this is 
the square root of the trace of the position error 
covariance matrix.

RMS Vel RMS velocity error (m/s). More precisely, this is 
the square root of the trace of the velocity error 
covariance matrix.

Geo, XYZ, and Target common fields

PDOP Position Dilution of Precision.

Solution type Standalone, Code differential, RTK float, RTK 
fixed.

Table 3-2. Elements of the Geo|XYZ|Target Tabs (Continued)

Field Description
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LQ This field reflects the status of the received 
differential messages and contains the following 
information:
•Data link quality in percentage
•Time (in seconds) elapsed since the last received 
message

•Total number of received correct messages
•Total number of received corrupt messages
If the receiver is not (for some reason) receiving 
differential corrections or if none of the ports has 
been configured to receive differential 
corrections, the field LQ will either be empty or it 
will look like this: 100%(999,0000,0000). 
Currently the values for this field are obtained 
from the [MS] message.

Receiver time This field shows the receiver's current time within 

day. This value is taken from the message [~~]b. 
For more information about [~~], see the GRIL 
Reference Manual.

Receiver date This field shows the receiver's current date as 
specified in the corresponding [RD] message.

Clock offset This field describes the time derivative of (Tr - 

Trr), where Tr designates the receiver time, Trr 

designates the receiver reference time. For more 
information about Tr and Trr, see the GRIL 

Reference Manual. This parameter is obtained 
from the [DO] message and is expressed in parts 
per million (ppm).

Osc. offset The parameter describes the difference between 
the VCO's nominal and quiescent frequencies. It 
is derived from the message [OO] and is 
expressed in ppm.

Table 3-2. Elements of the Geo|XYZ|Target Tabs (Continued)

Field Description
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NOTICE
To set the target coordinates equal to the current 
receiver coordinates, double-click on either Lat 
or Lon field of the Target tab.

NOTICE
To reset the timer in the bottom-right corner of 
the Main window to 00:00:00, double-click 
somewhere in the hour:min:second area.

Status Bar
The Status bar provides auxiliary information while using PC-
CDU. This information includes the connection status, current 
communication settings, various types of messages (e.g., error 
messages) and time since the connection to the receiver has 
been established.

Tracking time This field shows the time elapsed since the last 
complete loss-of-lock event in the receiver's C/A 
channels as specified in the corresponding [TT] 
message.

a. These geodetic coordinates are always computed in WGS 84.
b. Currently the message [~~] reports the time within day in the GPS 

time scale only.

Table 3-2. Elements of the Geo|XYZ|Target Tabs (Continued)

Field Description
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Menu Structure & Functional Overview
This section briefly describes the contents of the Menu bar and 
graphically represents the program structure. Use the references to 
find further details on the subject of interest.

File Menu
The File menu contains six menu items:

• Connect – By clicking this button, you open the 
Connection Parameters window through which you 
establish the communication with a TPS receiver. If the 
TPS receiver is already connected, this item will not be 
available.

• Disconnect – When you select this button, the connection 
with the TPS receiver will be closed. If the TPS receiver is 
already disconnected, this item will be grayed out.

• File manager – Opens the File Manager window, which 
allows the user to start/stop data recording into the 
receiver’s internal memory and to manage log files 
collected with a TPS receiver. For more information, see 
“File Manager Window” on page 3-14.

• Real-Time Logging – Displays the Real-Time Logging 
window, which allows the user to start/stop data recording 
into a computer drive. For more information, refer to “Real-
Time Logging Window” on page 3-22.

• Manual Mode – Displays the Manual Mode window, 
which allows the user to send commands to the receiver and 
view the responses. For details, see “Manual Mode 
Window” on page 3-32.

• Exit – Closes PC-CDU.
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Configuration Menu
The Configuration menu contains four menu items:

• Receiver – Opens the Receiver Configuration window. 
This window allows the user to adjust a wide range of 
receiver settings. For details, see “Receiver Configuration 
Window” on page 3-33.

• Site – Displays the Site Parameters window, which allows 
the user to enter site-specific information. For more details, 
see “Site Configuration Window” on page 3-89.

• Target position – Displays the Target position window. For 
details, see “Target position Window” on page 3-90.

• Radio – When selected, pops up the RFM96 button. 
Clicking this button, opens the RFM96 Configuration 
window. This window contains the controls that allow the 
user to configure the RFM96 radio modem from Pacific 
Crest. For details, see “RFM96 Configuration Window” on 
page 3-91.

Tools Menu
The Tools menu contains four menu items:

• Initialize file system – Initialize the receiver’s file system. 
For details, see “Initialize file system” on page 3-96.

• Clear NVRAM – Clears the receiver’s NVRAM. For 
details, see “Clear NVRAM” on page 3-98.

• Reset receiver – Performs the receiver reset. For details, see 
“Reset receiver” on page 3-99.

• Receiver options – Opens the Option Manager window. 
This window allows the user to check the status of the 
receiver’s options and load an OAF to a connected receiver. 
For details, see “Receiver options” on page 3-100.
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Plots Menu
The Plots menu contains four menu items:

• Scatter – Displays the Scatter window, which shows the 
graphical representation of the position the receiver 
computes along with the precision measurement 
information. For details, see “Scatter Window” on page 3-
114.

• Satellites – Displays the Satellites window, which shows 
the sky plot of visible satellites. For details, see “Satellites 
Window” on page 3-116.

• Position – Displays the Position window. For details, see 
“Position Window” on page 3-118.

• Configuration – Displays the Plots Configuration window, 
which contains the controls related to Scatter, Satellites and 
Position windows. For details, see “Plots Configuration” on 
page 3-119.

Help Menu
The Help menu contains only one item:

About – Opens the About PC-CDU window, which 
provides information about the current version of the 
program, including its version number, release and 
expiration dates. Also here the user will find some 
additional information about a connected receiver. For 
details, see “About PC-CDU Window” on page 3-122.
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Program Structure
The following five figures are for the reference purposes only. 
They will help you navigate through the program interface 
while you are familiarizing yourself with the software.

Figure 3-4.  File Menu Structure
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Figure 3-5. Configuration Menu Structure

Figure 3-6. Tools Menu Structure
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Figure 3-7. Plots Menu Structure

Figure 3-8. Help Menu Structure
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File Manager Window
As its name implies, this window allows the user to manage the log 
files in the receiver.

To open the File Manager dialog window, select the File Manager 
item from the File menu, or press the Ctrl+F keys.

The user will be presented with the following tab controls:

• Download files – Allows downloading and deleting the log files 
from the receiver memory. See “Download files Tab” .

• Current log file – Allows the user to start/stop data logging to a 
file and to specify data logging rate, elevation mask, and site 
parameters. See “Current log file Tab” on page 3-18.

• Download path – Lets the user specify the full path and folder 
for the log files to be downloaded from the receiver. See 
“Download path Tab” on page 3-22.

Download files Tab
This tab lets the user download log files into a computer, or 
delete them from the receiver memory (Figure 3-9).

Figure 3-9. Download Files Tab

Before downloading the desired log file(s) onto your computer, 
select the folder on the PC where you want the file(s) to be 
stored. To do this, use the Download path tab. For more 
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information on Download path, look up “Download path Tab” 
on page 3-22.

Once the destination has been specified, go to the Download 
files tab, highlight file(s) you want to download onto the 
computer, and press Download.

You will see the following color download status indicators in 
the course of downloading the data:

The green circle ( ) indicates the file(s) that have been 
successfully downloaded.

The red circle ( ) marks the file that is being downloaded.

The blue circle ( ) indicates the file(s) in the queue for 
downloading.

The user can interrupt the download by pressing the Stop 
button.

Files in the destination folder will have the same names and 
extensions as the original receiver log files. Before 
downloading the current log file in the destination folder, PC-
CDU will check if there already exists a file with the same 
name in this folder. If such a file is found there, the user will be 
prompted to select either Append or Overwrite (Figure 3-10). 
In the first case the contents of the log file downloaded will be 
appended to the existing file. In the second case the existing file 
will be replaced with a new file of the same name.

Figure 3-10. Message – a File with the Same Name Already Exists
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WARNING
Care should be taken when selecting Append. 
This option is normally used only if the 
downloading process has for some reason 
been interrupted and you want it to be 
resumed.

The warning Last warning: Waiting for the 1st 
block appearing in the status bar while downloading a log file 
indicates that PC-CDU cannot for some reason retrieve the next 
block of data from the receiver. The Retries field shows how 
many attempts to retrieve this block of data have been made so 
far (Figure 3-11).

Figure 3-11. Message – Problem with Data Retrieving

If such a problem occurs, you may need to try a higher baud 
rate and/or a smaller block size.

TIP
Usually, the larger the block size the more 
efficient the data transfer. On the other hand, if 
the connection between the computer and 
receiver is not reliable enough, reducing the 
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block size can often help to exclude or at least 
minimize communication errors.

Selecting the Exclusive mode checkbox will allow the user to 
increase considerably the data transfer speed, especially if 
115200 or a higher baud rate has been set. Note however that 
using this option will disable most of the processes running 
inside the receiver (including the satellite tracking process) in 
order to ensure the highest possible file transfer speed.

One more note about downloading the receiver log files onto 
the computer.

If the Exclusive mode checkbox is not selected, one can start 
downloading the current log file without closing it first. The 
downloading process will stop at the moment when end-of-file 
is reached in the log file.

However the receiver will continue to write new data to the log 
file after that.

This method has two drawbacks. First, the download progress 
indicator can occasionally display values exceeding 100%. 
Second, the last record can be corrupt in the downloaded file. If 
Exclusive mode is on, it is impossible to start downloading the 
current log file without closing it first. In other words, if the 
Exclusive mode checkbox has been checked and one wants to 
start downloading the current log file, PC-CDU will 
automatically close the log file before the download is started.

Use the Delete button to erase unnecessary log files in the 
receiver memory.

To delete a group of log files, click on any one of them, then 
hold down the Ctrl key and select the rest of the files, and 
finally press Delete.

To delete a group of adjacent log files, click on the first of them, 
then hold down the Shift key and click on the last of the files, 
and finally press Delete.
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TIP
Log files that have inadvertently been deleted 
from the receiver memory can be visible with the 
command set,/par/dev/blk/a/removed,on. This 
command can be sent to the receiver from the 
Manual Mode window. The user is able to 
download deleted files to the computer only if 
he/she has not recorded any new files in the 
receiver memory since these files were removed. 
Otherwise, it cannot be guaranteed that the 
deleted files can be completely downloaded. 
See Chapter 2 on page 2-27 for procedure 
details.

With the Refresh button the user can reload the list of the 
receiver log files.

Press Exit to close the File Manager tab.

Current log file Tab
In this tab the user can create new and delete existing receiver 
log files (Figure 3-12).

Figure 3-12. Current log file Tab
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To create (open) a new log file, take these steps:

1. Enter the desired filename in the File name edit box, or 
select a file from the file list displayed in this window. In 
the latter case, just double-click on the corresponding 
filename.

2. Specify the desired data recording interval (i.e., data update 
interval) in the Recording interval edit box.

3. Set the desired Elevation mask.

4. Click the Site parameters button. The Site Configuration 
dialog box will appear (Figure 3-13).

–Specify the desired Site Name.

–Select the correct Antenna Status from the corresponding 
list box.

–Set the Antenna Height parameter and select/deselect the 
Slant checkbox depending on whether you have specified 
the slant or vertical antenna height.

–Select the correct antenna type from the Antenna Type 
box.

–Set the Send parameters automatically checkbox. By 
default, it is enabled. Disabling this checkbox, will prevent 
PC-CDU from the automatic sending of the Site and 
Antenna Parameters to the receiver on every log file 
creation event.

–Press OK.
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Figure 3-13. Site Configuration Dialog Box

NOTICE
After pressing the OK button, the Site 
parameters dialog box will be closed and the 
parameters that have been specified in the box 
will be copied to pccdu.ini. If the user then 
presses the Start button in the File Manager 
window, these settings will be enabled and 
inserted into the newly created (current) log file, 
unless the user disabled the Send parameters 
automatically button. On the other hand, if the 
user needs to update the site information for the 
log file being recorded, it will be sufficient to 
press the Send to receiver button to send the 
new site settings (site name, antenna status, 
antenna height, etc.) directly to both the receiver 
log file and pccdu.ini.

NOTICE
If you set a recording interval that is not currently 
supported by the receiver, PC-CDU will launch a 
utility Output Period Setup Wizard. For more 
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information on the Wizard, see Appendix C on 
page C-1.

To stop data recording and close the file, click the Stop button.

The rest of the controls are described in Table 3-3.
Table 3-3. Current log files Controls

Control Description

Current file Shows the name of the file the data is 
being logged to.

Size Reflects the size of the current log file. 
To keep track of the data recording 
process, see how the log-file size varies 
in time.

Total memory Shows the total amount of space in 
bytes (in the receiver) available for 
data.

Free memory Displays how much space in the 
receiver is free for storing data.

Delete, Refresh, Exit Serve the same purposes as in the 
Download file tab (see “Download files 
Tab” on page 3-14).
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Download path Tab
In this tab the user selects the destination folder for the files 
downloaded (Figure 3-14).

Figure 3-14. Download path tab

Note that the window's right panel is for display only. The user 
will be prevented from doing any operations on the files in the 
corresponding directory. If the user has not explicitly selected a 
destination folder for the files downloaded, these files will be 
stored based on the last specified download path.

Real-Time Logging Window
The term real-time logging means recording receiver data into a PC 
in real time mode.

To open the Real-Time Logging window, select Real-Time 
Logging from the File menu or press the Ctrl+R keys.

The Real-Time Logging dialog boxes (see Figure 3-15 on page 3-
25 and Figure 3-16 on page 3-26) are, structurally, similar to the 
Main window. For a description of the GUI components that are 
identical for the Real-Time Logging and Main windows, refer to 
“Understanding Elements of the Main Window” on page 3-1. 
Below we will focus on the components specific to the Real-Time 
Logging window.
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Note the three tabs in the top-left corner of the window: Single file, 
Multiple files and Select output path. For information on the Select 
output path tab, refer to “Download path Tab” on page 3-22.

Before we getting down to the other two tabs, consider the 
parameters displayed in the middle of the Real-Time Logging 
window, between the GPS Satellites and GLONASS Satellites 
tables.

The Elapsed time field shows the time elapsed since the current log 
file was opened. Every time a new log file is created, this timer is 
reset to 00:00:00.

The Received field shows the log-file size in bytes. This parameter 
will vary as new data are recorded into the file. After pressing the 
Stop button, one will see the log file's final size in the field.

The Site parameters button allows the user to enter various 
antenna and site parameters. For details, see “Site Configuration 
Window” on page 3-89.

The Start button allows the user to start recording data into the file. 
After starting the data logging the name on the button will change 
to Stop. Pressing the Stop button will close the file.

NOTICE
If the user sets a recording interval that is not 
currently supported by the receiver, PC-CDU 
launches a utility called Output Period Setup 
Wizard. For more information on the Wizard, see 
Appendix C on page C-1.

By pressing Exit you will close the Real-Time Logging window.

NOTICE
While the value of Recording interval specified in 
the Real-Time Logging window applies only to 
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this mode, the Elevation mask edit box also 
affects the Terminal Elevation Mask setting.

NOTICE
In real-time data logging mode it is 
recommended that the RTS/CTS handshaking 
checkbox be selected and the baud rate be set 
to 115200 or higher.

NOTICE
Unlike downloading the recorded log files from 
the receiver memory onto the computer, real-
time data logging does not use any error 
detection/correction protocol in the course of the 
data transfer. As a result, some of the messages 
in the created TPS files may be corrupt (due to 
the serial port overrun or similar problems). More 
precisely, some of the transferred bytes may be 
lost on the computer end.
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Single file Tab
In this mode PC-CDU will record receiver data into one 
specific file on the host computer. Figure 3-15 shows an 
example of the Single file tab of the Real-Time Logging 
window.

Figure 3-15. Real-Time Logging Window – Single file Tab

To start real-time data logging into a single file on the host 
computer, follow these steps:

1. In the Save to edit box enter the name of the file where the 
receiver data are to be logged.

NOTICE
By default the name of a TPS file created in real-
time logging mode will coincide with the site 
name from the Site Configuration dialog box.

2. Specify the Site parameters, Recording interval and 
Elevation mask settings.

3. Click the Select output path tab and then specify the full 
path for the file in the Save to edit box.

4. Return to Single file. Click Start to begin logging.
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Multiple files Tab
This function, real-time logging of multiple log files, is intended 
to automate the process of real-time recording of the receiver 
data to TPS files according to the specified time schedule.

In this mode PC-CDU will automatically open/close TPS files 
in regular time intervals. A new TPS file will be opened 
immediately after the previous file is closed. By selecting the 
Multiple files tab, the user will be presented with a window that 
looks like Figure 3-16.

Figure 3-16. Real-Time Logging Window – Multiple files Tab

The filename convention settings Prefix and Numbering 
determine how the TPS files created will be named.

As the name of the setting implies, Prefix determines the prefix 
part of the filename. By default, PC-CDU will use the site name 
specified in the Site Configuration dialog window as the 
filename prefix.

The Numbering edit box allows the user to select the desired 
file numbering scheme:

• If the Date & Time option is selected, the numeric part of 
the filename will look as follows:

YDDDHHMM, where
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Y – last digit of the year [0-9]

DDD – day of the year [1-366]

HH – hours in the receiver time scale [00-23]

MM – minutes in the receiver time scale [00-59]

The date and time used for the filename will correspond to 
the first epoch recorded into the file.

• If the Ascending Count option is selected, the numeric part 
of the filename will vary between 0000 and 231147483647.

If the Ascending Count option has been chosen, the 
parameter Start Count will be enabled. In this edit box the 
user can enter the starting state of the TPS file count, (i.e., 
the numeric part of the name of the TPS file created first). 
This count will be increased as new TPS files are opened.

New file every is associated with a pair of components, an edit 
box and a drop-down list box. Use the list box to select the 
desired time unit (day, hour or minute). Use the edit box to 
specify the interval (in the selected time unit) in which the 
current TPS file will be closed and the next one will be opened. 

Note that this interval must be an integer3. Also note that some 
of the multiple files created may be shorter (in terms of their 
duration in time) than it is specified in the corresponding edit 
box.

To better understand how multiple files are opened and closed 
in multiple file mode, let us consider the artificial time scale 

with the origin at 0h00m00s4 as shown in Figure 3-17 on 
page 3-28. This time scale is divided into intervals equal to the 
period as specified by the New file every fields.

3. Whatever time unit is selected.
4. That is, at the beginning of the day when multiple file logging is 

started by pressing the Start button.
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The first of the multiple TPS files will be opened immediately 
after the Start button is pressed.

The first file will be closed and the second one opened as the 
2nd interval starts, for example, at t=2n (Figure 3-17), etc.

Time duration of the second and all the following multiple files 
(maybe except the last one) will be exactly equal to the selected 
file period.

To stop the multiple file data logging, press the Stop button. 
Note that the last file, too, can be shorter than is specified in 
New file every.

Figure 3-17. Generation of Multiple Files

If the user wants PC-CDU to overwrite the existing files whose 
names coincide with the names of the newly created files, select 
the Overwrite existing files checkbox before starting real-time 
logging.

For example, assume that the Ascending Count and 
Overwrite existing files options have been selected. If the user 
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then presses the Start button, PC-CDU will display a prompt as 
in Figure 3-18.

Figure 3-18. Overwrite existing files? Warning

In this example the destination folder is                              
E:\c-s-db\raw_data, the filename prefix is Site. 

Press Yes to overwrite the existing files. If you press No, you 
will return to the Real-Time Logging window. There you will 
need first to uncheck the Overwrite existing files checkbox 
and then press the Start button to start data logging. In this case 
the numeric parts of the names of the TPS files recorded will be 
incremented starting from the first unused value, not 
necessarily from 0000.

If the Autoconvert to RINEX checkbox is selected, PC-CDU 
will automatically convert all newly created TPS files to 
RINEX. Note that this conversion is performed on the move.

NOTICE
If you want to use the Autoconvert to RINEX 
function, make sure that the executable file 
tps2rin.exe is available on your computer.

The Setup converter button, which is located immediately 
below the Autoconvert to RINEX checkbox, allows you to set 
up some of the options used by the tps2rin.exe converter. 
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Pressing this button will open the Converter to RINEX Setup 
window (Figure 3-19).

Figure 3-19. Converter to RINEX Setup Window

The information specified in the Properties panel will be put in 
the header of the corresponding RINEX files:

• Run by – name of the person or agency launching the 
converter.

• Observer – name of the person who collected the data.

• Agency – name of the agency responsible for collecting the 
data.

• Antenna # – antenna number to be copied in the RINEX 
files.

• Antenna type – antenna type to be copied in the RINEX 
files.

• Comment – comment line(s).

• Marker name – name of the antenna marker.

• Marker number – number of the antenna marker.

In the Application edit box, the full path to tps2rin.exe 
must be entered. Use the Browse button to select the desired 
filename path instead of typing it.
Topcon PC-CDU User’s Manual



Real-Time Logging Window

3-31
Use the Exclude GPS (Exclude GLONASS) checkbox to 
exclude from the resulting RINEX files all raw data 
measurements/ephemeris data corresponding to GPS 
(GLONASS).

Use the Exclude L1 (Exclude L2) checkbox to exclude from 
the resulting RINEX files all L1 (L2) raw data measurements.

The Delete source JPS files after successful conversion 
checkbox means exactly what its name implies.

In the Additional options edit box you can enter any of the 
switches available for the windows console application 
tps2rin.exe. For more information about the switches, 
refer to the Free Software section at                                         
http://www.topcongps.com/software/tps2rin.html.
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Manual Mode Window
This window, as shown in Figure 3-20, allows direct control of the 
receiver by using GRIL commands. In manual mode PC-CDU 
serves as a terminal communicating with the receiver, (i.e., it allows 
the user to send various receiver commands and get responses to 
these commands). For a complete list of commands supported by 
TPS receivers, refer to the GRIL Reference Manual. This document 
is available for download from the TPS website                          
(http://www.topcongps.com/support/manuals.html).

Figure 3-20. Manual Mode Window

To go to the Manual Mode window, select the Manual Mode item 
from the File menu or press the Ctrl+M keys.

NOTICE
We recommend that you do not send any 
commands to the receiver from the Manual 
Mode window before you familiarize yourself with 
the GRIL Reference Manual and acquire good 
knowledge of the receiver parameters.
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At the top of the Manual Mode window there is a command line 
box in which the user can type a (new) command line. 
Alternatively, the user can click  to open the combo-box list and 
select one of the previously used command lines. Note that there 
may be stored up to twenty (20) command lines in the list. Once the 
desired command line is typed (or selected), press the Send 
command button in the bottom-left corner of the Manual Mode 
window or just click the Enter key on your keyboard. The 
receiver's responses will be displayed in the receiver replies 
window located under the command line box.

The other controls available on this window are summarized in 
Table 3-4.

Receiver Configuration Window
To go to the Receiver Configuration window, select Receiver from 
the Configuration menu, or alternatively press the Ctrl+V keys.

The user will see a dialog window comprising eight tabs, as shown 
in Figure 3-21 on page 3-35.

Table 3-4. Controls of Manual Mode Window

Control Description

Stop all messages Stops outputting any messages from the receiver to the 
current terminal. After the button is pressed, PC-CDU 
will send an appropriate dm command to the receiver.

Clear window Clears the receiver replies window.

Exit Closes the Manual Mode window.

Disconnect Allows the user to disconnect from the receiver without 
disabling any configuration changes made.

Start logging Allows the user to copy to a text file all information that 
has been displayed in the receiver replies window 
during the session.

Edit script Allows the user to modify the contents of the script 
files.

Load script Loads into the receiver the desired script file.
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Each tab has Apply and Refresh buttons.

• Apply – instructs PC-CDU to accept and send to the receiver 
settings made in the tab without closing the window.

NOTICE
Each Apply button serves only its own tab and 
cannot affect the other tabs' settings.

• Refresh – updates the currently displayed window with 
information from the receiver.

In addition, the following four buttons are available and common 
for all tabs.

• OK – unlike the individual Apply buttons, allows you to accept 
the selected settings for all eight tabs at a time and once 
accepted, to close the Receiver Configuration window.

• Exit – closes the Receiver Configuration window without 
accepting the settings you have made since Apply was pressed 
last.

• Save – opens the Save setup to a script window. In this window 
you can save the current receiver settings to a script file. Script 
files normally have the extension .tpc. Later you can load the 
desired script file to the receiver, thus enabling several 
necessary receiver settings with a single operation. See Chapter 
2 on page 2-29 for details.

• Set all parameters to defaults – does exactly what its name 
implies.
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General Tab
Figure 3-21 shows the Receiver Configuration window's 
General tab.

Figure 3-21. General Tab

Elevation mask

In the Terminal Elevation Mask edit box the user enters the 
minimum elevation (i.e., the elevation mask angle) for the 
satellites whose data will be output to the current terminal (i.e., 
the receiver port being used for communication).

Antenna

The Internal, External and Auto radio buttons are used to 
select the desired antenna type. Table 3-5 shows what antenna 
type settings are allowed for different receiver models and 
board types.

Table 3-5. Allowed antenna type settings

Receiver model Board
Default 
value

Values

any JPS_3, Eurocard ext int, ext

any JPS_4, JPS_4_2 ext int, ext, auto
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NOTICE
Note that such receiver models as HiPer, 
Regency with JPS_4 board and Odyssey with 
JPS_4 board are capable of automatically 
detecting an external antenna only at receiver 
start-up time. Therefore if one wants to switch 
from the internal antenna to an external one while 
in auto, he/she will have to power the receiver off 
and then back on.

NOTICE
The Regency and Odyssey receivers with 
JPS_4_2 board inside are capable of 
automatically detecting an external antenna 
without switching the receiver off and back on.

OEM JGG20 unavailable unavailable

OEM, 
LEGACY_H

HE_GG, 
HE_GD

unavailable unavailable

HiPer, HiPer 
GGD, HiPer +, 

HiPer Lite, HiPer 
Lite +

HE_GG, 
HE_GD, 

HE_GGD, 
HE_GDL, 
HE_GGDL

auto int, ext, auto

OEM, 
ODYSSEY_E

E_GGD, 
HE_GG, 
HE_GD, 
HE_GGD

unavailable unavailable

Table 3-5. Allowed antenna type settings (Continued)

Receiver model Board
Default 
value

Values
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Antenna Status

The Current Input indicator shows what antenna type is 
actually being used by the receiver:

• int – the internal antenna is being used.

• ext – an external antenna is being used.

The Ext. DC Status indicator shows if the external antenna 
draws any DC power:

• off – the external antenna draws no power.

• normal – the external antenna draws normal power.

• overload – the external antenna draws higher power than 
expected or??? a short circuit occurs in the antenna or 
antenna cable.

Temperature

The Board temperature indicator shows the receiver board's 
current temperature in degrees of Celsius.

Power management

There are five group boxes that allows the user to adjust/view 
the power settings for your receiver. Each group box contains a 
set of related controls.

Power

Use the Mode drop-down list box to select the desired 
power source for the connected receiver:

• Auto – receiver will automatically select the power 
source.

• Mix – receiver will automatically consume power from 
the source with the highest voltage.

• Battery A – receiver will consume power only from 
battery A.
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• Battery B – receiver will consume power only from 
battery B.

• External – receiver will use an external power supply.

The Current Mode indicator shows what power source is 
being used at the moment.

Charger

Use the Mode drop-down list box to select the battery 
charging mode:

• Off – receiver will not charge the batteries.

• Charge A – receiver will charge only battery A.

• Charge B – receiver will charge only battery B.

• Auto – receiver will automatically detect and charge 
the detected batteries.

Use the Speed list box to set the desired speed of battery 
charge cycle (available not for all receiver models). You can 
select between Normal and Fast charging modes.

The Current Mode flag shows which of the batteries, a, b 
or none (off) is being charged at the moment.

The Current (Amp) field reflects the actual battery 
charging current in Amperes.

Power output modes

The Ports A,B checkbox allows you to turn power on and 
off for ports A and B. This parameter is applicable to the 
Odyssey receiver only.

With the Port C checkbox you can turn power on and off 
on port C. This parameter is applicable to the Odyssey 
receiver only.

The Ports list box governs power output on serial ports:

• On – the power board will feed all available serial ports 
via the corresponding pins when the receiver is turned 
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on. If the receiver is turned off, there will not be any 
power on the ports.

• Off – power, for all available serial ports, will be absent 
even if the receiver is turned on.

• Always – all serial ports will be powered even if the 
receiver is turned off.

With the Slots list box the user governs power output to the 
receiver internal slots:

• On – means that all slots are powered if the receiver is 
turned on. If the receiver is turned off, there will not be 
any power on the slots.

• Off – means that internal slots will not be powered 
even if the receiver is turned on.

• Always – means that internal slots will be powered 
even if the receiver is turned off.

NOTICE
The Ports, Slots list boxes are applicable to the 
HiPer and Odyssey-E receiver families only.

Voltages

The External indicator shows the external power supply's 
voltage.

The On Board indicator shows what is the actual voltage 
presented on the receiver board.

The Battery A and Battery B indicators show the voltage 
on batteries A and B, respectively.

The Charger indicator shows the output voltage of the 
internal charger during battery charging.

The On Ports indicator displays the output voltage on the 
first pin of each of the receiver’s serial port.
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Turn on/off Slots

Select the Slot 2 (C), Slot 3 (B) and Slot 4 (D) checkboxes 
to enable the corresponding internal slots.

NOTICE
The Turn on/off Slots group box is applicable to 
the HiPer and Odyssey-E receiver families only.

If the Enable Low Power Mode checkbox is selected, the 
receiver's processor will go into low power consumption mode.

MINTER Tab
In this tab (Figure 3-22), the user can configure receiver 
parameters which relate to MINTER (MINimum INTERface).

Figure 3-22. MINTER Tab

Recording interval

The recording time interval specified in the Recording interval 
edit box will be used when receiver files are opened and logged 
via MINTER, (i.e., by pressing the FN button). This setting is 
used not only when logging a single log file but also when 
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logging receiver data in AFRM mode. Note that this parameter 
cannot exceed 86400 seconds.

NOTICE
If an incorrect recording interval is set (the 
Recording interval edit box), PC-CDU will run a 
utility called Output Period Setup Wizard. For 
more in-formation on the Wizard, see Appendix 
B. Output Period Setup Wizard.

Elevation mask for Log file

This control specifies the minimum elevation angle for the 
satellites whose data will be put in the receiver files logged 
when pressing FN.

File name prefix

This setting specifies what prefix will be added to the names of 
the receiver files created via MINTER, (i.e., by pressing FN). 
The prefix can be up to 20 characters long. Default is log.

Always append to the file

If the new receiver data are to be appended to an existing log 
file, enter the desired filename in the Always append to the 
file edit box. The setting can be up to twenty characters long.

Files Creation mode

Two operation modes are possible for the FN button. If the Log 
file radio button has been selected, pressing FN will result in 
closing the current log file or, if data logging has been off, 
opening a new log file. If AFRM has been selected, pressing 
FN will enable this mode, if it has been disabled, and vice 
versa.
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Automatic File Rotation Mode (AFRM) parameters

• Period – specifies the time duration of each of the multiple 
log files created in AFRM mode.

• Phase – specifies the phase (i.e., constant time shift) of the 
multiple log files created in AFRM mode.

• Files (total) – specifies how many multiple log files must be 
created in AFRM until this mode automatically turns off. 
Zero means that an unlimited number of log files will be 
created.

• Files (remain) – shows you how many log files are left for 
the receiver to create in AFRM.

• Automatically remove old files – if selected, the receiver 
will start, should there be no free space left in the receiver 
memory, overwriting the least recent files.

FN key mode

These two radio buttons are used to program how the receiver 
will react to clicking FN (i.e., keeping the button depressed for 
less than one (1) second). In LED blink mode switch mode, 
clicking FN will toggle between the Minter's standard and 
extended information modes. For more details, see the MINTER 
User's Manual. In Occupation mode switch you click FN to 
get the receiver to insert into the corresponding log file a 
message indicating that the occupation type has been changed 
from static to kinematic, or vice versa.

Initial data collection dynamic mode

These radio buttons specify the starting occupation type 
descriptor that will be inserted at the beginning of each receiver 
files logged via the MINTER. You select Static and Kinematic 
to specify that the corresponding log file will start with a static 
and kinematic occupation, respectively.
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Data recording auto-start

The user can program how the receiver will behave in the event 
of a power failure.

Depending on which of the three radio buttons has been 
selected, the receiver will behave as given in Table 3-6 
(specified file refers to the file name entered in the Always 
append to the file field):

Table 3-6. How Data recording auto-start Works

Before 
Power 
Failure

Enabled Radio Button Results

Off On Always

Receiver 
data logged 
to file 
specified.

Data logging will 
not resume when 
power is restored.

Receiver will 
resume data 
logging to the 
same file 
when power is 
restored.

Receiver will 
resume data logging 
to the same file 
when power is 
restored.

Receiver 
data logged 
to default 
file.

Data logging will 
not resume when 
power is restored.

A new log file 
will open 
when power is 
restored and 
data will log to 
this file.

A new log file will 
open when power is 
restored and data 
will log to this file.

Receiver 
data logging 
not started 
and file 
specified.

No file will open 
with this name. 
Data logging will 
not start when 
power is restored.

No file will 
open with this 
name. Data 
logging will 
not start when 
power is 
restored.

A log file with this 
name will open and 
data logging will 
start after power is 
restored.
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Also, if the Always option is selected, your receiver will 
automatically start logging data (to a newly created or an 
existing file) in the following three cases:

1. After turning on the receiver using the Power key.

2. After resetting the receiver (using PC-CDU or pressing the 
Reset key).

3. After taking the receiver out of Sleep Mode.

Receiver 
data logging 
is off and no 
file 
specified.

Data logging will 
not start when 
power is restored.

Data logging 
will not start 
when power is 
restored.

A log file with a 
default name will 
open and data 
logging will start 
after power is 
restored.

Table 3-6. How Data recording auto-start Works (Continued)

Before 
Power 
Failure

Enabled Radio Button Results

Off On Always
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Positioning Tab
This tab contains various controls and fields that allow the user 
to set elevation and PDOP masks, to select satellites to track, 
and to specify what measurements to use in position 
computation (Figure 3-23). 

Figure 3-23. Positioning Tab

Positioning Mode

These four radio buttons permit the user to select one of the 
four available positioning modes.

Enable Solutions

If the Standalone checkbox has been checked and the rover 
receiver is being run in differential mode, the receiver will 
report its current standalone position instead of the DGPS (or 
RTK) position if the latter is unavailable in the current epoch.

If the DGPS (Code Differential) checkbox has been checked 
and the rover receiver is running in RTK Float or RTK Fixed 
mode and is unable to obtain an RTK solution at the current 
epoch, it will output the current code differential position for 
the unavailable RTK solution.
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NOTICE
If the DGPS (Code Differential) checkbox is 
enabled and a DGPS solution cannot be 
obtained, you can instruct the receiver to output 
single-point position for the unavailable 
differential. For this, enable the Standalone 
checkbox.

NOTICE
Code differential mode requires broadcasting 
the corresponding DGPS (not RTK) messages 
from the reference receiver and accepting them 
on the rover receiver. If any of these 
requirements are not met, then enabling the 
DGPS (Code Differential) checkbox will not have 
any effect.

NOTICE
The checkboxes RTK Float and RTK Fixed are 
always grayed out in this version of PC-CDU.

Positioning Masks

• In the Elevation mask edit box you specify the elevation 
mask angle for the satellites used in position computation. 
The receiver will not use the satellites below the specified 
elevation mask to compute the position. The default value is 
5 degrees.

• In the PDOP mask edit box you specify the threshold value 
of PDOP that disables position computation. If PDOP 
exceeds this mask during a period of time, the receiver's 
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position will not be computed over the corresponding 
epochs. The default value is 30.

RAIM Enabled

RAIM stands for Receiver Autonomous Integrity Monitoring. 
When this feature is enabled, the receiver continuously checks 
whether the signals received from satellites are usable or not. If 
a fault (measurement outlier) in satellite data has been detected 
based on the current alarm limit, RAIM excludes this 
satellite(s) from the positioning calculations, thereby allowing 
the receiver to continue providing correct position information 
without an interruption in the service.

• The RAIM Enabled checkbox, if selected, activates the 
RAIM algorithm.

• With the Alarm setting, the user specifies alarm limit 
mode. The alarm limit is a threshold value for the 
horizontal radial error. There are three pre-defined limits 
and one that is specified manually:

–Non-precision stands for Non-precision approach. For this 
phase of flight the alarm limit is equal to 0.3 nmi. This 
value means that an error of 0.3 nmi or greater, caused by 
bad satellite data, will be detected by RAIM.

–Terminal. For this phase of flight the alarm limit is 1.0 
nmi.

–En route. For this phase of flight the alarm limit is 2.0 
nmi.

–Manual. This mode allows the user to select alarm limit 
values other than the pre-defined ones.

• The Alarm limit edit box is available only if one has 
selected the Manual mode from the Alarm list box. Values 
the user enters in this edit box can vary within the range 
10.0…10000.0 meters. The default value is 555.6 and it 
corresponds to Non-precision approach.
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From the Current Datum drop-down list box you select the 
datum used in position computation. Once the desired datum is 
selected and the Apply button is pressed, the receiver begins 
producing its position expressed in the selected datum. The 
default datum is WGS 84.

NOTICE
Currently TPS receivers support more than 200 
datums. For a list of the supported datums, refer 
to the GRIL Reference Manual, Appendix H.

NOTICE
The receiver position, which is expressed in a 
datum other than WGS 84, may be viewed using 
NMEA messages such as GGA, GLL and so on. 
Position-related TPS messages (for example 
[PV]) always contain the coordinates computed 
in WGS 84.

Pressing the Datum Parameters button will open the <Datum 
ID> Datum Parameters window (Figure 3-24). In this window 
the user is able not only view the ellipsoid and transformation 
parameters of the datums selectable from the Current Datum 
list box but also edit the transformation parameters for a user-

defined datum (USER) and the P90 datum5.

5. P90 is the datum ID of the GLONASS reference frame PZ-90 
(Parametry Zemli or parameters of the Earth).
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In addition the ellipsoid parameters of USER can be edited in 
this window.

Figure 3-24. <Datum ID> Datum Parameters Window

Current Datum

Select the desired datum ID from the pull-down list to examine 
(for pre-defined datums) or edit (for user-defined and PZ-90 
datums) the ellipsoid and transformation parameters.

Reference Ellipsoid parameters

• Ellipsoid ID – Two-letter identification code. Displays U- 
for a user-defined ellipsoid.

• Semi-major axis – The semi-major axis length in meters. 
Ranges from 6300000.0 to 6500000.0.

• Inverse flattening – The reciprocal of the ellipsoid 
flattening (dimensionless). It must be a positive value 
between 280.0 and 310.0.

NOTICE
The semi-major axis and Inverse flattening fields 
are only available for modifying if the selected 
datum in the Current Datum list is USER or P90.
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Transformation parameters

• Reference Datum – The datum relative to which the user 
specifies the transformation parameters.

NOTICE
This field is only available for modifying if the 
selected datum in the Current Datum list is 
USER.

• Translation dX – The shift value along the X axis used to 
relate the origins of a pre-defined or user-defined datum 
and the selected reference datum. Ranges from -10000.0 
meters to +10000.0 meters.

• Translation dY – The shift value along the Y axis used to 
relate the origins of the two datums. Ranges from -10000.0 
meters to +10000.0 meters.

• Translation dZ – The shift value along the Z axis used to 
relate the origins of the two datums. Ranges from -10000.0 
meters to +10000.0 meters.

• Rotation Rx – The rotation angle around the X axis used to 
relate the orientation of a pre-defined or user-defined datum 
and the selected reference datum. Ranges from -60" to 
+60".

• Rotation Ry – The rotation angle around the Y axis used to 
relate the orientation of the two datums. Ranges from -60" 
to +60".

• Rotation Rz – The rotation angle around the Z axis used to 
relate the orientation of the two datums. Ranges from -60" 
to +60".

• Scale – The scale factor used to account for any changes in 
scale between the two datums. It ranges from -1000 ppm to 
+1000 ppm.
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NOTICE
These transformation parameters are only 
available for modifying if the selected datum in 
the Current Datum list is USER or P90.

NOTICE
Click Apply, then OK to accept configuration 
changes and close the window.

Positioning System

Select the GPS and GLONASS checkboxes if it is desired that 
the corresponding satellite constellations to be used in position 
computation.

NOTICE
However the selected satellite constellation will 
indeed be used in position computation only if 
the corresponding Satellites used in pos. 
checkbox from the Satellite management panel is 
selected as well.

Measurements Used

This radio button group shows what code measurements will be 
used to compute the receiver's standalone position. This 
parameter applies only to absolute position computation.

NOTICE
For a single-frequency receiver, the radio 
buttons P/L1, P/L2 and Iono-Free will be gray.

If the Iono-Correction checkbox is selected, the receiver will 
correct the pseudoranges for ionosphere (based on the model 
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defined in ICD-GPS-200, Revision C) before using them in 
position computation. Note that if both Iono-Free and Iono-
Correction are selected, the first overrides the second. This 
parameter applies only to absolute position computation.

If the Tropo-Correction checkbox is selected, the 
pseudoranges will be corrected for troposphere before being 
used in position computation. This parameter applies only to 
absolute position computation.

Satellite management

1. Satellites tracked

The GPS and GLONASS checkboxes are used to allow 
tracking of GPS and GLONASS satellites, respectively.

2. Satellites used in pos.

Use the GPS and GLONASS checkboxes to specify what 
satellite systems (only GPS, only GLONASS, or both) will 
be used in position computation.

3. GPS | GLONASS | WAAS

Use these tabs to explicitly specify which of the GPS, 
GLONASS and WAAS satellites are enabled for tracking 
and position computation.

• The first tab, as its name implies, deals with the GPS 
satellites (Figure 3-25).

Figure 3-25. GPS Tab
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The tab displays three columns, prn, lock and use, 
which are described in Table 3-7.

Use the All to lock and All to use buttons to select all 
GPS satellites at one time.

Use the None to lock and None to use buttons to 
deselect all GPS satellites at one time.

• The second tab, as its name implies, deals with the 
GLONASS satellites (Figure 3-26).

Figure 3-26. GLONASS Tab

Satellite Numbering

For user convenience, GLONASS satellites can be 
displayed ordered either by their Frequency Channel 
Number or by the Slot Number.

Table 3-7. Description of Data Displayed in the GPS Tab

Notation Meaning

prn GPS satellites’ pseudo-random noise code numbers.

lock Checkmarks in this column indicate that the corresponding 
satellites are enabled for tracking. As shown in Figure 3-25, 
GPS satellite PRN 8 is disabled for tracking.

use Checkmarks in this column indicate that the corresponding 
satellites are enabled for position computation. In Figure 3-
25, GPS satellite PRN 4 is disabled for position 
computation.
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The tab displays three columns, fcn/sat, lock and use, 
which are described in Table 3-8.

Use the All to lock and All to use buttons to select all 
GLONASS satellites at one time.

Use the None to lock and None to use buttons to 
deselect all GLONASS satellites at one time.

• The third tab, as its name implies, deals with the 
WAAS/EGNOS satellites (Figure 3-27).

Figure 3-27. WAAS Tab

A WAAS-enabled TPS receiver allows simultaneous 
tracking of two WAAS satellites. Either of the WAAS 
satellites is allocated its own channel. Below it will be 
shown how to set up Channel 1 (Channel 2 is handled 
in the same manner).

Table 3-8. Description of Data Displayed in the GLONASS Tab

Notation Meaning

fcn/sat GLONASS satellites’ frequency channel numbers, if the 
Frequency Channel Number checkbox is selected. 
GLONASS satellites’ slot numbers, if the Slot Number 
checkbox is enabled.

lock Enable GLONASS satellites for tracking.

use Use this GLONASS satellite for position computation.
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• The Channel 1 checkbox, if selected, allows you to 
specify necessary settings for the desired WAAS 
satellite signal reception.

• One uses the Set WAAS and as GPS spin-boxes to 

associate the selected WAAS PRN (120-138)6 with an 
appropriate GPS PRN (1-32). It is recommended to 
select for this purpose one of the GPS PRNs that are 
not used in the current GPS constellation. At writing 
this manual, the unused GPS PRNs are: 12 and 32.

• The Interpret message #0 as message: # spin-box 
disables message 0.

• The Use Iono Corrections radio button group allows 
the user to set the desired ionosphere correction mode.

–Never. Ignore any iono corrections received from 
the WAAS satellite(s).

–If exist. All acquired satellites will be used in 
position computation, (i.e., even the satellites 
whose WAAS Iono Corrections are unavailable).

–Only. Only satellites whose WAAS Iono 
Corrections are available will be used in position 
computation. Note that this is the default option for 
the radio button group.

If the Enable output of "true" WAAS PRN numbers 
checkbox is selected, the WAAS satellites will have 
their true WAAS PRNs (not "GPS associated") in the 
corresponding Satellite Indices messages.

6. WAAS satellites with PRNs 122 and 134. EGNOS satellites with 
PRNs 120 and 131.
P/N 7010-xxxx www.topconpositioning.com



Detailed Software Reference

3-56
Base Tab
With the Base tab, the user can configure the receiver for use as 
a reference station (Figure 3-28).

Figure 3-28. Base Tab

Base Station Coordinates (Antenna Phase Center)

As the names of the GPS/GLO at one time and GPS/GLO 
separately radio buttons imply, these allow the user to specify 
for GPS and GLONASS either common reference coordinates 
or individual reference coordinates. In most cases it is 
recommended to use the same reference coordinates both for 
GPS and GLONASS. After the user has selected GPS/GLO 
separately, he/she will see the GLONASS tab appear on the 
screen too.

In the Reference Geodetic Coordinates area the user enters 
the geodetic coordinates of the base antenna’s phase center.

• Lat – Antenna latitude in degrees, minutes, and seconds 
format with a hemisphere letter (N or S).

• Lon – Antenna longitude in degrees, minutes, and seconds 
format with a hemisphere letter (E or W).

• Alt – Antenna height above the ellipsoid, in meters.
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NOTICE
The reference geodetic coordinates specified in 
this tab will relate to the antenna L1 phase 
center. To account for the offset between the L1 
and L2 antenna phase centers, use the 
parameter L1 to L2 Antenna Phase Center 
offsets.

NOTICE
If the coordinates entered are expressed in a 
datum other than WGS 84, which is default, 
ensure that the correct datum ID is selected.

There are three ways to enter the coordinates:

1. Type in the precise latitude/longitude and ell. height 
manually (use the Lat, Lon and Alt edit boxes).

2. Use the absolute coordinates averaged over the specified 
time interval (with the Averaged and Avg.Span controls).

For this, enable Averaged and enter the Averaged Span in 
seconds, then click Apply and OK. Click Tools->Reset 
receiver and wait until the specified interval (span) 
completes. Examine the Base coordinates on the Base tab, 
they should correspond to the coordinates obtained from 
the average. Click Refresh if the coordinates are zeros.

3. Use the instant absolute coordinates from the receiver (by 
pressing the Get from receiver button).

Pressing the Datum Parameters button will open the <Datum 
ID> Datum Parameters window that is similar to Figure 3-24 
on page 3-49).
P/N 7010-xxxx www.topconpositioning.com



Detailed Software Reference

3-58
NOTICE
Do not confuse the described window and that 
shown in Figure 3-24 on page 3-49. Although 
their purposes and structures are similar, they 
affect different coordinates.

With the controls in the <Datum ID> Datum 
Parameters window shown on page 3-49 you 
instruct the receiver to output the currently 
computed position in the selected datum. Whereas 
with this window you only define the datum in which 
the base station’s coordinates will be expressed.

L1 to L2 Antenna Phase Center offsets

Use these fields if you need to account for the difference 
between the L1 and L2 antenna phase offsets.

RTCM Settings

The Station ID edit box allows the user to assign a separate 
station ID to each reference station working in the area. On the 
rover side, this ID allows easy identification of the reference 
station whose RTCM messages are being received by the rover 
receiver. This ID must be an integer from 0 (default) to 1023.

With the Max. number of Satellites edit box, the user specifies 
the maximum number of satellites allowed for use in RTCM 
messages types 18 through 21. A 0 means that all of the 
available satellites will be included in the above mentioned 
RTCM message types. If an RTK system has a slow modem 
(the baud rate is less than 9600 bps), it is recommended to 
restrict the number of satellites included in these messages. The 
limitation allows the user to reduce the amount of data sent by 
the base station, which helps to avoid the data link overload. If 
the actual number of satellites in sight exceeds the value 
entered in this edit box, the RTCM messages will include data 
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only from the satellites with higher elevations and the number 
of satellites included in the RTCM messages will not be greater 
than that specified in the edit box.

The Health list box is intended to define the reference station 
status:

• Good – station is operating normally.

• Bad – station is not working normally.

• Unknown – station health status is unknown.

With the Measurements Sent radio buttons, the user specifies 
the measurement types that will be included into the RTCM 
message types 18 through 21. Currently, the mentioned RTCM 
messages always contain C/A measurements. The user can also 
include either or both P/L1 data and P/L2 data in these 
messages (on condition that the TPS receiver is configured as a 
dual-frequency unit).

The GPS and GLONASS checkboxes, which are grouped 
together within the System Used area, indicate the satellite 
constellations included in the RTCM message types 18, 19, 20 
and 21.

If the Pseudo-range smoothing checkbox is selected, the 
receiver will use smoothed pseudoranges in the RTCM message 
types 19 through 21.

CMR Settings

With the Station ID the user can specify the base station ID, 
which will be included into the CMR messages transmitted by 
this base station. On the rover side, this ID allows easy 
identification of the reference station whose CMR messages are 
being received by the rover receiver. This ID must be an integer 
from 0 (default) to 31.

The Motion list box characterizes the motion of the reference 
station:
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• Unknown – the motion state is undetermined.

• Static – the receiver is motionless.

• Kinematic – the receiver is in motion.

Use the Short ID, COGO and Long ID to include the 

reference station's point feature code7 into CMR message type 
2.

The CA/L1, P/L1 radio buttons and the P/L2 checkbox, which 
are grouped within the Measurements Sent area, allow the 
user to specify which measurement types will be included into 
the corresponding CMR messages broadcasted by the reference 
station. If the receiver is a single-frequency unit, the P/L1 and 
P/L2 controls will not be available.

The GLONASS message spin box allows the user to specify 
which message types will be associated with GLONASS 
measurements. You can choose any unused message types 
between 3 and 7.

Click the Configuration of Receiver Ports button to go to the 
Ports tab. For a description of this tab, refer to “Ports Tab” on 
page 3-66.

7. Feature code is an alphanumeric code used to describe an object to be 
surveyed.
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Rover Tab
In this tab, the user can configure a receiver as a rover station 
(Figure 3-29). 

Figure 3-29. Rover Tab

Positioning Mode

These four radio buttons are included in the Rover tab only for 
user convenience. They mirror the same named buttons from 
the Positioning tab. For more information about this radio 
button group, see “Positioning Tab” on page 3-45.

DGPS Parameters

To switch a roving receiver to Multi-base mode, select the 
Multi-base checkbox. In this mode, the rover is able to use 
differential corrections received from more than one reference 

station8.

8. Currently, this mode allows the rover to use up to five reference 
stations simultaneously.
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• Correction usage

If the user selects the Nearest checkbox, the rover will use 
differential corrections transmitted by the nearest reference 
station.

NOTICE
When working in the Nearest mode, make sure 
that the Mix and Best checkboxes are clear.

The Mix checkbox allows the user to run the rover station 
in average mode.

NOTICE
When the rover runs in this mode, the Best 
checkbox must be unselected.

With the Corrections and Positions radio buttons, the 
user specifies which of the averaging modes will be 
used for position computation.

–If both the Mix checkbox and Corrections radio 
button are selected, the rover will be averaging 
differential corrections received from different 
reference stations.

–If the user selects the Mix checkbox and Positions 
radio button, the receiver will average the computed 
positions, not the received corrections.

If the Best checkbox is selected, the receiver will use 
differential corrections that correspond to the most precise 
of the obtained position estimates. Best means that the 
solution has the least RMS error.

In the CD Corrections max. age edit box, the user can set the 
maximum age (in seconds) of the code differential corrections 
used for position computation. It must be an integer value 
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between 1 and 1200. The default is 30. If the age of the 
corrections exceeds the value specified in this edit box, the 
rover will compute a stand-alone position.

Use the Iono Corrections max. age edit box to specify the 
maximum age (in seconds) of the ionosphere corrections used 
for position computation.

If you set the Use Iono Corrections checkbox to on, the rover 
receiver will use in position computation both the ionosphere 
corrections from RTCM message type 15 and differential 
corrections from RTCM message types 1 and 31 (or 9 and 34).

The Source list box serves to specify the source (port) from 
which the receiver will use differential corrections for position 
computation.

NOTICE
The receiver uses this parameter only if Multi-
base mode is unchecked.

Enable Solutions

These four checkboxes are included in the Rover tab only for 
user convenience. They mirror the same named checkboxes 
from the Positioning tab. For details, refer to “Positioning Tab” 
on page 3-45.

NOTICE
At the present time, the RTK Float and RTK Fixed 
checkboxes are unavailable and checked at the 
same time demonstrating that these solution 
types are also enabled.

RTK Parameters

The RTK mode radio button group serves to toggle between 
the extrapolation and delay modes. If Extrapolation is 
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selected, the rover will extrapolate the base station's carrier 
phase measurements when computing the rover's current RTK 
position. If Delay is selected, the rover will not extrapolate the 
base station's carrier phase measurements to compute the 
current rover position. Instead, the RTK engine will compute 
either a delayed RTK position (for the epoch to which the 
newly received RTCM/CMR message corresponds) or the 
current stand-alone position (while waiting for new RTCM/
CMR messages coming from the base).

To define the rover dynamics, use the Dynamics radio button 
group.

The Ambiguity fixing level radio buttons govern the process of 
the RTK engine fixing integer ambiguities. The RTK engine 
uses the ambiguity fix indicator when making a decision 
whether to fix ambiguities or not. Low, Medium and High 
correspond to the indicator's 95%, 99.5% and 99.9% states, 
respectively. The higher the specified confidence level, the 
longer the integer ambiguity search time. This is the price one 
pays for the higher reliability of the ambiguity fixed solution.

The Measurements Used checkbox group allows the user to 
select measurement types used by the rover for position 
computation.

In the Base Corrections period edit box, the user can set the 
differential correction update interval. It should be noted here 
that for a proper rover setup in RTK Delay mode the user 
should know the exact rate at which the reference station 
broadcasts its differential correction data.

NOTICE
The receiver will use the Base Corrections period 
control only if it runs in Delay mode. Also, this 
edit box is used to provide more reliable 
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synchronization between the base station and 
rover.

If you set the Use old ref. coordinates checkbox to on and then 
launch RTK, the rover receiver immediately starts using the 
existing reference coordinates in place of expecting when the 
reference station transmits some updated reference coordinates 
to the rover side.

NOTICE
Care should be taken when setting this 
parameter to on. Imagine for a moment that the 
rover has changed the location and started a 
new RTK session with a different reference 
station. Should this parameter be set to on, the 
rover receiver will be misusing the old reference 
coordinates for some time, which will most likely 
result in position blunders until the rover receives 
a first message with the correct reference 
coordinates.

The Source list box serves to specify the source (port) from 
which the receiver will use differential data for position 
computation in RTK mode.

With the GLONASS message spin box the user assigns the 
message type for GLONASS measurements. Make sure that 
both the reference station and rover receiver use the same 
message type for GLONASS measurement data. This 
parameter is applicable only if you use CMR differential 
messages.

Press the Reset RTK Engine button to reset the RTK engine. It 
means that all of the previously obtained estimates (estimated 
position, variance-covariance matrix, etc.) will be thrown away 
and the RTK engine will then start from scratch.
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To access the tab allowing you to revise and edit port settings, 
either click the Ports tab, or press the Configuration of 
Receiver Ports button.

Ports Tab
The Ports tab, as shown in Figure 3-30, comprises six different 
sections that are reached via the six subtabs.

Figure 3-30. Ports Tab

These subtabs are as follows:

• Serial – Used to specify the data the receiver serial ports 
will transmit/receive. See “Serial” on page 3-67.

• Parallel – Used to specify the data the receiver parallel port 
will transmit/receive. See “Parallel” on page 3-70.

• Modem – Used for configuration the Legacy and Odyssey 
receivers’ internal radio modem. For all other receiver 
models, the settings on this subtab will be unavailable. See 
“Modem” on page 3-71. 

• USB – Used to specify the data the receiver USB port will 
transmit/receive. See “USB” on page 3-72.
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• Ethernet – Used to configure the Ethernet, Telnet, and FTP 
communication settings. See “Ethernet” on page 3-73.

• TCP – Used to specify the data the receiver will transmit/
receive over TCP/IP network. See “TCP” on page 3-75.

Serial

Use this subtab to adjust the settings for serial ports A, B, C 
and D (Figure 3-30 on page 3-66).

The Input list box allows the user to specify what type of 
data to input on the selected port.

• None – The port will reject any incoming data.

• Command – The port is in command mode. In this 
mode the port will recognize the commands sent by the 
user.

• Echo – The port is in echo mode. Being used in this 
mode the receiver port redirects all incoming data to an 
output stream. Output stream may be either a port or 
the current log file.

• RTCM 2.x – In this mode, the receiver recognizes and 
decodes the RTCM version 2.1, 2.2, and 2.3 messages 
accepted on the corresponding port.

• RTCM 3.x – In this mode, the receiver recognizes and 
decodes the RTCM version 3.0 messages accepted on 
the corresponding port.

• CMR – The port is in Compact Measurement Record 
(CMR) messages input mode.

• JPS – The port is in JPS messages input mode.

• Omni – The data incoming to the port will be used by 
the OmniStar VBS or HP to produce DGPS solution 
type.
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The Output list box allows the user to specify what type of 
data to output on the selected port.

• None – The port outputs nothing.

• DGPS RTCM {1,31,3} – The port outputs RTCM 
message types 1, 31, and 3.

• DGPS RTCM {9,34,3} – The port outputs RTCM 
message types 9, 34, and 3.

• RTK RTCM {18,19,22,3} – The port outputs RTCM 
message types 18, 19, 22, and 3.

• RTK RTCM {20,21,22,3} – The port outputs RTCM 
message types 20, 21, 22, and 3.

• RTK RTCM {18,19,23,24} – The port outputs RTCM 
message types 18, 19, 23, and 24.

• RTK RTCM {20,21,23,24} – The port outputs RTCM 
message types 20, 21, 23, and 24.

• RTK RTCM3 GD min – The port outputs RTCM 
message types 1003, 1006, 1008. These messages 
provide minimum service operation for Precision GPS 
RTK on L1 & L2.

• RTK RTCM3 GD full – The port outputs RTCM 
message types 1004, 1006, 1008. These messages 
provide full service operation for Precision GPS RTK 
on L1 & L2.

• RTK RTCM3 GGD min – The port outputs RTCM 
message types 1003, 1011, 1006, 1008. These 
messages provide minimum service operation for 
Precision GPS and GLONASS RTK on L1 & L2.

• RTK RTCM3 GGD full – The port outputs RTCM 
message types 1004, 1012, 1006, 1008. These 
messages provide full service operation for Precision 
GPS and GLONASS RTK on L1 & L2.
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• RTK CMR {10,0,1} – The port outputs CMR message 
types 10, 0, 1.

• RTK CMR+ {10,0,9} – The port outputs CMR + 
message types 10, 0, 9.

• RTK JPS min – The port outputs JPS message types 
RT, SI, rc, cp, 2r, 2p, BI, ET. These messages provide 
the minimum adequate message set for an RTK system.

• RTK JPS max – The port outputs JPS message types 
RT, SI, rc, cp, DC, EC, 2r, 2p, D2, E2, BI, ET. These 
messages provide the complete message set for an RTK 
system.

• User Defined – The port outputs data specified by the 
user. It means that the user defined an arbitrary 
message set that will be outputted through the port.

In the Period edit box the user sets the message output 
interval (in seconds).

NOTICE
It is worth noting, however, that the period of 
RTCM messages types 22, 3 and CMR message 
type 1 cannot be changed with this edit box. The 
default period for the mentioned messages is 10 
seconds. If the user wants to change the period, 
he/she should use the em command from the 
Manual Mode window. For more details on em 
refer to the GRIL Reference Manual.

NOTICE
If the user sets an incorrect message output 
interval (the Period edit box), PC-CDU will run a 
utility called Output Period Setup Wizard. For 
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more information on the Wizard, see Appendix 
C on page C-1.

To set the baud rate for the corresponding receiver port, use 
the Baud rate list box.

The checkbox RTS/CTS enables/disables hardware 
handshaking for the port.

In addition to described settings, port D has a unique 
checkbox Infrared that permits the user to utilize this port 
for infrared connection with an external device.

Use Infrared mode only if the following conditions are met:

• A device you are going to connect to is compatible with 
the receiver infrared interface (for example, CDU-1).

• Your receiver supports the infrared port hardware-wise.

• The Infrared Port option is enabled in your receiver.

Parallel

The settings represented on this subtab are similar to those 
in the Serial subtab except that these settings are intended 
for managing parallel port (Figure 3-31). For detailed 
information on each setting, refer to “Serial” on page 3-67.

Figure 3-31. Parallel Subtab
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Modem

NOTICE
These settings are only available if you have the 
Legacy or Odyssey receiver with the internal 
Spread Spectrum modem. Otherwise the 
settings will be grayed out (Figure 3-32).

Figure 3-32. Modem Subtab

Internal Modem

Input, Output and Period are similar in their purposes to 
the analogous settings in the Serial and Parallel subtabs.

The Type list box allows the user to set operation modes 
(Receiving or Transmitting).

The Mode list box intends to specify the method used to 
transmit data:

• Off – internal modem is turned off.

• FHSS – internal modem uses frequency-hopping 
spread spectrum technique.

• DSS – internal modem uses direct-sequence spread 
spectrum technique.

With the Antenna radio buttons, the user sets the antenna 
type the modem uses.

• Int – stands for an internal antenna.
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• Ext – stands for an external antenna.

The user can set power transmitting mode for the internal 
modem using the Power radio buttons.

USB

This subtab contains settings that allow the user to specify 
what type of data to input/output on the USB port 
(Figure 3-33). These settings are the same as those in the 
Serial subtab. For more information, refer to “Serial” on 
page 3-67.

Figure 3-33. USB Subtab
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Ethernet

NOTICE
The settings on this subtab are only available if a 
connected receiver has the Ethernet capability.

Figure 3-34 shows an example of the Ethernet subtab.

Figure 3-34. Ethernet Subtab

IP Settings

With the settings in this group, the user specifies the IP 
addressing parameters for a connected receiver.

• IP Address – A unique identifier for your receiver on a 
TCP/IP network. An IP address comprises four 
numbers from 0 to 255, separated by periods. The 
receiver’s default IP address is 192.168.2.2.

• IP Mask – Mask used to determine what subnet the 
receiver belongs to. The default mask is 
255.255.255.192.

• Gateway – An IP address for the gateway used to 
communicate with the devices on another network. The 
default gateway is 192.168.2.1.
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NOTICE
Contact your system administrator if you are not 
sure what settings are safe to use.

Telnet Settings

These settings allows the user to configure a connected 
receiver to act as a telnet server. Remote devices (telnet 
clients) can then connect to the telnet server over a TCP/IP 
network and control the server behavior as if it was a direct 
connection. Currently up to 5 simultaneous telnet clients 
can be connected to the telnet server.

• TCP Port – This is a TCP/IP port a telnet server listens 
on for the connection. The default port number is 8002.

• Timeout – This parameter sets the amount of time in 
seconds the telnet server allows an inactive connection 
to remain open. After this time, the server terminates 
the unused connection. The default timeout is 600 
seconds.

NOTICE
Contact your system administrator if you are not 
sure what settings are safe to use.

FTP Settings

These settings allows the user to configure a connected 
receiver to act as an FTP server. A remote device (an FTP 
client) can then connect to the FTP server over a TCP/IP 
network and download raw data files. Only one 
simultaneous FTP connection is supported.

• TCP Port – This is a TCP/IP port an FTP server listens 
on for connection requests. The default port number is 
21.
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• Timeout – A period of time in seconds that must elapse 
before an inactive connection will be terminated. The 
default timeout is 600 seconds.

NOTICE
Contact your system administrator if you are not 
sure what settings are safe to use.

Network Password

This is a password used in telnet and FTP. The telnet or 
FTP client must enter password to access the telnet or FTP 
server. You can enter up to 15 alphanumeric characters.

NOTICE
To activate any configuration change, you should 
click Apply, then OK and then reset the receiver 
using the Reset receiver action in PC-CDU or 
pressing and holding the receiver’s Reset button 
for about one second.

TCP

NOTICE
The settings on this subtab are only available if a 
connected receiver has the Ethernet capability.

With this subtab the user specifies what type of data to 
input/output over the corresponding TCP/IP stream 
(Figure 3-35). These settings are the same as those in the 
Serial subtab. For more information, refer to “Serial” on 
page 3-67.
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Figure 3-35. TCP Subtab

Events Tab
This tab is used to review and configure the 1PPS signal and 
Event marker settings (Figure 3-36). 

Figure 3-36. Events Tab

The PPS A Enabled and PPS B Enabled checkboxes 
enable the receiver to generate 1PPS signals and also 
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allows the user to modify the settings related to the selected 
1PPS signal.

The Period edit box determines the rate of generating the 
1PPS signals via the corresponding output connector.

The user can determine millisecond and nanosecond parts 
of PPS signal offsets with respect to the selected reference 
time grid using the Offset (ms) edit box for millisecond 
part and Offset (ns) for nanosecond part.

With the Period of 'marked' pulses edit box, the user 
specifies the period of the marked 1PPS signal.

Using the Edge radio button group, the user synchronizes 
the edge (rising or falling) of the 1PPS signal with the 
specified reference time.

The Ref. Time radio button group allows the user to select 
the reference time that the 1PPS signal will be 
synchronized with. There are four available reference time 
scales:

• GPS means GPS system time.

• GLO means GLONASS system time.

• UTCus means UTC(USNO).

• UTCsu means UTC(SU).

If the user selected the Tied with Ref. Time checkbox, the 
receiver will synchronize the 1PPS signal with the chosen 
reference time. Otherwise, 1PPS will be synchronized 
either with the receiver's internal clock or with an external 
reference frequency applied to the receiver (in the latter 
case the Source setting described on page 3-84 must be set 
to External).

In order to enable or adjust the event input function, use the 
controls described below.
P/N 7010-xxxx www.topconpositioning.com



Detailed Software Reference

3-78
The Event A Enabled and Event B Enabled checkboxes, 
if selected, allow the receiver to measure and log event 
times in the specified reference time with high accuracy.

If the Clock Synchronization checkboxes are selected, the 
receiver executes a one-time synchronization of its one-
millisecond cycle grid with the corresponding edge of the 
event signal.

The Status indicator shows whether the receiver clock is 
actually being synchronized with the event signals or not. If 
you see on in the field, it means the synchronization has 
been done successfully.

In some cases, however, it can be necessary to perform the 
synchronization again. For this purpose click the Repeat 
Synchronization button several times until on appears.

The Rise and Fall radio buttons serve to measure the time 
of either the rising edge or falling edge of the input event 
signal.

The Ref. Time radio button group sets the reference time 
scale that the event reception time will be synchronized 
with.

With the Tied with Ref. Time checkboxes, the receiver is 
instructed to measure the event reception time in the 
selected reference time with or without consideration for 
the computed receiver clock offset.
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Advanced Tab
The Advanced tab is composed of six subtabs, as illustrated in 
Figure 3-37.

Figure 3-37. Advanced Tab

WARNING
Only change these advanced settings when it 
is known what they mean. Unsuitable 
changes to these subtabs can cause the 
receiver to run improperly. If you are doubtful 
of any changes you made to these subtabs, 
click the Set all parameters to defaults button 
to get the factory default settings back. For a 
description of these subtabs refer to the 
corresponding paragraphs below.

Anti-Interference

With the Anti-Interference radio button group (Figure 3-
37 on page 3-79), the user enables mode allowing the TPS 
receivers to suppress the impact of narrow-band 
interferences.
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NOTICE
Anti-Interference is only available for JPS_3, 
JPS_4_x, Euro_x, and E_GGD_x board versions, 
where x stand for a board revision number.

The user can assess the presence of interference based on 
the following information:

• When the number of tracked satellites is fewer (by 2 or 
greater) than the number of satellites in view.

• When the signal-to-noise ratio (C/N0) in the C/A 
channel for the satellites having elevations above 30 
degrees does not exceed 40 dB/Hz.

• When the information about interferences indicates that 
Jamming Suppressor detected interference signals 
within the specified band and also the strength of 
aggregate in-band interference is characterized as high 
or hard. This information you can obtain with the 
command em,,jps/JI.

Multipath Reduction

The checkboxes Code multipath reduction and Carrier 
multipath reduction are used for mitigation of the 
multipath phenomenon (Figure 3-38).

Figure 3-38.  Multipath Reduction Tab

When the reference station and rover station run in DGPS 
mode and they are not free from the impact of multipath, 
we recommend that you select the Code multipath 
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reduction checkbox for both the reference and rover 
stations.

If you use a pair of receivers in RTK mode, you can 
additionally select the checkbox Carrier multipath 
reduction for both receivers.

Loop Management

In this subtab the user can configure the settings that deal 
with the receiver capability of searching, acquiring and 
tracking the GPS+ satellite signals (Figure 3-39 on page 3-
82).

WARNING
Care should be taken when changing the 
settings for this subtab. Topcon recommends 
that users do not change these settings 
without good reason. For an explanation of 
this subtab, please see details under 
Figure 3-39 on page 3-82.
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Figure 3-39. Loop Management Tab

The PLL bandwidth edit box governs the noise bandwidth 
of the guiding phase lock loops. In this box, you can enter 
values between 2 and 50 Hz.

With the PLL order edit box, the user can toggle guiding 
and common lock loop order between 2 and 3. Care should 
be taken when using a 2nd order PLL because this can 
adversely affect satellite signal tracking in some cases.

The Guided loop bandwidth edit box governs all of the 
guided loops but the C/A DLLs. Here the user can enter 
values between 0.1 Hz and 10 Hz.

The C/A code guided loop bandwidth edit box specifies 
the bandwidth of the receiver's C/A group delay lock loop. 
In this box, one can enter the values between 0.1 Hz and 50 
Hz.

With the Enable Adaptive Guided Loops checkbox, the 
user enables/disables the use of adaptive guided loops. If 
the user selects the checkbox, the receiver will adjust the 
guided loops bandwidths depending on the actual strengths 
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of the signals tracked. The weaker the signals, the narrower 
the bandwidths.

With the Enable P/L1 and P/L2 tracking checkbox the 
user can adjust tracking settings for the receiver. If one has 
either a single-frequency receiver or L1 only antenna, it is 
recommended to disable tracking of the P/L1 and P/L2 
signals.

By selecting the Enable Co-Op tracking checkbox, you 
will enable this mode and make the other controls in the 
group available for modifying. Co-Op tracking mode is 
used to considerably improve the tracking characteristics of 
TPS receivers in hostile environments.

• When the receiver is in Co-op tracking mode, one can 
enable the Static Mode checkbox. This mode allows 
the receiver to acquire satellites with lower signal-to-
noise ratios and reduce the reacquisition time for the 
satellite signals after a temporary loss of lock.

NOTICE
Enable the Static Mode parameter only if the 
receiver antenna is completely stationary. If your 
receiver antenna may have some movement, 
even for a few millimeters, disable the Static 
Mode parameter. Moving the antenna while in 
Static Mode may result in a loss of lock to 
satellites.

• The Bandwidth of individual PLL and Bandwidth of 
common PLL edit boxes mean exactly what their 
names imply.

Select the Enable L2 common loop checkbox to avoid the 
loss of L2 phase tracking in dynamic applications due to 
antenna rotation around its axis.
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External Frequency

The settings on this subtab, allow the operator to configure 
the use of reference frequency (Figure 3-40). It may be 
either a high-stability external frequency or the receiver's 
internal crystal oscillator.

Figure 3-40. External Frequency Tab

With the controls in the Source group, the user specifies the 
reference frequency input that the receiver will use:

• Internal – means the receiver uses the internal 
oscillator.

• External – means the receiver uses an external 
frequency.

NOTICE
By switching from Internal to External and vice 
versa may result in a temporary loss of lock to 
satellites.

External Frequency Source Parameters

With the Ext. frequency value edit box the user specifies 
nominal external frequency value. Here the user can enter 
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the integer values between 2 and 40 MHz. The default 
value is 10 MHz.

The Ext. frequency source status field shows whether the 
external frequency is being used or not:

• off – Indicates that the receiver is using the internal 
crystal oscillator.

• wait – Indicates that the receiver is waiting for the 
external frequency lock. More precisely, this value will 
be returned in the following three cases:

–If the external frequency oscillator is disconnected

–If the amplitude of input signal is too low

–If the actual external frequency is different from that 
specified in the Ext. frequency value edit box 

• locked – Indicates that the receiver is using the external 
frequency.

With the Ext. freq. signal amplitude field the user can 
estimate the external frequency signal amplitude:

• off – Indicates that the internal oscillator is actually 
being used.

• low – Indicates that the external frequency signal's 
amplitude is lower than needed.

• ok – Indicates that the external frequency signal's 
amplitude meets the specs.

The Oscillator Offset Reduction group box allows the 
user to govern the behavior of the internal crystal oscillator.

• The Off radio button means that the oscillator 
frequency offset reduction mode is turned off.

• The Freq. Locked radio button means that the receiver 
will adjust the internal oscillator's frequency until the 
measured frequency offset is reduced to zero. By using 
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the incoming satellite signals, the receiver will force 
the internal oscillator to generate a very stable 20 MHz 
frequency signal. This frequency output is available via 
the corresponding receiver output pin.

TIP
The user is able to monitor the offset reduction in 
the Clock offset field of the GEO tab. After 
selecting Freq. Locked the value in Clock offset 
starts to reduce and soon (usually in a few 
minutes) it will become equal to zero, while in 
contrast Osc. Offset will not change much.

• The Freq. and Time Locked radio button means that 
the receiver will adjust both the internal oscillator's 
frequency until the measured frequency offset is 
reduced to zero and the internal clock until it gets fully 
synchronized with the specified reference time scale.

NOTICE
Switching from Freq. Locked or Freq. and Time 
Locked to Off may result in a temporary loss of 
lock to satellites.

Freq. Locked guarantees that the receiver's 20 MHz output 
will have long-term stability, not necessarily short-term 
stability. However, there is a way to assure that both of 
these characteristics will be good enough. It can be done by 
selecting Enable Co-op tracking on the Loops 
Management subtab.
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Raw Data Management

This subtab, which is shown in Figure 3-41, contains the 
controls for specifying the frequency at which the receiver 
will update raw measurement and position. Also, the user 
may set up the controls that affect the signal processing.

Figure 3-41. Raw Data Management Tab

The Raw Measurement Update Rate group allows the 
user to determine the raw data update period. In the Update 
Rate edit box, enter a value (in milliseconds) to specify the 
period. With Current Update Rate, the user can check 
which period is actually being used by the receiver.

The Position Update Rate group allows the user to 
determine the receive position update period. In the Update 
Rate edit box, enter a value (in milliseconds) to specify the 
period. With Current Update Rate, the user can check 
which period is actually being used by the receiver.

The Code smoothing interval edit box specifies the 
interval over which pseudoranges are smoothed by using 
corresponding carrier phase measurements. Here you can 
enter values between 0 and 900 seconds. Zero designates 
that carrier phase measurements will not be used for 
smoothing pseudo-ranges.
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In the Doppler smoothing method edit box, the user sets 
the method used for smoothing Doppler. There are three 
available methods:

• Receiver outputs raw (unsmoothed) Doppler. 
Instantaneous yet rather noisy Doppler measurements.

• Doppler is computed using two consecutive carrier 
phase measurements, CarPhase[i] and CarPhase[i-1], 
where i stands for the current epoch. Such Doppler 
measurements are less noisy than in the first case.

• Doppler is computed using three consecutive carrier 
phase measurements, CarPhase[i], CarPhase[i-1] and 
CarPhase[i-2], where i stands for the current epoch. 
Doppler measurements obtained in this mode are least 
noisy.

With Nominal Iono smoothing interval edit box, the user 
specifies the nominal ionospheric correction smoothing 
interval over which raw ionospheric corrections are 
smoothed (assuming the receiver has been working for 
some time and has already obtained enough raw 
ionospheric corrections to perform such smoothing). This 
integer parameter varies between 0…900 seconds. The 
default value is 60.

With the Minimum Iono smoothing interval edit box, the 
user specifies the minimum smoothing interval for the 
receiver to filter raw ionospheric corrections before they 
can be used in position computation. This integer parameter 
ranges between 0 and 900 seconds. The default value is 30 
seconds.

Options

Figure 3-42 shows the subtab from which the user can turn 
on/off the Cinderella option. Every other Tuesday, 
Cinderella enables the receiver to run as a dual-frequency 
GPS+GLONASS unit during 24 hours. For information on 
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scheduling Cinderella Tuesdays, visit the Cinderella Option 
page on the TPS web site at
http://www.topcongps.com/software/cinderella.html.

Figure 3-42. Options Tab

Site Configuration Window
This window allows the user to enter an antenna-specific 
information for the site to be surveyed (Figure 3-43 on page 3-89). 
The settings you defined on this page will also be reflected on the 
Site Configuration window described on page 3-20.

Figure 3-43. Site Configuration Window

To open the Site Configuration window, select the Site item from 
the Configuration menu, or press the keys CTRL+I.

• Site Name – The site identification string (up to 20 
alphanumeric characters).

• Antenna Status – This control allows the user to define whether 
the receiver antenna is in motion or is motionless.
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• Antenna Height – The height of antenna, measured from the 
survey marker to the measuring mark of antenna. The 
measuring mark is the antenna reference point (ARP) if you use 
the vertical height or a known measuring mark (usually antenna 
edge) on the antenna if you use the slant height.

• Slant – Enable this checkbox if you measure the slant height. 
Otherwise, leave it blank.

• Antenna Type – Select the type of antenna you use.

• Send parameters automatically – Select this checkbox if you 
want PC-CDU to automatically send the above site and antenna 
parameters to the receiver on every log file creation event.

• OK – Applies the changes and closes this window.

• Send to receiver – Applies the changes when the log file is 
being recorded.

• Cancel – Closes the window without applying the changes.

Target position Window
This window allows the user to enter the target coordinates 
(Figure 3-44).

Figure 3-44. Target position Window

To go to the Target position window, either select the Target 
Position from the Configuration menu, or press the keys 
CTRL+T.

• OK – Associates the entered coordinates with the target 
position and closes the window.
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• Get from receiver – Sets the target position to the most recent 
position produced by the receiver.

• Cancel – Closes the window without applying the coordinates.

RFM96 Configuration Window
If your receiver is equipped with the RFM96 radio modem, use the 
following windows to adjust its settings.

To open the RFM96 Configuration window, select the Radio item 
from the Configuration menu, then click RFM96, as shown in 
Figure 3-45.

Figure 3-45. Select Radio->RFM96

After you click the RFM96 item, the following window displays 
(Figure 3-46).

Figure 3-46. RFM96 Configuration – Connect

This tab allows the user to establish a connection with the radio 
modem.

Use the Modem connected to port list box to select the receiver 
port that the radio modem is connected to. Normally, this is port C 
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for the Legacy, Legacy-E, Legacy-H, Regency, HiPer family, and 
port B for the Odyssey.

To set the baud rate with which the modem and receiver will 
communicate, use the Connect to modem at bitrate list box 
(typically 38400 bps). If you want the receiver automatically 
detects the baud rate, select Auto.

Select the method of modem connection and click Connect. For 
most RFM96 models, you can use Search for modem.

If the radio is not found, change Connection type to Power cycle 
and click Connect. The program will prompt you to turn the 
modem off and then back on (Figure 3-47 on page 3-92). The 
program will poll the radio during its power cycle and establish a 
connection.

Figure 3-47. RFM96 Configuration – Power Cycle
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Once a connection has been established, you will see a window 
showing the radio link settings and protocol details (Figure 3-48).

Figure 3-48. RFM96 Configuration – Settings

• In the RF Channel list box, the user selects the desired 
channel.

• In the DTE-DCE Serial Interface area, the user specifies the 
following settings:

Baud rate – Select the baud rate used for communication 
with the local DTE device.

Parity – Select the parity used for communication with the 
local DTE device.

EOT – This field is set to the end-of-transmission character 
or timeout value used to determine when a message that is 
to be transmitted is complete and ready to transmit. This 
applies only when the DTE-DCE protocol of the radio-
modem is configured for Transparent, Fast Asynch, or 
TrimTalk modes.

• In the DTE-DCE protocol mode, select the desired operation 
protocol among the following available:

Transp. w/EOT time out

Transp. w/EOT character
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Packet

Auto-repeater

Fast async

Enable/disable the BREAK to Command checkbox. If 
enabled, a BREAK condition on the RS-232 interface will 
cause the radio-modem to switch into command mode.

• In the Addresses area, specify the Local and Destination 
addresses. The Local field is set for the local radio modem 
identifier. In packet switched and addressed transparent 
operation each modem should be assigned a unique address. 
Packets may be sent to a specific address, or broadcast to a 
group of modems. Acceptable values are 0 to 254. Do not use 
address 255 as it is reserved as the broadcast address. 
Destination is used only in transparent mode for addressed 
transparent operation. When in transparent mode, all data is 
transmitted to the address specified in this field.

• In the Radio Link Settings area, specify the following settings:

Link rate – This list box field allows you to select the rate at 
which data is transmitted over the RF link. Pacific Crest 
recommend the use of 9600 bps to minimize the power 
consumption and to maintain the radio transmitter at a low 
TX duty cycle. You may need to use 4800 bps in order to 
maintain reliability in difficult transmission circumstances 
(long range or heavy fade conditions).

Retries – Enter in this field the number of retries the 
modem should attempt in the case where the remote 
modem does not respond or a corrupted data packet causes 
a negative acknowledgment from the receiving modem. 
This field is only used when the modems are in packet 
mode or operation or when the modems are in transparent 
mode with a designated destination address other than 255.

FEC – Enable or disable Forward Error Correction (FEC). 
FEC allows the receiving modem to correct burst and single 
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bit errors in the incoming data stream. When enabled, an 
additional 4 bits per byte of data is transferred over the RF 
link. This effectively reduces the data throughput in 
proportion to the overhead bytes. Leave FEC enabled 
unless the data throughput requirements make the overhead 
unacceptable.

Scrambling – This list box is used to enable or disable data 
scrambling. For optimal operation of the GMSK 
modulation, data should be scrambled. When enabled, the 
radio modem scrambles and unscrambles the data on 
transmission or reception via an exclusive-OR operation 
with a pseudo-random bit stream. Do not disable 
scrambling unless the DTE performs data scrambling and 
produces a data stream with approximately the same 
number of 1's and 0's.

Digisquelch – The receiving modem attempts to decode the 
radio information only in conditions where the radio signal 
is of a certain power level. The radio modem allows the 
user to select the level at which the radio begins to decode 
the signal. By adjusting the sensitivity to an RF carrier, the 
radio modem can be configured to ignore weak signals, or 
signals from unintentional radiators (computer CRT's, etc.) 
which would otherwise interfere with reception. Four 
settings are provided: High, Moderate, Low and Off. Select 
High for greatest sensitivity. A selection of High will result 
in the best range of reception. Select Moderate or Low to 
minimize interference from other transmissions. Note that 
selecting Moderate or Low will result in poorer reception of 
weak signals, and lower range. By selecting Off, the radio 
modem loses its ability to receive signals, and thereby 
becomes a transmit only unit. Note that selecting Off will 
allow the radio modem to transmit over other broadcasts, 
and is generally not recommended, especially at higher 
power levels where your broadcast will interfere with co-
channel users.
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CSMA monitor – This field instructs the modem to wait, or 
not, for the transmit frequency to clear before attempting 
transmission. This is most useful when the RX and TX 
frequencies are different. When set to On, the modem will 
check for clear TX frequency. If the TX frequency is busy, 
the modem waits a random time period and repeats the 
check. When the TX frequency is clear, transmission will 
commence. When set to Off, transmission will commence 
without first checking for clear TX frequency.

Once the change has been made, press the Apply button to program 
the radio.

Pressing the Set defaults button returns all radio link and serial 
interface settings back to their factory default values.

Digisquelch should be set to Low on the base and High on the 
rover. If the radio at the rover is suffering from an external 
interference, then you can set it to Medium or Low.

NOTICE
For more information on the settings used in this 
window, refer to the RFM96 Modem 
Configuration Software help.

Initialize file system
This procedure is to some extent similar to disk formatting. It 
results in erasing all of the files inside the receiver. In practice, you 
do not execute this procedure very often.

To initialize the file system in the connected receiver, select the 
Initialize file system item from the Tools menu.
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After pressing Initialize file system, you will be prompted to 
confirm the command (Figure 3-49).

Figure 3-49. Confirm Initialization – 1

On the next window, confirm the initialization by clicking the Start 
button (Figure 3-50).

Figure 3-50. Confirm Initialization – 2

Wait until the initialization process completes (Figure 3-51).

Figure 3-51. File System Initializing

NOTICE
The command’s execution time may be up to 
several minutes depending on the receiver’s 
memory size.

Once completed, the window showing the receiver’s file system and 
physical memory information appears. If you want to save this 
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information to a text file, click Save to file. To close the window, 
click OK (Figure 3-52).

Figure 3-52. File System Has Completely Initialized

Clear NVRAM
The receiver’s Non-Volatile Random Access Memory (NVRAM) 
holds data required for satellite tracking, such as ephemeris data, 
almanac data, and receiver position. The NVRAM also keeps the 
current receiver’s settings, such as active antenna input, elevation 
masks and recording interval, and information about the receiver’s 
internal file system.

Even though clearing the NVRAM is not a common (nor normally 
a recommended) operation, there are times when clearing the 
NVRAM can eliminate communication or tracking problems. 
Clearing the NVRAM in your receiver can be interpreted as a soft 
boot in your computer.

After clearing the NVRAM, your receiver will require some time to 
collect new ephemerides and almanacs (around 15 minutes).

Clearing the NVRAM of your receiver will not delete any files 
already recorded in your receiver’s memory. However, it will reset 
your receiver parameters to factory default values.
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In addition, the NVRAM keeps information about the receiver file 
system. Note that after clearing the NVRAM, the receiver's STAT 
LED will flash orange for a few seconds indicating that the receiver 
is scanning and checking the file system.

To clear the NVRAM, select the Clear NVRAM item from the 
Tools menu. PC-CDU then prompts you with a message asking to 
confirm clearing the NVRAM. Click OK to execute this procedure 
or Cancel to return to the main window (Figure 3-53).

Figure 3-53. Confirm Clear NVRAM

Reset receiver
This operation is similar to computer resetting. It will not clear the 
receiver's NVRAM. 

To reset the receiver, select the Reset receiver item from the Tools 
menu. When clicking the Reset receiver option, you will be 
prompted to confirm your command (Figure 3-54 on page 3-99).

Figure 3-54. Confirm Receiver Reset

After the command is executed, PC-CDU disconnects itself from 
the receiver and then opens the Connection Parameters window 
prompting you to set necessary parameters to connect to the 
receiver again.
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Receiver options
By clicking the Receiver options item, the Option Manager 
window displays. With this window you can check the status of 
your receiver’s options and load new Option Authorization Files 
(OAFs) to the receiver (Figure 3-55).

Figure 3-55. Option Manager

Option Manager Window
This window contains the following information (Figure 3-55 
on page 3-100):

• Option name – a name/description of the option

• Current – shows if the option is in force at the present or not

• Purchased – if the option is purchased or not

• Leased – if the option is leased or not

• Expiration date – the date the option will be disabled, if 
applicable
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Since Options can be both purchased and leased, the «Current» 
status of the option displays the currently effective value.

Option values can be:

• -1 or «----» – the firmware version does not support this 
option.

• 0 – the receiver option is disabled.

• positive integer – the option is enabled with a specified 
value.

• yes or no – the option is either enabled or disabled.

Table 3-9 lists all options available for a TPS receiver. 

Table 3-9. Receiver Options

Option Name Description Values

GPS Enables/disables the use of 
GPS satellites.

yes – enabled
no – disabled

GLONASS Enables/disables the use of 
GLONASS satellites.

yes – enabled
no – disabled

L1 Enables/disables the receiver 
to track the L1 carrier 
frequency and use the C/A-
code measurements for 
position computation.

yes – enabled
no – disabled

L2 Enables/disables the receiver 
to track the L2 carrier 
frequency and use the P-code 
measurements on L1 and L2 
for position computation.

yes – enabled
no – disabled
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Cinderella Enables/disables the 
Cinderella option. It turns a 
single frequency, GPS 
receiver into a dual-frequency, 
GPS+GLONASS receiver for 
24 hours every other Tuesday 

at GPS midnighta.

yes – enabled
no – disabled

Position update rate 
(Hz)

Displays the maximum 
allowable position update rate 
for autonomous and code 
differential positioning. 
Measured in Hertz.

0, 1, 2, 5, 10, 20.
Zero means that the 
option is disabled.

Raw data update rate 
(Hz)

Displays the maximum 
allowable raw measurement 
update rate. Measured in 
Hertz.

0, 1, 2, 5, 10, 20.
Zero means that the 
option is disabled.

Code differential 
Base

Enables/disables the receiver 
to be configured as a DGPS 
Base. This option is obsolete 
and retains in the program for 
back-compatibility.

yes – enabled
no – disabled

Code differential 
Rover

Enables/disables the receiver 
to be configured as a DGPS 
Rover. This option is obsolete 
and retains in the program for 
back-compatibility.

yes – enabled
no – disabled

RTK Base Enables/disables the receiver 
to be configured as an RTK 
Base. This option is obsolete 
and retains in the program for 
back-compatibility.

yes – enabled
no – disabled

Table 3-9. Receiver Options (Continued)

Option Name Description Values
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RTK Rover (Hz) Enables/disables the receiver 
to be configured as an RTK 
Rover with the desired RTK 
position update rate. 
Measured in Hertz. This 
option is obsolete and retains 
in the program for back-
compatibility.

0, 1, 2, 5, 10, 20.
Zero means that the 
option is disabled.

Memory (Mb) Displays the maximum 
amount of storage space for 
raw data files. Measured in 
Mbytes.

0 – disabled
1...6256 – enabled 
for specified 
memory space

Co-Op Tracking Enables/disables the use of 
the Co-Op tracking feature.

yes – enabled
no – disabled

1-PPS Timing Signal Enables/disables the receiver 
to output 1 PPS signal.

0 – no 1 PPS output
1 – single 1 PPS 
output
2 – dual 1 PPS 
output

Event Markers Enables/disables the receiver 
to accept event marker inputs.

0 – no event marker 
input
1 – single event 
marker input
2 – dual event 
marker input

In-Band Int. 
Rejection

Enables/disables the receiver 
to use Jamming Suppressor.

0 – disabled
1 – enabled outside 
USA
2 – enabled for USA 
only

Table 3-9. Receiver Options (Continued)

Option Name Description Values
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Multipath Reduction Enables/disables the use of a 
special signal processing 
technique that significantly 
reduces the effects of 
multipath.

yes – enabled
no – disabled

Frequency Input If enabled, allows the receiver 
to operate with an external 
high-stability frequency 
source.

yes – enabled
no – disabled

Freq. Lock and 
Output

Enable the receiver to 
generate a very stable 20 
MHz frequency.

yes – enabled
no – disabled

Serial Port A (Kbps) Enables/disables 
communications through port 
A and displays a maximum 
available baud rate at which 
the receiver communicates 
with an external device. 
Measured in Kbits per second.

0 – port disabled
9 – 9600
19 – 19200
38 – 38400
56 – 56700
115 – 115200
230 – 230400
460 – 460800

Serial Port B (Kbps) Enables/disables 
communications through port 
B and displays a maximum 
available baud rate at which 
the receiver communicates 
with an external device. 
Measured in Kbits per second.

0 – port disabled
9 – 9600
19 – 19200
38 – 38400
56 – 56700
115 – 115200
230 – 230400
460 – 460800

Table 3-9. Receiver Options (Continued)

Option Name Description Values
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Serial Port C (Kbps) Enables/disables 
communications through port 
C and displays a maximum 
available baud rate at which 
the receiver communicates 
with an external device. 
Measured in Kbits per second.

0 – port disabled
9 – 9600
19 – 19200
38 – 38400
56 – 56700
115 – 115200
230 – 230400
460 – 460800

Serial Port D (Kbps) Enables/disables 
communications through port 
D and displays a maximum 
available baud rate at which 
the receiver communicates 
with an external device. 
Measured in Kbits per second.

0 – port disabled
9 – 9600
19 – 19200
38 – 38400
56 – 56700
115 – 115200
230 – 230400
460 – 460800

Infrared Port Enables/disables 
communications through 
infrared port.

yes – enabled
no – disabled

Parallel Port Enables/disables 
communications through 
parallel port.

yes – enabled
no – disabled

Sp.Sp. Freq. Hop. Allows use of the internal 
Spread Spectrum modem in 
the frequency hopping mode. 
For the Legacy and Odyssey 
only.

yes – enabled
no – disabled

Sp.Sp. Direct Allow use of the internal 
Spread Spectrum modem in 
the spread spectrum mode. 
For the Legacy and Odyssey 
only.

yes – enabled
no – disabled

Table 3-9. Receiver Options (Continued)

Option Name Description Values
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RAIM Enables/disables Receiver 
Autonomous Integrity 
Monitoring.

yes – enabled
no – disabled

Datums support Enables/disables the receiver 
to output position information 
in a datum other than WGS 84 
or PE-90.

yes – enabled
no – disabled

Magnetic azimuth Enables/disables the receiver 
to output the magnetic course.

yes – enabled
no – disabled

Geoid height Enables/disables the receiver 
to use embedded low-
accuracy geoid model with 
RMS of about 3 m.

yes – enabled
no – disabled

Way Point 
Navigation

N/A always disabled

WAAS Enables/disables the receiver 
to use the WAAS service.

yes – enabled
no – disabled

OMNISTAR Enables/disables the receiver 
to use the OmniSTAR satellite 
differential service.

yes – enabled
no – disabled

RTCM Output Allows the receiver to output 
RTCM messages.

0 – RTCM output 
disabled
1 – DGPS RTCM 
output enabled
2 – RTK RTCM 
output enabled
3 – DGPS&RTK 
RTCM output 
enabled

Table 3-9. Receiver Options (Continued)

Option Name Description Values
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RTCM Input Allows the receiver to accept 
RTCM messages via a certain 
number of ports. The option 
value represents the number 
of ports from which the 
receiver is able to 
simultaneously accept RTCM 
messages.

0 – RTCM input 
disabled
1, 2, 3, 4, 5 – RTCM 
input enabled on a 
specified number of 
ports.

CMR Output Allows the receiver to output 
CMR messages.

0 – CMR output 
disabled
1 – CMR output 
enabled

CMR Input Allows the receiver to accept 
CMR messages

0 – CMR input 
disabled
1 – CMR input 
enabled

JPS Output Allows the receiver to output 
TPS messages.

0 – TPS output 
disabled
1 – TPS output 
enabled

JPS Input Allows the receiver to accept 
TPS messages via a certain 
number of ports. The option 
value represents the number 
of ports from which the 
receiver is able to 
simultaneously accept TPS 
messages.

0 – TPS input 
disabled
1, 2, 3, 4, 5 – TPS 
input enabled on a 
specified number of 
ports.

DGPS mode Enables/disables the receiver 
to run in DGPS (Code 
Differential) mode.

yes – enabled
no – disabled

Table 3-9. Receiver Options (Continued)

Option Name Description Values
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RTK mode (Hz) Enables/disables the receiver 
to run in RTK mode at a 
specified rate. Values are 
given in Hertz.

0 – disabled
1 – enabled @ 1 Hz
2 – enabled @ 2 Hz
5 – enabled @ 5 Hz
10 – enabled @ 10 
Hz
20 – enabled @ 20 
Hz

Carrier Phase Enables/disables true carrier 
phase output. If the option is 
enabled, true carrier phase is 
output. If the option is 
disabled, integral Doppler is 
output for true carrier phase. 
In this case the option RTK 
mode will not be fully 
available because only float 
solutions can be obtained 
when RTK using integral 
Doppler for true carrier phase. 
In TPS receivers other than 
JGG20 and HEGG, this 
option is always enabled.

yes – enabled
no – disabled

Ethernet Port Enables/disables the receiver 
to communicate over 
Ethernet.

yes – enabled
no – disabled

TCP Connections Enables/disables the receiver 
to establish a certain number 
(5 max.) of simultaneous 
Telnet-like connections.

0 – disabled
1, 2, 3, 4, 5 – 
number of enabled 
Telnet connections.

FTP Connections Enables/disables the receiver 
to establish an FTP 
connection (1 max.).

0 – disabled
1 – enabled

Table 3-9. Receiver Options (Continued)

Option Name Description Values
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USB Port Enables/disables 
communications through 
USB port.

no – disabled
yes – enabled

ADU Enables/disables the receiver 
to act as an attitude 
determination unit.

0 – disabled
1 – enabled for 
heading and pitch 
computation
2 – enabled for 
heading, pitch, and 
roll computation

CDU Support Enables/disables the receiver 
to be connected to the CDU-1 
device.

no – disabled
yes – enabled

Reserved For internal purposes only. no – disabled 

Authorization Enable/disables the receiver 
to be authorized to work with 
a number of programs. This is 
a bit-field option, where each 
bit corresponds to a specified 
software.

0 – not authorized
1st bit (decimal 1) – 
authorized for 
Pinnacle
2nd bit (decimal 2) – 
authorized for      
PC-CDU MS
3rd bit (decimal 4) – 
authorized for 
TopNet+
Combinations of 
these values are also 
available.

Table 3-9. Receiver Options (Continued)

Option Name Description Values
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RTK distance 
[x100m]

This option determines the 
maximum allowed distance in 
hundreds of meters between 
the reference and rover 
stations. If the distance 
between the reference and 
rover stations exceeds the 
specified limit, the receiver 
will not provide the RTK 
position.

0 – disabled
511 – enabled 
without restriction
1...510 – enabled for 
specified distance
For example, 120 
means 12 km.

Corrections inputs Enables/disables the 
corresponding port to be
set to any differential data 
input mode.
This is a bit-field option, 
where each bit corresponds to 
a specified port.

0 – differential data 
inputs are disabled 
on all ports
1st bit (decimal 1) – 
serial port A is 
enabled for 
differential data 
input
2nd bit (decimal 2) – 
serial port B is 
enabled for 
differential data 
input
3rd bit (decimal 4) – 
serial port C is 
enabled for 
differential data 
input
4th bit (decimal 8) – 
serial port D is 
enabled for 
differential data 
input
Combinations of 
these values are also 
available.

Table 3-9. Receiver Options (Continued)

Option Name Description Values
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Latitude 1 Specifies the latitude of the 
upper left corner of the 
rectangle area within which 
the receiver can produce the 
position information and 
output measurement data.
Measured in degrees.

from -90 to 90

Longitude 1 Specifies the longitude of the 
upper left corner of the 
rectangle area within which 
the receiver can produce the 
position information and 
output measurement data.
Measured in degrees.

from 0 to 360

Latitude 2 Specifies the latitude of the 
lower right corner of the 
rectangle area within which 
the receiver can produce the 
position information and 
output measurement data. 
Measured in degrees.

from -90 to 90

Longitude 2 Specifies the longitude of the 
upper left corner of the 
rectangle area within which 
the receiver can produce the 
position information and 
output measurement data.
Measured in degrees.

from 0 to 360

Lat_Lon checksum 1 Checksum of the Latitude1, 
Longitude1, Latitude2, 
Longitude2 options. See the 
GRIL Reference Manual for 
details on how the checksum 
is calculated.

from 0 to 511
0 – indicates that the 
receiver is disabled 
to compute its 
position and output 
raw data 
measurements

Table 3-9. Receiver Options (Continued)

Option Name Description Values
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Latitude 3 Specifies the latitude of the 
upper left corner of the 
second rectangle area within 
which the receiver can 
produce the position 
information and output 
measurement data. 
Measured in degrees.

from -90 to 90

Longitude 3 Specifies the longitude of the 
upper left corner of the 
second rectangle area within 
which the receiver can 
produce the position 
information and output 
measurement data.
Measured in degrees.

from 0 to 360

Latitude 4 Specifies the latitude of the 
lower right corner of the 
second rectangle area within 
which the receiver can 
produce the position 
information and output 
measurement data. Measured 
in degrees.

from -90 to 90

Longitude 4 Specifies the longitude of the 
upper left corner of the 
rectangle area within which 
the receiver can produce the 
position information and 
output measurement data.
Measured in degrees.

from 0 to 360

Table 3-9. Receiver Options (Continued)

Option Name Description Values
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Also this window contains four buttons. Their functions are:

• Refresh – Updates the window.

• Load – Loads a new OAF. For details, see “How to Load 
New OAF to Receiver” on page 2-40.

• Stop – Terminates loading an OAF.

• Exit – Closes the window.

Lat_Lon checksum 2 Checksum of the Latitude3, 
Longitude3, Latitude4, 
Longitude4 options. See the 
GRIL Reference Manual for 
details on how the checksum 
is calculated.

from 0 to 511
0 – indicates that the 
receiver is disabled 
to compute its 
position and output 
raw data 
measurements

a. Cinderella activates only if the receiver hardware supports 
GLONASS and the L2 frequency.

Table 3-9. Receiver Options (Continued)

Option Name Description Values
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Scatter Window
This is a useful graphic feature allowing you to monitor the 
behavior/quality of the receiver trajectory/position in real time.

To go to the Scatter window, select the Scatter item from the Plots 
menu.

The window is divided into the scatter plot and an augmented status 
bar (Figure 3-56).

Figure 3-56. Scatter Window

The plot displays the current receiver position relative to the 
position specified in the Target position window. The most current 
receiver position is showed by a red point.

Status bar contains the following information:

• Average latitude, longitude and ellipsoidal height of the 
receiver’s position over the entire set of obtained position 
estimates

• Horizontal position RMS error
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• Vertical position RMS error

• Total position RMS error, i.e. the square root of the trace of the 
position error variance-covariance matrix

• Horizontal velocity RMS error

• Vertical velocity RMS error

• Total velocity RMS error, the square root of the trace of the 
velocity error variance-covariance matrix

• The number of the position estimates for each of the four 
solution types (in %) and their total as well

• The maximum and average Easting to Target and Northing to 
Target in the local system with the origin at the receiver.

Use the Clear all points button to erase all plotted points in the 
window.

When you click the Fit all points button, PC-CDU will 
automatically change the scale of scatter plot allowing you to view 
all plotted positions currently gathered by the software.

After you click Target to average, PC-CDU sets the target position 
equal to the average receiver’s position.

NOTICE
The scatter plot and information in the status bar 
are updated once a second, unless you 
specified a lower position or raw data update 
rate at your receiver.

NOTICE
If you close this window, the positions displayed 
in the scatter plot and information in the status 
bar will not be discarded (unless you disconnect 
the receiver), thus when you reopen the window 
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later, it will include both the current position 
information and data.

Satellites Window
The Satellites window shows graphic representation of the satellite 
positions in the sky (Figure 3-57).

To go to the Satellites window, select the Satellites item from the 
Plots menu.

Figure 3-57. Satellites Window

Each concentric circle represents the elevation angle above the 
horizon.

The outermost circle corresponds to 0 degrees above the horizon.

The center of the sky plot represents 90 degrees above the horizon.

The dotted circle shows the position computation elevation mask 
angle. In Figure 3-57, the mask angle equals 5 degrees. The user 
Topcon PC-CDU User’s Manual



Satellites Window

3-117
can adjust the mask angle through the Elevation MaskForm 
window which appears immediately after clicking the Elevation 
mask button (Figure 3-58).

Figure 3-58. ElevationMaskForm Window

Also, the user can see four DOP characteristics, specifically:

• GDOP – Geometrical Dilution of Precision (3 position 
coordinates plus clock offset in the solution)

• PDOP – Position Dilution of Precision (3 coordinates)

• HDOP – Horizontal Dilution of Precision (2 horizontal 
coordinates)

• VDOP – Vertical Dilution of Precision (height only)

A dynamically changing histogram shows the signal-to-noise ratio 
(C/N0) in the C/A channel. Each vertical bar has a unique color and 
designates a satellite’s PRN (GPS and WAAS) or slot number 
(GLONASS). Note that GPS/WAAS and GLONASS satellites are 
marked with G# and R#, respectively. By selecting or clearing the 
checkbox for each SV, the user can specify which of the GPS, 
GLONASS and WAAS satellites are enabled/disabled for position 
computation.

TIP
To view the basic tracking information about a 
satellite, move the cursor onto the desired 
satellite’s icon and right-click on it. Holding down 
the right button, you will see a pop-up window, 
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as shown in Figure 3-59. The values in the 
window are similar to the values in Main window.

Figure 3-59. Satellites Window – Basic Tracking Information

To clear the Satellites window, click the Clear data button.

Position Window
The Position window represents continuously updated graphs that 
show the difference between latitude/longitude of the receiver 
position and latitude/longitude specified in the Target position 
window over a user-defined time interval (Figure 3-60).

To go to the Position window, select the Position item from the 
Plots menu.

Figure 3-60. Position Window

The Latitude and Longitude graphs are constructed as follows:

• Horizontal axes

Display the time interval (in seconds) over which PC-CDU 
computes the differences.
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–The range of a time interval, over which the differences are 
displayed, varies between 0 seconds (which corresponds to the 
current moment in time) and a value entered in the Time 
interval parameter from the Plots Configuration window.

–The interval between values along the axes corresponds to a 
value of the Time step parameter specified in the Plots 
Configuration window.

For example, the graphs in Figure 3-60 on page 3-118 show the 
range of values 0 s to 360 s with the interval of 20 s.

• Vertical axes

Display the difference (in meters) between a particular position 
of your receiver and a fixed position of a target.

–The range of deviations that can be viewed, sets in the Max. 
deviation parameter of the Plots Configuration window.

–The interval between values along the axes corresponds to a 
value of the Deviation step parameter in the Plots 
Configuration window.

For example, the graphs in Figure 3-60 on page 3-118 show the 
range of deviations 0 m to 30 m with an interval of 10 m.

Plots Configuration
With the controls in this window, the user configures the settings in 
the Scatter, Satellites and Position windows (Figure 3-61 on 
page 3-120).

To go to the Plots Configuration window, select the Configuration 
item from the Plots menu.
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Figure 3-61. Plots Configuration Window

In the Points colors area, the user can change the color for the 
points of the Scatter window.

For example, if it is desired that the points corresponding to the 
absolute position estimates, be displayed in red, take the 
following steps:

1. Move the cursor onto the colored box, which is on the right 
side of Standalone.

2. Click either mouse button in a fill area of the box.

3. Click the color wanted. If the color desired is not seen, 
click Define Custom Colors>>. To the right of Basic 
colors you will see a custom palette where you can mix 
your own color. After selecting the color you want, click 
Add to Custom Colors, and then click OK.

In the Scatter group box, the user can change the settings related to 
the Scatter window.

• With the Plot Width edit box, the user specifies the length of 
the axes on the plot.

• The Tick Interval edit box specifies the tick size (in meters) 
between the adjacent concentric circles (i.e., interval between 
adjacent values on the axis).

• To remove the circle grid from the plot, clear the Show grid 
checkbox.
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• With the Connect points checkbox, the user can select whether 
to plot the positions as discrete points (checkbox disabled) or as 
a trajectory (checkbox enabled).

• With the Standalone, Code Differential, RTK float and RTK 
fixed checkboxes, the user specifies what kinds of solutions 
will be shown on the plot. It is recommended that you use a 
unique color for each solution type.

The Position group box contains the settings that govern the graphs 
in the Position window.

• The Time interval edit box specifies the length of the x axis (in 
seconds).

• The Max. deviation edit box specifies the length of the y axis 
(in meters). Zero means that the vertical axes will always be 
scaled automatically according to the maximum deviation value 
within the currently displayed time interval.

• To turn off the grid, clear the Show grid checkbox.

• The Time step edit box specifies the time (in seconds) between 
adjacent vertical gridlines.

• The Deviation step edit box sets the distance (in meters) 
between adjacent horizontal gridlines.

The Values to keep edit box determines the size of a circular buffer 
used to store the positions of the receiver’s antenna. The default 
value is 3600. When the buffer is full, the new values overwrite the 
oldest. This circular buffer is used with the aim of saving the 
computer memory consumption when the graphs have been being 
monitored for a long time (continuously during several hours, days, 
etc.).

To commit any changes that you have made, click Apply.
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About PC-CDU Window
The About PC-CDU window shows software version information 
and, after establishing connection, information about the receiver 
(Figure 3-62).

Figure 3-62. About PC-CDU Window

To access the About PC-CDU window, either select the About item 
from the Help menu, or press the keys CTRL+U.

Table 3-10 gives a description of each of the fields in this window.

Table 3-10. Connected Receiver Details

Field Description

Receiver model The model of the connected receiver.

Receiver ID The electronic identifier of the connected receiver.

Firmware version The firmware version installed on the receiver.

RTK support Shows whether the receiver can work in RTK 
mode.

Mainboard version The version of the GPS board.

RAM size The size of the receiver RAM in kilobytes.

Power Board The hardware and firmware version of the power 
board installed on the receiver.
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Power supply (V) The voltage of the external power supply.

Antenna input Shows whether the receiver uses internal or 
external antenna to acquire the GPS/GLONASS 
signals.

Ext. Ant. DC status Indicates if an external antenna draws acceptable 
DC current.

Power source Shows the power source used by the receiver.

Power cur.source Displays the power source that is currently being 
used by the receiver.

Charger status Displays the mode of an external charger.???

Charger cur.status Displays the mode in which the external charger is 
currently working.???

Battery A(V) Shows the voltage of the battery A.

Battery B(V) Shows the voltage of the battery B.

On board (V) Displays the voltage the receiver board draws.

Charger (V) Displays the output voltage of the internal charger 
during battery charging.

On ports (V) Displays the output voltage on the first pin of each 
of the receiver’s serial port.

Digital part 3.3V (V) Displays the voltage across the digital part of the 
receiver board.

Analog part 3.3V (V) Displays the voltage across the analog part of the 
receiver board.

Digital part 5V (V) Displays the voltage across the digital part of the 
receiver board.

Analog part 5V (V) Displays the voltage across the analog part of the 
receiver board.

Table 3-10. Connected Receiver Details (Continued)

Field Description
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Temperature (°C) Displays the temperature of the receiver board.

Flash memory size Displays the amount of available memory in your 
receiver for raw data storage.

Flash memory free Displays how much receiver memory is free.

Number of files Shows the number of raw data files in the receiver 
memory.

Bad blocks Displays the number of bad blocks (if any) in the 
receiver memory.

Write verify Displays the state of the write verify feature.

Block size Displays the block size of the receiver’s memory.

Blocks for files Displays the total amount of the receiver’s 
physical memory in blocks.

Physical memory Displays the total amount of the receiver’s 
physical memory in bytes.

Current port Shows the port the receiver is currently 
communicating through with PC-CDU.

Speed Shows the baud rate at which the receiver 
communicates with the PC.

Parity Shows whether parity checking is used or not. If 
used, displays the form of parity checking.

Stop bits Shows the number of bits used to mark the end of 
a byte.

RTS/CTS Shows whether hardware handshaking is used or 
not.

Infrared Shows the status of the infrared port.

Time from last reset Shows time elapsed since the last receiver reset.

Table 3-10. Connected Receiver Details (Continued)

Field Description
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Along with the information about the connected receiver, this 
window contains four buttons that have the following functions:

• Save to file – Records your receiver’s configuration information 
to a text file on the computer drive. For details on how to save 
this vital receiver information and submit it to Topcon, see “E-
mail” on page 4-5.

• Report – Records the contents of the About PC-CDU window 
together with the status of receiver options to a text file on the 
computer drive.

• Refresh – Updates the receiver details list.

• OK – Closes the window.

Hardware version Shows Topcon’s specific information.

Boot loader version Shows Topcon’s specific information.

Wait states Shows the flash memory access time expressed in 
wait states.

Table 3-10. Connected Receiver Details (Continued)

Field Description
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This chapter provides information on how to identify and remedy 
minor software problems.

Things to Check First
Before contacting TPS Customer support about any problems with 
the PC-CDU software, refer to the following list of basic 
suggestions that may help:

• Go through all external receiver connections carefully and make 
sure they are not wrong or loose.

• Double-check the cables. Cables became defective more often 
than the devices do.

• Check the sections below for available solutions.

• Reset the receiver using PC-CDU (Tools->Reset receiver).

• Restore factory default settings using PC-CDU (click 
Configuration->Receiver, then Set all parameters to 
defaults).

• Clear the NVRAM (see “Clearing the NVRAM” on page 4-14).

• Initialize the file system using PC-CDU (click Tools->Initialize 
file system; this will erase all files inside the receiver).
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Error Messages
The following are the error messages you may encounter while 
working with PC-CDU.

Table 4-1. Error Messages

Message Possible Cause Corrective Action

Can't find receiver

The receiver is turned off. Apply power and turn 
the receiver on.

The wrong computer port 
specified.

Select the correct 
computer port.

The receiver port you are 
trying to connect to is not 
in the command mode.

Use another free 
receiver port to connect 
with a computer.

Can't connect to the 
server

PC-CDU Internet Server 
is not started.

Configure and run PC-
CDU in Internet Server 
mode. For details, refer 
to “Internet Server 
Mode” on page 1-26.

PC-CDU Internet Server 
is not properly 
configured.

Double-check the 
Internet Server 
configuration. For 
details, refer to 
“Internet Server Mode” 
on page 1-26.

PC-CDU Internet Client 
is not properly 
configured.

Double-check the 
Internet Client 
configuration. For 
details, refer to 
“Internet Client Mode” 
on page 1-29.
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•Can't set 
<parameter>
•Can't set <value> for 
<parameter>
•Incorrect 
<parameter> value
•Invalid <parameter>
•Invalid value for 
<parameter>

PC-CDU and the receiver 
are disconnected.

Check the cable 
connection between the 
receiver and computer 
and restore the 
connection. For details, 
see “Getting 
Connected” on page 1-
8.

The parameter value is 
out of acceptable range.

Specify the value 
within the range of the 
selected parameter.

Converter application 
file not found!

PC-CDU cannot locate 
the tps2rin.exe file 
in the specified path.

Make sure you have 
this file on the 
computer and double-
check the file location.

Modem not found

The wrong receiver port. Select the correct 
receiver port. For 
details, see “RFM96 
Configuration 
Window” on page 3-91.

There is no radio modem 
installed in your receiver.

Open COMx port 
failed: Access is 
denied
(where x – 1, 2, 3, 
4,...)

Another application uses 
the computer port 
dedicated for connection

Close the application, 
then re-connect.
Alternatively, connect 
the receiver via another, 
unused computer port.

Table 4-1. Error Messages

Message Possible Cause Corrective Action
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Obtaining Technical Support
If the troubleshooting hints and tips in this User’s Manual fail to 
remedy the problem, contact TPS Customer Support.

Phone
To get in contact with TPS Customer Support by phone, call    
1-866-4TOPCON (1-866-486-7266).

Unable to create file

The receiver has no free 
space for files.

Download receiver files 
to a computer and then 
delete unnecessary files 
from the receiver. For 
details, see Chapter 
2 on page 2-25.

The receiver has no 
memory.

Contact your dealer to 
equip the receiver with 
memory.

The receiver has already 
logged 512 files into the 
internal memory.

Delete unnecessary 
files.

File name contains 
not allowed 
characters

Characters ??? cannot be 
used in the name of the 
log file.

Rename the log file 
using only allowed 
characters.

Table 4-1. Error Messages

Message Possible Cause Corrective Action
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E-mail
To get in contact with TPS Customer Support by e-mail, use the 
following electronic mail addresses:

If in doubt about which e-mail address to use for your particular 
question, please send it to support@topcon.com.

TIP
To provide you with quick and effective support, 
provide us with detailed description of the 
problem.

Typical steps you should take to provide us with this 
information are as follows:

1. Reveal the exact conditions when the problem occurs.

• What receiver model and configuration settings do you use?

–The easiest way to provide this information is to use the 
Save to file button in the About PC-CDU window. To do 
this, run PC-CDU and establish a connection between the 
receiver and the computer. Click Help, then click About, or 
alternatively press Ctrl+U. Click Save to file. Specify a 
name of the text file and click Save. The file will be saved 
onto the selected computer’s drive.

• What system/hardware specifications does the computer on 
which you are running (installing) PC-CDU have?

• What symptoms and/or error codes/messages do you see?

• Does the problem happen regularly or occasionally?

Table 4-2. Technical Support E-mail

For Questions Related To... Use...

PC-CDU pccdu@topcon.com

Hardware (receivers, antennas, firmware hardware@topcon.com
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2. Document the problem and create support request package.

• Write an e-mail that contains complete explanation of the 
problem with answers to the questions from Step 1.

• Attach the file created in Step 1 to this e-mail.

3. Submit e-mail to Customer Support.

• Send the e-mail you wrote in Step 2 to an appropriate 
electronic address given in “E-mail” on page 4-5.

NOTICE
Generally, you will receive a response within 24 
hours or less, depending on the severity of the 
problem.

TIP
You can also check our online resources for the 
latest product support information.

Web Site
The Topcon Positioning Systems website provides current 
information about Topcon’s line of products. The support area 
of the website provides access to frequently asked questions, 
configuration procedures, manuals, e-mail support, etc.

To access the TPS website home page, use: 
www.topconpositioning.com
To visit the support area, use:                                            
http://www.topcongps.com/support/
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This appendix will help you write PC-CDU scripts. It describes:

• the script language components, including variables and 
commands.

• the syntax of the commands, their function and usage.

Introduction to Scripting
Script is a plain text file each line of which is either a receiver 
command, or a PC-CDU command, or a comment. Scripts allow 
you to save a set of manual commands into one file. You can then 
load this single script instead of typing each individual command.

Variables
Variables are special character sequences that allow you to store 

some specific values9 in scripts. They can then be used in place of 
the values they store while running the script.

Currently PC-CDU supports the following variables: 

@1, @2, @3, @4, @5, @6, @7, @8, @9, and @0

The first nine of these variables initially contain the values of the 
script's command line arguments.

With the command @default, you can assign the default values to 
these variables unless the corresponding arguments have already 

9. Specified by the user and stored by PC-CDU.
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been specified through the script command line. Also, you may use 
the @set command to change the variables' values.

The variable @0, which is read-only, has a special purpose. Initially 
it contains the script name specified in the command line. In the 
course of script execution, it will either contain the last of the 
receiver's positive acknowledgements (i.e., the most recent of the 
RExxx replies), or remain empty.

After getting RExxx from the receiver, PC-CDU will search the 
received sequence for the last of the «%» symbols it contains. PC-
CDU does not assign to the variable @0 the entire RExxx reply, but 
only the characters following immediately after the last «%» 
symbol (until the end of this sequence is found). Leading and 
trailing spaces are trimmed. With the @set command, you can 
assign the value of @0 to other variables.

PC-CDU Commands
In essence, a PC-CDU command is a single word that instructs the 
receiver what to do.

Any line starting with the «@» character is interpreted as a PC-
CDU command with optional arguments separated by commas or 
spaces. In Table A-1 you will find the description of supported 
commands.

Table A-1. List of PC-CDU Commands

Command Arguments Description

:<label 
name>

Specifies a label to which you want 
the PC-CDU’s command interpreter 
to jump.
Label names should not contain 
spaces or commas. See the goto 
command for how to use labels.

call <script name> 
[<arguments>]

Executes another script from within 
the current script.
The maximum number of recursive 
calls is 200.
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clear Removes issued commands and 
receiver replies from the Manual 
Mode window.

default <variable> <default value> Defines the default values for those 
of the script arguments that were not 
explicitly specified in the command 
line.
For example,
@default @1 a
assigns the value a to the variable 
@1 unless this argument is already 
defined in the command line.

disconnect Stops script execution, disconnects 
PC-CDU from the receiver and 
closes the Manual Mode window. 
This is the same as pressing the 
Disconnect button.

echo on
off
any character sequence

Turns echo on and off, or displays 
its arguments. If echo is turned on, 
PC-CDU will display all nonempty 
lines entered in the script, 
specifically, PC-CDU commands, 
receiver commands and the 
corresponding reply messages. If 
echo is turned off, PC-CDU will 
display only replay messages 
preceding them with the «>» 
character.
PC-CDU will not show @echo off 
and @echo on commands.
Default is «on». 

exit Stops script execution, disconnects 
PC-CDU from the receiver and 
exists PC-CDU.

Table A-1. List of PC-CDU Commands

Command Arguments Description
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goto <label name> Jumps to the line following 
immediately after @:<label
name>.
If PC-CDU cannot find such a label 
in the script, this command is just 
ignored and PC-CDU continues 
with the script.

send <bytes to send> Sends the argument to the receiver 
as is, without making any 
substitutions. This string may 
contain escape sequences in a C-like 
style to represent non-printable 
characters.

Sequence Value Character

\a 0x07 BEL

\b 0x08 BS

\f 0x0C FF

\n 0x0A LF

\r 0x0D CR

\t 0x09 HT

\v 0x0B VT

\\ 0x5C Backslash

\'' 0x22 Double quote

\O any O – octal 
character code

\xH any H – hexadecimal 
character code

Example:
@send "#OFF#\r\n"

Table A-1. List of PC-CDU Commands

Command Arguments Description
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set • rate <new baud rate>
• rtscts [on,off]
• <variable> <value>

With these commands, you can 
assign both serial ports' parameters 
and PC-CDU's internal variables.
Example 1:
Suppose you have a script with the 
commands
….
@set @1 "a text"
@echo @1
….
When the script interpreter reaches 
the echo command, you will get the 
following reply:
>a text
Example 2:
Assign the current terminal's baud 
rate to @2:
%%print,/par/cur/term/
rate
@set @2 @0

sleep integer number of 
milliseconds

PC-CDU interrupts script execution 
for a specified number of 
milliseconds.

stop Stops script execution.

stoponerrors on
off

Enables/disables PC-CDU' stop-on-
error option. This indicates whether 
PC-CDU will stop script execution 
after getting an ERxxx message 
from the receiver. Default is «on».

Table A-1. List of PC-CDU Commands

Command Arguments Description
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Receiver Commands
Using scripts the user can specify receiver commands’ arguments 
either explicitly or through variables.

When you use variables for this purpose, these will be substituted 
by PC-CDU for some specific values before sending the 
corresponding command to the receiver. If the user sends a receiver 
command that starts with «%» (command label), PC-CDU will wait 
for the receiver to reply and, if a reply is received, it will save the 
reply to the variable @0.

Currently the character «@» is used in GRIL commands only to 
delimit the command checksum. It should not cause any problems 
since PC-CDU automatically adds a checksum for every command 
sent to the receiver.

PC-CDU does not interpret receiver commands. Therefore, if one 
uses receiver commands that change the baud rate and/or 

timeout integer value in 
milliseconds, default is 
5000

If a receiver command starts with a 
«%» symbol, PC-CDU will wait for 
the receiver to reply within the 
specified timeout interval. If a reply 
is received during this time, it will 
be saved to the variable @0. If no 
reply is received over the timeout 
interval, or if after receiving a few 
bytes PC-CDU gets no more data 
for 100+ milliseconds, or if PC-
CDU keeps receiving continuous 
data for more than 100 
milliseconds, @0 will be undefined 
(however, script execution will 
continue). In this you may need to 
adjust the timeout interval to be sure 
that the variable @0 contains 
correct information.

Table A-1. List of PC-CDU Commands

Command Arguments Description
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handshaking for the current receiver port (that is the port to which 
PC-CDU is connected), you should either use appropriate @set 
commands immediately after them, as shown below:

%%set,/par/cur/term/rtscts,off                                 

@set rtscts,off                                                                      

%%set,/par/cur/term/rate,9600                                                       

@set rate,9600                                                                                    

or specify such receiver commands at the end of the script, 
immediately before @disconnect or @exit. Otherwise, PC-CDU 
may be locked up waiting for the receiver to reply.

Below will be found some examples illustrating various 
applications of scripts.

The following script serves the purpose described in the article 
Using the Coast Guard Beacon for Differential Corrections      
(http://www.topcongps.com/support/how-to/beaconsetup.html).

@default @1,c

%%set,dev/ser/@1/imode,rtcm

%%set,dev/ser/@1/rate,9600

%%set,/par/pos/mode/cur,cd

%%em,,/msg/nmea/GGA:1

@exit

After these lines are saved to a file (e.g., beacon.jpc), you can 
then type in the command line @beacon and press Enter to 
instruct the receiver to input RTCM corrections from serial port C 
and output NMEA messages to the current terminal. If the user 
wants to use serial port B for inputting corrections, type @beacon 
b and press Enter.

The following example illustrates how the goto command and 
labels are used in scripts intended for work with different receiver 
models.
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%/par/rcv/model%print,/par/rcv/model

@goto Is@0

@echo Unknown receiver model.

@stop

@:IsOdyssey

@echo Receiver is Odyssey!

@goto end

@:IsLegacy

@echo Receiver is Legacy!

@goto end

@:IsEurocard

@echo Receiver is Eurocard!

@:IsHIPER

@echo Receiver is HIPER!

@goto end

@:end

@stop
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Writing and Editing Scripts
You can create and edit scripts directly in the PC-CDU’s Manual 
Mode window or in any text editor, e.g. Notepad.

To create a script using the Manual Mode window:

1. In the Manual Mode window, click the Edit script button.

2. Enter the name of a new script in the File name field.

3. Click the Open button.

4. Type the script commands.

5. Click the Save script button.

To edit an existing script using the Manual Mode window:

1. In the Manual Mode window, click the Edit script button.

2. Navigate to a list of available scripts and select the desired 
script name from that list.

3. Click the Open button.

4. Make necessary changes in the script and then click the Save 
script button.

5. Finally, click the Close editor button.

TIP
It is recommended to save scripts using the 
extension .tpc.

TIP
For easy access to scripts, keep them all in one 
directory, e.g. in PC-CDU’s working directory.
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Running Scripts
To run a script through the command line of the Manual Mode 
window:

1. Enter the script name with a preceding '@' character (e.g. 
@my_script).

OR

Click the Load script button and select the required script from 
the Script file window.

2. Specify script arguments, if required.

3. Click the Send command button.

NOTICE
Script arguments should be delimited by either 
spaces or commas. If some of the arguments in 
the command line contain separators (spaces 
and/or commas), put such arguments into 
double quotes, e.g.: @myscript “This is one 
argument”.

After PC-CDU starts script execution, it will read the file line by 
line carrying out the following operations, if necessary:

• skipping empty and comment lines;

• replacing variables with their specific values;

• echoing non-empty lines to the screen (if echo is enabled);

• interpreting PC-CDU internal commands, and;

• sending commands to the receiver and (optionally) waiting for 
receiver replies.

To abort script execution, click the Stop script button.
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Running Scripts from Windows Explorer
Files with the extension .tpc are automatically associated with 
PC-CDU. It means that you can launch PC-CDU (specifically 
in Manual mode) by clicking on a script in the file/directory 
tree. It can be achieved with the use of Windows Explorer, My 
Computer or some other Windows file manager.

After the Connection Parameters window pops up, you click 
the Connect button to open PC-CDU’s Manual Mode window. 
Note, however, that the script you selected will not start 
automatically so that you should type the name of desired script 
in the command line or select the script through the Load 
script button. After exiting Manual mode, you can continue 
working with PC-CDU in the usual way.
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This appendix provides a complete list of PC-CDU settings 
including their values and ranges (if applicable), units (if 
applicable), and pages on which these parameters are described in 
detail.

The default value for a setting is shown in Italic (if applicable).

Connection Parameters Window
Table B-1 provides a list of settings that are available in the 
Connection Parameters Window. The default value for a setting is 
shown in Italic (if applicable).

Table B-1. Connection Parameters Settings

Parameter Values/Range Units
Where to 

Find 
Description

Connection Mode

• Direct

• Internet Client

• Internet Server

–
page 1-9–
page 1-31

Port settings Area

Port

• COM#’s

• USB

• LPT

• ETHR

–

page 1-10, 
page 1-14, 
page 1-16, 
page 1-19, 
page 1-26
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Baud rate

• 4800

• 9600

• 19200

• 38400

• 57600

• 115200

• 230400

• 460800

bps page 1-10

Infrared port
• enabled

• disabled
– page 1-11

RTC/CTS 
handshaking

• enabled

• disabled
– page 1-10

TCP port
(for Ethernet 

connection only)
1...8002...65536 –

page 1-19, 
page 1-26

Host name
(for Ethernet 

connection only)

• 0.0.0.0 ... 
255.255.255.255

• not specified

–
page 1-20, 
page 1-26

Password
(for Ethernet 

connection only)

• up to 15 a/n 
characters

• no password

–
page 1-20, 
page 1-26

Program Settings Area

Passive mode
• enabled

• disabled
– page 1-12

Manual mode 
only

• enabled

• disabled
– page 1-12

Table B-1. Connection Parameters Settings (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Timeout

• 500

• 1000

• 2000

• 3000

• 4000

• 5000

• 10000

milliseconds page 1-12

Restore the 
receiver’s original 

baud rate on 
Disconnect

• enabled

• disabled – page 1-12

Internet (Client - Server) settings Area

Host name

• localhost

• 0.0.0.0 to 
255.255.255.255

• DNS addresses

– page 1-30

TCP port
1...8000...65536

–
page 1-27, 
page 1-30

Password
• up to 128 a/n 

characters

• no password

–
page 1-27, 
page 1-30

Display data on 
server

• enabled

• disabled
– page 1-28

Log server events
• enabled

• disabled
– page 1-27

DNS lookup
• enabled

• disabled
–

page 1-28, 
page 1-30

Table B-1. Connection Parameters Settings (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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File Manager Window
Table B-2 provides a list of settings that are available in the File 
Manager Window. The default value for a setting is shown in Italic 
(if applicable).

Table B-2. File Manager Settings

Parameter Values/Range Units
Where to 

Find 
Description

Download files Tab

Exclusive mode
• disabled

• enabled
– page 3-17

Block size

• 512

• 1024

• 2048

bytes page 3-16

Current log file Tab

File name
• any string

• not specified
– page 3-19

Recording interval 0...1...86400 seconds page 3-19

Elevation mask -90...5...90 degrees page 3-19

Download path Tab

New folder any string – page 3-22
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Real-Time Logging Window
Table B-3 provides a list of settings that are available in the Real-
Time Logging Window. The default value for a setting is shown in 
Italic (if applicable).

Table B-3. Real-Time Logging Settings

Parameter Values/Range Units
Where to 

Find 
Description

Single file Tab

Save to
up to 24 a/n 
characters

– page 3-25

Recording interval 0...1...86400 seconds page 3-19

Elevation mask -90...5...90 degrees page 3-19

Multiple files Tab

Prefix
up to 16 a/n 
characters

–
page 2-22, 
page 3-26

Numbering
• Ascending 

Count

• Date & Time
–

page 2-22, 
page 3-26

New file every
any integer 

number

• minutes

• hours

• days

page 2-22, 
page 3-27

Autoconvert to 
RINEX

• enabled

• disabled –
page 2-22, 
page 2-23, 
page 3-29

Start Count
0...999999

–
page 2-22, 
page 3-27

Overwrite existing 
files

• enabled

• disabled
–

page 2-22, 
page 3-28
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Settings List

B-6
Receiver Configuration Window
Table B-4 through Table B-11 provide a list of settings that are 
available in the Connection Parameters window. The default value 
for a setting is shown in Italic (if applicable).

Recording interval 0...1...86400 seconds
page 2-22, 
page 3-19

Elevation mask
-90...5...90

degrees
page 2-22, 
page 3-19

Select output path Tab

New folder • any string – page 3-22

Table B-4. Connection Parameters Settings – General Tab

Parameter Values/Range Units
Where to 

Find 
Description

Elevation mask Area

Terminal 
Elevation Mask

-90...5...90 degrees page 3-35

Antenna

• Internal

• External

• Auto

– page 3-35

Antenna Status Area

Current Input
• int

• ext
– page 3-37

Table B-3. Real-Time Logging Settings (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
Topcon PC-CDU User’s Manual



Receiver Configuration Window

B-7
Ext. DC Status

• off

• normal

• overload

– page 3-37

Temperature Area

Board 
temperature

a numeral oC page 3-37

Power management Area

Power->Mode

• Auto

• Mix

• Battery A

• Battery B

• External

– page 3-37

Power->Current 
Mode

• mix

• ext

• a

• b

– page 3-38

Charger->Mode

• Off

• Charge A

• Charge B

• Auto

– page 3-38

Charger->Speed
• normal

• fast
– page 3-38

Charger->Current 
Mode

• off

• a

• b

– page 3-38

Charger->Current • a numeral Amperes page 3-38

Table B-4. Connection Parameters Settings – General Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Settings List

B-8
Power output 
modes->Ports A,B 

(for Odyssey 
only)

• enabled

• disabled
– page 3-38

Power output 
modes->Port C 
(for Odyssey 

only)

• enabled

• disabled
– page 3-38

Power output 
modes->Ports

• Off

• On

• Always

– page 3-38

Power output 
modes->Slots

• Off

• On

• Always

– page 3-39

Voltages->
External

float values Volts page 3-39

Voltages->
On Board

float values Volts page 3-39

Voltages->
Battery A

float values Volts page 3-39

Voltages->
Battery B

float values Volts page 3-39

Voltages->
Charger

float values Volts page 3-39

Voltages->
On Ports

float values Volts page 3-39

Turn on/off Slots  
->Slot 2 (C)

• enabled

• disabled
– page 3-39

Table B-4. Connection Parameters Settings – General Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Receiver Configuration Window

B-9
Turn on/off Slots  
->Slot 3 (B)

• enabled

• disabled
– page 3-39

Turn on/off Slots  
->Slot 4 (D)

• enabled

• disabled
– page 3-39

Enable Low 
Power Mode

• enabled

• disabled
– page 3-39

Table B-5. Connection Parameters Settings – MINTER Tab

Parameter Values/Range Units
Where to 

Find 
Description

Recording 
Interval

0...1...86400 seconds page 3-40

Elevation mask 
for Log file

-90...5...90 degrees page 3-41

File name prefix
• log

• up to 20 a/n 
characters

– page 3-41

Always append to 
the file

up to 20 a/n 
characters

– page 3-41

FIle Creation 
mode

• Log file

• AFRM
– page 3-41

Table B-4. Connection Parameters Settings – General Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Settings List

B-10
Automatic File Rotation Mode (AFRM) parameters Area

Period 60...3600...86400 seconds page 3-42

Phase 0...86400 – page 3-42

Files (total) 0... 231-1 – page 3-42

Files (remain) integer values – page 3-42

Automatically 
remove old files

• enabled

• disabled
– page 3-42

FN key mode Area

FN key mode

• LED blink 
mode switch

• Occupation 
mode switch

– page 3-42

Initial data collection dynamic mode Area

Initial data 
collection 

dynamic mode

• Static

• Kinematic
– page 3-42

Data recording auto-start Area

Data recording 
auto-start

• Off

• On

• Always

– page 3-43

Table B-5. Connection Parameters Settings – MINTER Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Receiver Configuration Window

B-11
Table B-6. Connection Parameters Settings – Positioning Tab

Parameter Values/Range Units
Where to 

Find 
Description

Positioning Mode Area

Positioning Mode

• Standalone

• DGPS (Code 
Differential)

• RTK Float

• RTK Fixed

– page 3-45

Positioning Masks Area

Elevation mask -90...5...90 degrees page 3-46

PDOP mask 0...30...500 – page 3-46

RAIM Enabled Area

RAIM Enabled
• enabled

• disabled
– page 3-47

Alarm

• Manual

• Non-
precision

• Terminal

• En route

– page 3-47

Alarm limit 10...555.6...10000 meters page 3-47

Current Datum
• datum IDs 

list

• W84

– page 3-48
P/N 7010-xxxx www.topconpositioning.com



Settings List

B-12
Enable Solutions Area

Enable Solutions

• Standalone

• DGPS

• RTK Float

• RTK Fixed

– page 3-45

Positioning System Area

GPS
• enabled

• disabled
– page 3-51

GLONASS
• enabled

• disabled
– page 3-51

Measurements Used Area

Measurements 
Used

• CA/L1

• P/L1

• P/L2

• Iono-Free

– page 3-51

Iono-Correction
• enabled

• disabled
– page 3-51

Tropo-Correction
• enabled

• disabled
– page 3-52

Satellite management Area

Satellites tracked
->GPS

• enabled

• disabled
– page 3-52

Satellites tracked
->GLONASS

• enabled

• disabled
– page 3-52

Table B-6. Connection Parameters Settings – Positioning Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Receiver Configuration Window

B-13
Satellites used in 
pos.->GPS

• enabled

• disabled
– page 3-52

Satellites used in 
pos.->GLONASS

• enabled

• disabled
– page 3-52

GPS Subtab

lock
• enabled

• disabled
– page 3-52

use
• enabled

• disabled
– page 3-52

GLONASS Subtab

Satellite 
Numbering

• Frequency 
Channel 
Number

• Slot Number

– page 3-53

lock • enabled

• disabled
– page 3-54

use • enabled

• disabled
– page 3-54

WAAS Subtab

Channel 1
or

Channel 2

• enabled

• disabled – page 3-54

Set WAAS 120...138 – page 3-54

as GPS 1...32 – page 3-54

Table B-6. Connection Parameters Settings – Positioning Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Settings List

B-14
Interpret message 
#0 as message: #

0...99 – page 3-54

Use Iono 
Corrections

• Never

• If exist

• Only

– page 3-54

Enable output of 
«true» WAAS 
PRN numbers

• enabled

• disabled – page 3-55

Table B-7. Connection Parameters Settings – Base Tab

Parameter Values/Range Units
Where to 

Find 
Description

Base Station Coordinates (Antenna Phase Center) Area

GPS/GLO at one 
time

• enabled

• disabled
– page 3-56

GPS/GLO 
separately

• enabled

• disabled
– page 3-56

Averaged
• enabled

• disabled
– page 3-57

Avg. Span 0...180...32000 – page 3-57

Table B-6. Connection Parameters Settings – Positioning Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Receiver Configuration Window

B-15
GPS/GLO, GPS, and GLONASS Subtabs

Lat

90o00’00.000000’’N
...

0o00’00.000000’’
...

90o00’00.000000’’S

DD MM 
SS.ssssss

page 3-56

Lon

180o00’00.000000’’E
...

0o00’00.000000’’
...

180o00’00.000000’’W

DDD MM 
SS.ssssss

page 3-56

Alt
-20000.000

...0.0...
+20000.000

meters page 3-56

L1 to L2 Antenna Phase Center offsets Area

East -0.1...0.0...+0.1 meters page 3-58

North -0.1...0.0...+0.1 meters page 3-58

Height -0.1...0.0...+0.1 meters page 3-58

RTCM Settings Area

Station ID 0...1023 – page 3-58

Max. number of 
Satellites

0... – page 3-58

Health

• Good

• Bad

• Unknown

– page 3-59

Table B-7. Connection Parameters Settings – Base Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Settings List

B-16
Measurements Sent Area

CA/L1
• enabled

• disabled
– page 3-59

P/L1
• enabled

• disabled
– page 3-59

P/L2
• enabled

• disabled
– page 3-59

System Used Area

GPS
• enabled

• disabled
– page 3-59

GLONASS
• enabled

• disabled
– page 3-59

Pseudo-range 
smoothing

• enabled

• disabled
– page 3-59

CMR Settings Area

Station ID 0...31 – page 3-58

Motion

• Unknown

• Static

• Kinematic

– page 3-59

Measurements Sent Area

CA/L1
• enabled

• disabled
– page 3-59

P/L1
• enabled

• disabled
– page 3-59

Table B-7. Connection Parameters Settings – Base Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Receiver Configuration Window

B-17
P/L2
• enabled

• disabled
– page 3-59

GLONASS 
message

3...5...7 – page 3-60

Short ID
• not specified

• up to 8 a/n 
characters

– page 3-60

COGO
• not specified

• up to 16 a/n 
characters

– page 3-60

Long ID
• not specified

• up to 50 a/n 
characters

– page 3-60

Table B-8. Connection Parameters Settings – Rover Tab

Parameter Values/Range Units
Where to 

Find 
Description

Positioning Mode Area

Positioning Mode

• Standalone

• DGPS (Code 
Differential)

• RTK Float

• RTK Fixed

– page 3-61

Table B-7. Connection Parameters Settings – Base Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Settings List

B-18
DGPS Parameters Area

Multi-base
• enabled

• disabled
– page 3-61

Corrections usage Area

Nearest
• enabled

• disabled
– page 3-62

Mix
• enabled

• disabled
– page 3-62

Corrections (only 
if Mix enabled)

• enabled

• disabled
– page 3-62

Positions (only if 
Mix enabled)

• enabled

• disabled
– page 3-62

Best
• enabled

• disabled
– page 3-62

CD Corrections 
max. age

1...30...1200 seconds page 3-62

Iono Corrections 
max. age

1...300...1800 seconds page 3-63

Use Iono 
Corrections

• enabled

• disabled
– page 3-63

Source

• Any

• Serial A

• Serial B

• Serial C

• Serial D

– page 3-63

Table B-8. Connection Parameters Settings – Rover Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Receiver Configuration Window

B-19
Enable Solutions Area

Enable Solutions

• Standalone

• DGPS

• RTK Float

• RTK Fixed

– page 3-63

RTK Parameters Area

RTK mode
• Extrapolation

• Delay
– page 3-63

Dynamics
• Static

• Kinematic
– page 3-64

Ambiguity fixing 
level

• Low

• Medium

• High

– page 3-64

Measurements Used Area

CA/L1
• enabled

• disabled
– page 3-64

P/L1
• enabled

• disabled
– page 3-64

P/L2
• enabled

• disabled
– page 3-64

Base Corrections 
period

0.05…1…100 seconds page 3-64

Use old ref. 
coordinates

• enabled

• disabled
– page 3-65

Table B-8. Connection Parameters Settings – Rover Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Settings List

B-20
Source

• Any

• Serial A

• Serial B

• Serial C

• Serial D

– page 3-65

CMR Settings Area

GLONASS 
message

3...5...7 – page 3-65

Table B-9. Connection Parameters Settings – Ports Tab

Parameter Values/Range Units
Where to 

Find 
Description

Serial Subtab

Serial A, Serial B, Serial C, Serial D

Input

• None

• Command

• Echo

• RTCM 2.x

• RTCM 3.x

• CMR

• JPS

• Omni

– page 3-67

Table B-8. Connection Parameters Settings – Rover Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
Topcon PC-CDU User’s Manual



Receiver Configuration Window

B-21
Output

• None

• DGPS RTCM 
{1,31,3}

• DGPS RTCM 
{9,34,3}

• RTK RTCM 
{18,19,22,3}

• RTK RTCM 
{20,21,22,3}

• RTK RTCM 
{18,19,23,24}

• RTK RTCM 
{20,21,23,24}

• RTK RTCM3 GD 
min

• RTK RTCM3 GD 
full

• RTK RTCM3 
GGD min

• RTK RTCM3 
GGD full

• RTK CMR 
{10,0,1}

• RTK CMR+ 
{10,0,9}

• RTK JPS min

• RTK JPS max

• User Defined

– page 3-68

Period 1...86400 seconds page 3-69

Table B-9. Connection Parameters Settings – Ports Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Settings List

B-22
Baud rate

• 4800

• 9600

• 19200

• 38400

• 57600

• 115200

• 230400

• 460800

bps page 3-70

RTS/CTS
• enabled

• disabled
– page 3-70

Infrared
• enabled

• disabled
– page 3-70

Parallel Subtab

Input

• None

• Command

• Echo

• RTCM 2.x

• RTCM 3.x

• CMR

• JPS

• Omni

– page 3-70

Table B-9. Connection Parameters Settings – Ports Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Receiver Configuration Window

B-23
Output

• None

• DGPS RTCM 
{1,31,3}

• DGPS RTCM 
{9,34,3}

• RTK RTCM 
{18,19,22,3}

• RTK RTCM 
{20,21,22,3}

• RTK RTCM 
{18,19,23,24}

• RTK RTCM 
{20,21,23,24}

• RTK RTCM3 GD 
min

• RTK RTCM3 GD 
full

• RTK RTCM3 
GGD min

• RTK RTCM3 
GGD full

• RTK CMR 
{10,0,1}

• RTK CMR+ 
{10,0,9}

• RTK JPS min

• RTK JPS max

• User Defined

– page 3-70

Period 1...86400 seconds page 3-70

Table B-9. Connection Parameters Settings – Ports Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Settings List

B-24
Modem Subtab

Input

• None

• Command

• Echo

• RTCM 2.x

• RTCM 3.x

• CMR

• JPS

• Omni

– page 3-71

Output

• None

• DGPS RTCM 
{1,31,3}

• DGPS RTCM 
{9,34,3}

• RTK RTCM 
{18,19,22,3}

• RTK RTCM 
{20,21,22,3}

• RTK RTCM 
{18,19,23,24}

• RTK RTCM 
{20,21,23,24}

• RTK RTCM3 GD 
min

• RTK RTCM3 GD 
full

• RTK RTCM3 
GGD min

– page 3-71

Table B-9. Connection Parameters Settings – Ports Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Receiver Configuration Window

B-25
Output

• RTK RTCM3 
GGD full

• RTK CMR 
{10,0,1}

• RTK CMR+ 
{10,0,9}

• RTK JPS min

• RTK JPS max

• User Defined

– page 3-71

Period 1...86400 seconds page 3-71

Type
• Receiving

• Transmitting
– page 3-71

Mode

• Off

• FHSS

• DSS

– page 3-71

Antenna
• Int

• Ext
– page 3-71

Power
• High

• Low
– page 3-72

USB Subtab

Input

• None

• Command

• Echo

• RTCM 2.x

• RTCM 3.x

– page 3-72

Table B-9. Connection Parameters Settings – Ports Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Settings List

B-26
Input

• CMR

• JPS

• Omni

– page 3-72

Output

• None

• DGPS RTCM 
{1,31,3}

• DGPS RTCM 
{9,34,3}

• RTK RTCM 
{18,19,22,3}

• RTK RTCM 
{20,21,22,3}

• RTK RTCM 
{18,19,23,24}

• RTK RTCM 
{20,21,23,24}

• RTK RTCM3 GD 
min

• RTK RTCM3 GD 
full

• RTK RTCM3 
GGD min

• RTK RTCM3 
GGD full

• RTK CMR 
{10,0,1}

• RTK CMR+ 
{10,0,9}

• RTK JPS min

• RTK JPS max

• User Defined

– page 3-72

Table B-9. Connection Parameters Settings – Ports Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Receiver Configuration Window

B-27
Period 1...86400 seconds page 3-72

Ethernet Subtab

IP Settings Area

IP Address
0.0.0.0...

192.168.2.2...
255.255.255.255

– page 3-73

IP Mask
0.0.0.0...

255.255.255.192...
255.255.255.255

– page 3-73

Gateway
0.0.0.0...

192.168.2.1...
255.255.255.255

– page 3-73

Telnet Settings Area

TCP Port 1...8002...65535 – page 3-74

Timeout 1...600...2147483647 seconds page 3-74

Network 
Password

• up to 15 a/n 
characters

• automatically 
generated unique 
value

– page 3-75

FTP Settings Area

TCP Port 1...21...65535 – page 3-74

Timeout 1...600...2147483647 seconds page 3-74

Table B-9. Connection Parameters Settings – Ports Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Settings List

B-28
TCP Subtab

TCP A, TCP B, TCP C, TCP D, TCP E

Input

• None

• Command

• Echo

• RTCM 2.x

• RTCM 3.x

• CMR

• JPS

• Omni

– page 3-75

Output

• None

• DGPS RTCM 
{1,31,3}

• DGPS RTCM 
{9,34,3}

• RTK RTCM 
{18,19,22,3}

• RTK RTCM 
{20,21,22,3}

• RTK RTCM 
{18,19,23,24}

• RTK RTCM 
{20,21,23,24}

• RTK RTCM3 GD 
min

• RTK RTCM3 GD 
full

Table B-9. Connection Parameters Settings – Ports Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Receiver Configuration Window

B-29
Output

• RTK RTCM3 
GGD min

• RTK RTCM3 
GGD full

• RTK CMR 
{10,0,1}

• RTK CMR+ 
{10,0,9}

• RTK JPS min

• RTK JPS max

• User Defined

– page 3-75

Period 1...86400 seconds page 3-75

Table B-10. Connection Parameters Settings – Events Tab

Parameter Values/Range Units
Where to 

Find 
Description

Events Tab

PPS A Enabled and PPS B Enabled Areas

PPS A Enabled
or

PPS B Enabled

• enabled

• disabled
– page 3-76

Period
10...1000

...1000000000
milliseconds page 3-77

Offset
-500000000…
0…500000000

milliseconds page 3-77

Table B-9. Connection Parameters Settings – Ports Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Settings List

B-30
Offset -500000…0…500000 nanoseconds page 3-77

Period of 
‘marked’ pulses

0...20...1000000000 milliseconds page 3-77

Edge
• Rise

• Fall
– page 3-77

Ref. Time

• GPS

• GLO

• UTCus

• UTCus

– page 3-77

Tied with Ref. 
Time

• enabled

• disabled
– page 3-77

Event A Enabled and Event B Enabled Areas

Event A Enabled
or

Event B Enabled

• enabled

• disabled
– page 3-78

Clock 
Synchronization

• enabled

• disabled
– page 3-78

Status
• on

• off
– page 3-78

Edge
• Rise

• Fall
– page 3-78

Ref. Time

• GPS

• GLO

• UTCus

• UTCsu

– page 3-77

Table B-10. Connection Parameters Settings – Events Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Receiver Configuration Window

B-31
Tied with Ref. 
Time

• enabled

• disabled
– page 3-77

Table B-11. Connection Parameters Settings – Advanced Tab

Parameter Values/Range Units
Where to 

Find 
Description

Anti-Interference Subtab

Anti-Interference

• Off

• GPS L1/L2

• GLONASS L1/
L2

• GPS/GLONASS 
L1

• GPS/GLONASS 
L2

• Auto

– page 3-79

Multipath Reduction Subtab

Code multipath 
reduction

• enabled

• disabled
– page 3-80

Carrier multipath 
reduction

• enabled

• disabled
– page 3-80

Loop Management Subtab

PLL bandwidth 2...25...50 Hz page 3-82

Table B-10. Connection Parameters Settings – Events Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Settings List

B-32
PLL order
• 2

• 3
– page 3-82

Guided loop 
bandwidth

0.1...0.5...10 Hz page 3-82

C/A code guided 
loop bandwidth

0.1...0.8...50 Hz page 3-82

Enable Adaptive 
Guided Loops

• enabled

• disabled
– page 3-82

Enable Co-Op Tracking Loop Area

Enable Co-Op 
Tracking Loop

• enabled

• disabled
– page 3-83

Static Mode
• enabled

• disabled
– page 3-83

Bandwidth of 
individual PLL

2...5...20 Hz page 3-83

Bandwidth of 
common PLL

2...25...50 Hz page 3-83

Enable Common 
Loop for L2

• enabled

• disabled
– page 3-83

External Frequency Subtab

Frequency Source Area

Source
• Internal

• External
– page 3-84

Ext. frequency 
value

2...10...40 MHz page 3-84

Table B-11. Connection Parameters Settings – Advanced Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Receiver Configuration Window

B-33
Ext. frequency 
source status

• off

• wait

• locked

– page 3-85

Ext. freq. signal 
amplitude

• off

• low

• ok

– page 3-85

Oscillator Offset Reduction Area

Oscillator Offset 
Reduction

• Off

• Freq. Locked

• Freq. and Time 
Locked

– page 3-85

Raw Data Management Subtab

Raw Measurement Update Rate

Update Rate 10...100...5000 milliseconds page 3-87

Current Update 
Rate

• any integer value 
between 50?? and 
5000

milliseconds page 3-87

Position Update Rate

Update Rate 10...100...5000 milliseconds page 3-87

Current Update 
Rate

• any integer value 
between 50?? and 
5000

milliseconds page 3-87

Code smoothing 
interval

0...300...900 seconds page 3-87

Table B-11. Connection Parameters Settings – Advanced Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Settings List

B-34
Site Configuration Window
Table B-12 provides a list of settings that are available in the Site 
Configuration Window. The default value for a setting is shown in 
Italic (if applicable).

Doppler 
smoothing 

method
0, 1, 2 – page 3-88

Nominal Iono 
smoothing 

interval
0...60...900 seconds page 3-88

Minimum Iono 
smoothing 

interval
0...30...900 seconds page 3-88

Options Subtab

Cinderella
• On

• Off
– page 3-88

Table B-12. Site Configuration Settings

Parameter Values/Range Units
Where to 

Find 
Description

Site Parameters Area

Site Name up to 20 a/n characters – page 3-89

Antenna Status
• Fixed

• Moving
– page 3-89

Table B-11. Connection Parameters Settings – Advanced Tab (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Target position Window
Table B-13 provides a list of settings that are available in the Target 
position Window. The default value for a setting is shown in Italic 
(if applicable)

Antenna Parameters Area

Antenna Height ??? meters page 3-89

Slant
• enabled

• disabled
– page 3-89

Antenna Type list of antenna types – page 3-89

Send parameters 
automatically

• enabled

• disabled
–

page 3-19, 
page 3-90

Table B-13. Target position Settings

Parameter Values/Range Units
Where to 

Find 
Description

Lat

90o00’00.000000’’N
...

0o00’00.000000’’
...

90o00’00.000000’’S

DD MM 
SS.ssssss

page 3-90

Lon

180o00’00.000000’’E
...

0o00’00.000000’’
...

180o00’00.000000’’W

DDD MM 
SS.ssssss

page 3-90

Table B-12. Site Configuration Settings (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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RFM96 Configuration Window
Table B-14 provides a list of settings that are available in the 
RFM96 Configuration Window. The default value for a setting is 
shown in Italic (if applicable).

Table B-14. RFM96 Configuration Settings

Parameter Values/Range Units
Where to 

Find 
Description

Connect Tab

Modem connected 
to port

• B

• C

• D

– page 3-91

Connect to 
modem at bitrate

• Auto

• 38400

• 19200

• 9600

• 4800

• 2400

bps page 3-92

Connection type
• Search for 

modem

• Power cycle
– page 3-92

Configuration Tab

RF Channel
• list of enabled 

channels

• 0

MHz page 3-93
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DTE-DCE Serial Interface Area

Baud rate

• 38400

• 19200

• 9600

• 4800

• 2400

bps page 3-93

Parity

• None

• Even

• Odd

– page 3-93

EOT 0...10...255 – page 3-93

Radio Link Settings Area

Link rate
• 4800

• 9600
bps page 3-93

Retries 0...3...255 – page 3-93

FEC
• Off

• On
– page 3-93

Scrambling
• Off

• On
– page 3-93

Digisquelch

• High

• Moderate

• Low

• Off

– page 3-93

CSMA monitor
• Off

• On
– page 3-93

Table B-14. RFM96 Configuration Settings (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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DTE-DCE protocol mode Area

DTE-DCE 
protocol mode

• Transp. w/EOT 
time out

• Transp. w/EOT 
character

• Packet

• Auto-repeater

• Fast async

– page 3-93

BREAK to 
Command

• enabled

• disabled
– page 3-93

Addresses Area

Local 0...254 – page 3-93

Destination 0...255 – page 3-93

Table B-14. RFM96 Configuration Settings (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Plots Configuration Window
Table B-15 provides a list of settings that are available in the Plots 
Configuration Window. The default value for a setting is shown in 
Italic (if applicable).

Table B-15. Plots Configuration Settings

Parameter Values/Range Units
Where to 

Find 
Description

Point colors Area

Standalone color palette – page 3-120

Code differential color palette – page 3-120

RTK float color palette – page 3-120

RTK fixed color palette – page 3-120

Position Area

Time interval 1...360...99999999 seconds page 3-121

Max. deviation 0.0...99999999.0 meters page 3-121

Show grid
• enabled

• disabled
– page 3-121

Time step 1...30...99999999 seconds page 3-121

Deviation step
0.0001...0.5... 
99999999.0

meters page 3-121

Scatter Area

Plot width
0.0001...10.0... 

99999999.0
meters page 3-120

Tick interval
0.0001...1.0... 
99999999.0

meters page 3-120
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Show grid
• enabled

• disabled
– page 3-120

Connect points
• enabled

• disabled
– page 3-121

Standalone
• enabled

• disabled
– page 3-121

Code differential
• enabled

• disabled
– page 3-121

RTK float
• enabled

• disabled
– page 3-121

RTK fixed
• enabled

• disabled
– page 3-121

General Area

Values to keep 3600...2678400 – page 3-121

Table B-15. Plots Configuration Settings (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Converter to RINEX Setup Window
Table B-16 provides a list of settings that are available in the 
Converter to RINEX Setup Window. The default value for a setting 
is shown in Italic (if applicable).

Table B-16. Converter to RINEX Setup Settings

Parameter Values/Range Units
Where to 

Find 
Description

Properties Area

Run by
any a/n characters

–
page 2-23, 
page 3-30

Observer
any a/n characters

–
page 2-23, 
page 3-30

Agency
any a/n characters

–
page 2-23, 
page 3-30

Antenna #
any a/n characters

–
page 2-23, 
page 3-30

Antenna type
any a/n characters

–
page 2-23, 
page 3-30

Comment
any a/n characters

–
page 2-23, 
page 3-30

Marker name
any a/n characters

–
page 2-23, 
page 3-30

Marker number
any a/n characters

–
page 2-24, 
page 3-30

Converter Area

Application
path to converter

–
page 2-24, 
page 3-30

Exclude GPS
• enabled

• disabled
–

page 2-24, 
page 3-31
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Exclude 
GLONASS

• enabled

• disabled
–

page 2-24, 
page 3-31

Exclude L1
• enabled

• disabled
–

page 2-24, 
page 3-31

Exclude L2
• enabled

• disabled
–

page 2-24, 
page 3-31

Delete source JPS 
files after 
successful 

conversation

• enabled

• disabled –
page 2-24, 
page 3-31

Additional 
options

list of switches
–

page 2-24, 
page 3-31

Table B-16. Converter to RINEX Setup Settings (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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<Datum ID> Datum Parameters 
Window
Table B-17 provides a list of settings that are available in the 
<Datum ID> Datum Parameters Window. The default value for a 
setting is shown in Italic (if applicable).

Table B-17. Datum Settings

Parameter Values/Range Units
Where to 

Find 
Description

Current Datum
• datum IDs list

• W84
– page 3-49

Reference Ellipsoid parameters Area

Ellipsoid ID two-letter IDs – page 3-49

Semi-major axis
6300000.0...

6378137.0000...
6500000.0

meters page 3-49

Inverse flattening
280.0…

298.257223563...
310.0

– page 3-49

Transformation parameters Area

Reference Datum
• W84

• P90
– page 3-50

Translation dX
-10000.0...

0.0...
+10000.0

meters page 3-50

Translation dY
-10000.0...

0.0...
+10000.0

meters page 3-50
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Translation dZ
-10000.0...

0.0...
+10000.0

meters page 3-50

Rotation Rx -60.0...0.0...60
seconds of 

arc
page 3-50

Rotation Ry -60.0...0.0...60
seconds of 

arc
page 3-50

Rotation Rz -60.0...0.0...60
seconds of 

arc
page 3-50

Scale -1000.0...0.0...1000 ppm page 3-50

Table B-17. Datum Settings (Continued)

Parameter Values/Range Units
Where to 

Find 
Description
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Appendix C

P/N
Output Period Setup 
Wizard
C-1
The Output Period Setup Wizard is a feature that helps you select 
and set the correct values for generating raw data and updating the 
receiver position.

PC-CDU will open this Wizard only if you try to specify an 
incorrect recording interval. Once the Wizard is run, follow the on-
screen instructions to adjust the typed values.

The following five figures, which are given here just for your 
convenience, show how the Output Period Setup Wizard windows 
look. These windows are listed in order of appearance.

Figure C-1. Wizard’s 1st Window
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Output Period Setup Wizard

C-2
Figure C-2. Wizard’s 2nd Window

Figure C-3. Wizard’s 3rd Window
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Figure C-4. Wizard’s 4th Window

Figure C-5. Wizard’s 5th Window
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Output Period Setup Wizard

C-4
Notes:
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Appendix D

P/N
Satellite Navigation 
Status Codes
D-1
Table D-1 lists the codes as seen in the SS column on the Main 
window in the PC-CDU software.

Table D-1. Satellite Navigation Status Structure

Code Description

00 C/A data used for position computation

01 P1 data used for position computation

02 P2 data used for position computation

03 Ionosphere-free combination used for position computation

04 Measurements unavailable

05 Ephemeris unavailable

06 Unhealthy SV (as follows from operational (=ephemeris) SV health)

07 Time-Frequency parameters from the ephemeris data set may be 

wronga

08 Initial conditions (position and velocity vectors) from the ephemeris 

data set may be wronga

09 Almanac SV health indicator unavailable for this satellitea

10 Unhealthy SV [as follows from the almanac SV health indicator]a

11 “Alert” flag (from the word “HOW”) is setb

12 URA indicates the absence of accuracy prediction for this SVb

13 User excluded this SV from position computation

14 User excluded this SV with this frequency channel number from 

position computationa
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Satellite Navigation Status Codes

D-2
15 This SV is excluded from solution since its system number is 

unknowna

16 This SV has an elevation lower than the specified mask angle

17 Reserved

18 Ephemeris data is too old

19 This SV does not belong to the constellation the user has selected

20 Differential data from Base Station unavailable for given satellite
(applicable only when receiver runs in DGPS)

21 Reserved

22 RAIM has detected wrong measurements

23 SNR below specified minimum level

24, 25 Reserved

26 DLL not settled

27 Ionospheric corrections are not received from Base Station

28 Coarse code outlier has been detected

29 Reserved

30 SV is not used in RTK processing (similar to code 20 but is used 
specifically for RTK)

31 The same as 30

32-50 Reserved

51 C/A slot used in RTK processing

52 P L1 slot used in RTK processing

53 P L2 slot used in RTK processing

54 P L1 & P L2 measurements used in RTK processing

55 C/A & P L2 measurements used in RTK processing 

56-62 Reserved

63 Satellite navigation status is undefined

a. GLONASS only
b. GPS only

Table D-1. Satellite Navigation Status Structure (Continued)

Code Description
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D-3
NOTICE
Codes 0-3 and 45-62 will show for the given 
satellite which raw data measurements have 
been used in position computation. The rest 
codes will indicate why this satellite has been 
excluded from position computation.
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D-4
Notes:
Topcon PC-CDU User’s Manual
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